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1 To create awareness and understanding on the basic functions of MS Excel 

2 To elucidate the students on the various advanced functions of MS Excel 

3 
To educate the students on MS Access and its application in database 
management 

4 
To enable the students to understand the functions and usage of various 
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5 
To enable the students learn the functions and usage of Cloud based 
apps like Google Forms, Google Slides and Google Cloud Printing. 

SYLLABUS  

UNIT Details 
No. of 
Hours 

Course 
Objectives 

I 

MS Excel – Basic Functions - Workbook – 
Building – modifying - navigating; Worksheet – 
Auto fill copying and moving cells, inserting and 
deleting rows, printing; Formulas and functions-
Troubleshooting formulas, Functions and its 
forms like database, reference, Databases – 
creating, sorting filtering and linking. 
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functions and usage of SPSS 

PO4, PO5,  PO6, 
PO7 
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Unit Objectives: 
  

      

Unit I - INTRODUCTION TO MS EXCEL 

Introduction: MS Excel – Basic Functions - Workbook – Building – modifying - 

navigating; Worksheet – Autofill copying and moving cells, inserting and deleting 

rows, printing; Formulas and functions-Troubleshooting formulas, Functions and 

its forms like database, reference, Databases – creating, sorting filtering and 

linking 

 

  To create awareness and understanding on the basic functions of MS Excel 

 

1.1  Introduction to Microsoft Excel, Basic  

Microsoft Excel is a powerful spreadsheet software developed by Microsoft, widely 

used for various purposes such as data analysis, financial modeling, and organizing 

information in tabular format. It is part of the Microsoft Office suite and is available for 

both Windows and Mac operating systems. 

Key components and features of Excel 

● Workbook 

● Worksheets 

● Cells 

● Columns and Rows 

● Formulas 

● Functions 

● Charts and Graphs 

● Formatting tools 

● Data Analysis tools 

● Macros 

Explanations of key components 

 
Workbook: A workbook is the main document in Excel where you store and work 

with your data. It consists of one or more worksheets, which are individual tabs 

located at the bottom of the Excel window. Each worksheet can contain multiple 

rows and columns, forming a grid where you can input and manipulate data. 
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Worksheets: Worksheets are individual tabs within a workbook where you 

enter and organize your data. You can have multiple worksheets within a single 

workbook, making it easy to manage different sets of data or perform various 

analyses within the same file. Cells: Cells are the basic building blocks of Excel 

worksheets. They are the individual boxes formed by the intersection of rows 

and columns. Each cell can contain different types of data such as text, 

numbers, formulas, or functions. 

Columns and Rows: Columns run vertically from top to bottom, labeled with 

letters (A, B, C, etc.), while rows run horizontally from left to right, labeled with 

numbers (1, 2, 3, etc.). Columns are used to organize data by categories, while 

rows represent individual records or entries. 

Formulas: Formulas are expressions that perform calculations on values in your 

worksheet. They start with an equal sign (=) followed by the mathematical 

operators and cell references. Excel supports a wide range of mathematical, 

logical, statistical, and financial functions to perform complex calculations easily. 

Functions: Functions are predefined formulas that perform specific tasks or 

calculations. Excel offers a vast library of functions categorized into various 

groups such as mathematical, statistical, financial, logical, text, date and time, 

and more. Functions help automate calculations and analysis, saving time and 

effort. 

Charts and Graphs: Excel allows you to create visual representations of your 

data using charts and graphs. You can choose from a variety of chart types such 

as bar charts, line graphs, pie charts, scatter plots, and more, to effectively 

present your data and identify trends, patterns, and relationships. 

Formatting Tools: Excel provides numerous formatting options to enhance the 

appearance and readability of your data. You can customize fonts, colors, 

borders, alignments, and styles to make your worksheets visually appealing and 

easy to understand. 

Data Analysis Tools: Excel offers built-in features and tools for data analysis, 

including sorting, filtering, pivot tables, and data validation. These tools allow you 

to organize, manipulate, and analyze large datasets efficiently, gaining valuable 

insights and making informed decisions. 

Macros and Automation: Excel supports macros, which are sequences of 

commands and instructions that automate repetitive tasks. You can record 
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macros or write them using Visual Basic for Applications (VBA) to perform 

specific actions or operations, saving time and improving productivity. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Excel is widely used in various industries for tasks ranging from simple data entry to complex 

financial modeling and analysis. It has become a standard tool for professionals, students, and 

anyone who needs to work with numerical data in a structured format. Excel is widely used in 

business, finance, science, and many other fields due to its versatility and ability to handle 

complex data analysis tasks. 
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1.2  Workshop- Building, modifying, and navigating 

Building, modifying, and navigating an Excel workbook involves creating and editing 

the spreadsheet to organize and analyze data effectively. Here's a step-by-step guide: 

Building a Workbook: 

Opening Excel: 

● Launch Microsoft Excel. 

● Choose a blank workbook or a template based on your needs. 
 

Creating Worksheets: 

● Each Excel file consists of one or more worksheets. 

● Add a new worksheet by clicking the "+" button at the bottom of the screen. 
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Entering Data: 

● Click on a cell and start typing data. 

● Use the Tab key to move to the next cell or Enter key to move down. 
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Formatting Cells: 

● Adjust the format of cells (font, color, alignment) using the toolbar. 

● Apply number formats, such as currency or date, to cells as needed. 
 

Inserting Rows and Columns: 

● Right-click on a row or column header and choose "Insert" to add a new row or column. 
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Using Formulas: 

● Start a formula with "=". 

● Use functions like SUM(), AVERAGE(), etc., to perform calculations. 
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Modifying a Workbook: 

Editing Data: 

● Double-click on a cell to edit its content. 

● Use the formula bar to edit formulas. 
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Moving and Copying: 

● Cut (Ctrl+X) or copy (Ctrl+C) cells and paste (Ctrl+V) elsewhere. 

● Use drag and drop to move data within the workbook. 
 

 

 



PU-CDOE MBA - Soft Skills III – Computing Skills UNIT 1 

15 Periyar University – CDOE| Self Learning Material 

 

 

 

 
 
 
 

 

Sorting and Filtering: 

● Select a range and use the "Sort" or "Filter" options to organize data. 
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To sort the following data register number 

wise, Select range, Choose sort and 

custom sort 

 

Choose sort by Regno 
 

Give Ok 
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Now the data is sorted using REGNO. 

 
 

Conditional Formatting: 

● Highlight cells based on certain conditions for better 

visualization. Choose range 

Click conditional formatting 
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To highlight the cell for whom those who scored less than or equal to 50 
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To remove conditional formatting 
 

 

Data Validation: 

● Set rules to control the type of data entered in cells. 
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Since the data that we entered in the table are marks, it should be between 0 to 100. 

To do this data validation, select range and click data validation. 

 
 

 

In settings, give minimum and maximum values and give ok. 
 

When you enter a value above 100, error message is displayed and it will not accept. 
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Protecting Worksheets: 

● Password-protect sheets to prevent unauthorized changes. 

 
 

To protect the sheet, select protect sheet by right clicking sheet 
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Give the password to protect the sheet 
 

 

 
Confirm the password to reenter 
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Now you can only view the sheet, if you want to make changes to the sheet, it will ask for 

password. 

 

Navigating a Workbook: 

Sheet Navigation: 

● Click on sheet tabs at the bottom to switch between worksheets. 
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Zooming In/Out: 

● Use the zoom slider in the bottom-right corner to adjust the view. 
 

Cell Navigation: 

● Use arrow keys to move between cells. 

● Press Ctrl + arrow key to jump to the edge of data in a 

direction. Named Ranges: 

● Define named ranges for easy navigation to specific 

areas. Workbook Views: 

● Switch between Normal, Page Layout, and Page Break 

views. Splitting Panes: 

● Divide the window into multiple panes for simultaneous viewing of different parts 

of the sheet. 

           Let us Sum Up:  

Microsoft Excel, a vital spreadsheet tool, facilitates tasks from simple data entry to 

complex analysis. Its components include Workbooks for organizing data, Worksheets 

for data entry and organization, Cells forming the basic units, and Columns/Rows for 

structuring. Formulas perform calculations, Functions automate tasks, Charts visualize 

data, and Formatting tools enhance presentation. Data Analysis tools aid sorting, 

filtering, and pivot tables, while Macros 
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automate tasks. Excel's versatility is key in various industries. Workbook structuring 

involves creating, modifying, and navigating spreadsheets, incorporating tasks such as 

data entry, formatting, formula usage, data modification, sorting/filtering, conditional 

formatting, data validation, protection, and navigation aids like zooming, cell navigation, 

named ranges, and workbook views. 

Check your Progress:  

1. What is the main purpose of Microsoft Excel? 

A) Creating presentations 

B) Managing emails 

C) Data analysis and organization 

D) Graphic design 

2. What are the basic components of an Excel workbook? 

A) Cells and Rows 

B) Slides and Paragraphs 

C) Worksheets and Columns 

D) Charts and Graphs 

3. What is the function of formulas in Excel? 

A) Creating visual representations 

B) Automating tasks 

C) Formatting cells 

D) Sorting data 

4. Which feature of Excel allows you to create visual representations of data? 

A) Formulas 

B) Functions 

C) Charts and Graphs 

D) Macros 

5. How can you protect a worksheet from unauthorized changes? 

A) Formatting cells 

B) Sorting data 

C) Using conditional formatting 

D) Password protection 
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6. What is the purpose of data validation in Excel? 

A) Creating charts 

B) Formatting cells 

C) Sorting data 

D) Controlling the type of data entered 

7. Which key component of Excel involves the intersection of rows and columns? 

A) Worksheets 

B) Formulas 

C) Cells 

D) Functions 

8. How can you switch between worksheets in Excel? 

A) Using conditional formatting 

B) Using Macros 

C) Clicking on sheet tabs at the bottom 

D) Zooming in/out 
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1.3  Activities  

 
Working with worksheets in Excel involves a range of tasks, from copying and moving 

cells to inserting and deleting rows, as well as preparing and printing the data. Let's go 

through these operations step by step: 

Autofill, Copying, and Moving Cells: 

Autofill: 

● Enter data into a cell. 

● Hover over the bottom-right corner of the selected cell until a small square 

(the fill handle) appears. 

● Drag the handle to fill adjacent cells with a series or 

pattern. Copying Cells: 

● Select the cells you want to copy. 

● Right-click and choose "Copy" or use Ctrl+C. 

● Move to the destination, right-click, and choose "Paste" or use 

Ctrl+V. Moving Cells: 

● Select the cells you want to move. 

● Right-click, choose "Cut" or use Ctrl+X. 

● Move to the destination, right-click, and choose "Paste" or use 

Ctrl+V. Inserting and Deleting Rows: 

Inserting Rows: 

● Right-click on the row number where you want to insert a row. 

● Choose "Insert" from the context 

menu. Deleting Rows: 

● Select the row(s) you want to delete. 

● Right-click and choose "Delete" from the context menu. 
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Printing in Excel: 

● Previewing Before Printing: 

● Click on the "File" tab and select "Print" to see a preview of your document. 
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Setting Print Area: 

● Select the range you want to print. 

● Go to the "Page Layout" tab and choose "Print Area" -> "Set Print 

Area." Adjusting Page Layout: 

● Navigate to the "Page Layout" tab to set margins, orientation, 

and size. Printing: 

● Click on the "File" tab and select "Print." 

● Choose the printer and other print settings. 

● Click "Print." 
 

 

Page Breaks: 

● Use the "Page Break Preview" option to adjust page breaks 

manually. Headers and Footers: 

● Customize headers and footers through the "Page Layout" tab. 
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1.4 Activities  

 
Excel functions are predefined formulas that perform calculations, manipulate data, and 

automate various tasks in Microsoft Excel. These functions are designed to simplify 

complex calculations and data analysis, making Excel a powerful tool for businesses, 

academics, and individuals. Functions in Excel are categorized based on their 

purposes, such as mathematical, statistical, logical, text, date and time, lookup and 

reference, and more. 

 
Categories of Excel Functions: 

Mathematical Functions: 

● Perform mathematical operations like addition, subtraction, multiplication, division. 

● Examples: SUM(), AVERAGE(), COUNT(), 

ROUND(). Statistical Functions: 

● Analyze data statistically, calculating measures like mean, median, standard deviation. 

● Examples: STDEV(), COUNTIFS(), 

CORREL(). Logical Functions: 

● Evaluate logical conditions and return true or false. 

● Examples: IF(), AND(), OR(), 

NOT(). Text Functions: 

● Manipulate and analyze text data. 

● Examples: CONCATENATE(), LEFT(), RIGHT(), 

LEN(). Date and Time Functions: 

● Handle date and time values and perform calculations. 

● Examples: TODAY(), NOW(), DATEDIF(), 

EOMONTH(). Lookup and Reference Functions: 

● Search for data within a range and retrieve information. 

● Examples: VLOOKUP(), HLOOKUP(), INDEX(), 

MATCH(). Financial Functions: 

● Perform financial calculations such as future value, present value, interest rates. 

● Examples: PV(), FV(), IRR(), NPV(). 
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Database Functions: 

● Extract data from a database based on specific criteria. 

● Examples: DSUM(), DCOUNT(), 

DAVERAGE(). How to Use Excel Functions: 

Function Syntax: 

Every function has a specific syntax indicating the order and type of arguments it 

requires. Entering Functions: 

Type the function name followed by open parentheses (, enter the required arguments, 

and close with ). 

AutoComplete and AutoSum: 

Excel provides autocomplete suggestions as you start typing a 

function. Use the AutoSum feature for quick insertion of common 

functions. 

Function Arguments: 

The Function Arguments dialog box helps understand and input arguments 

correctly. Cell References: 

Functions often involve references to cells or ranges. Absolute ($) or relative 

references are crucial. 

Nested Functions: 

Combine multiple functions within a single formula for more complex 

calculations. Common Functions and Their Forms: 

SUM Function: 

● Adds up a range of numbers. 

● Basic form: =SUM(A1:A10) 

● AutoSum shortcut: Select a range and press Alt + Shift + = 
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AVERAGE Function: 

● Calculates the average of a range of numbers. 

● Basic form: =AVERAGE(A1:A10) 
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VLOOKUP Function (Reference Function): 

● Searches for a value in the first column of a table and returns a value in the same row. 

● Basic form: =VLOOKUP(lookup_value, table_array, col_index_num, 

[range_lookup]) IF Function: 

● Performs a logical test and returns one value if the test is true and another if false. 

● Basic form: =IF(logical_test, value_if_true, 

value_if_false) INDEX-MATCH (Database Function): 

● Looks up a value in a table and returns a corresponding value in the same row 

using the MATCH function. 

● Basic form: =INDEX(return_range, MATCH(lookup_value, 

lookup_range, 0)) COUNTIF Function (Reference Function): 

● Counts the number of cells within a range that meet a specific condition. 

● Basic form: =COUNTIF(range, 

criteria) Database Functions: 

DSUM Function: 

● Adds the numbers in a column of a database that meet multiple criteria. 

● Basic form: =DSUM(database, field, 

criteria_range) DCOUNT Function: 

● Counts the cells that meet the specified conditions in a database. 

● Basic form: =DCOUNT(database, field, 

criteria_range) DAVERAGE Function: 

● Calculates the average of selected database entries that meet the specified criteria. 

● Basic form: =DAVERAGE(database, field, 

criteria_range) Troubleshooting Formulas in Excel: 

Error Checking: 

● Excel provides error checking features. Click on the cell with an error, and a 

small green triangle in the top-left corner offers options to trace and correct 

errors. 

Trace Precedents and Dependents: 

● Use the "Trace Precedents" and "Trace Dependents" options in the 

"Formulas" tab to identify the cells affecting or being affected by a formula. 

Evaluate Formula: 
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● Use the "Evaluate Formula" feature (Formulas tab -> Evaluate Formula) to step 

through each part of a formula to identify errors. 

Check Cell References: 

● Ensure cell references are correct and point to the 

intended cells. Parentheses Matching: 

● Check for matching parentheses in complex 

formulas. Watch Window: 

● Use the Watch Window (Formulas tab) to monitor specific cells and their formulas. 

 
 

Let Us Sum Up 

Working with worksheets in Excel involves a variety of tasks like copying, moving cells, 

and managing rows, alongside preparing and printing data. Autofill aids in quickly 

populating cells with patterns, while copying and moving cells allow for easy data 

duplication or relocation. Inserting and deleting rows help in adjusting the layout. 

Printing functionalities include previewing, setting print areas, adjusting layouts, and 

setting page breaks and headers/footers. Formulas and functions in Excel automate 

tasks and perform calculations, with various categories like mathematical, statistical, 

logical, text, date and time, lookup and reference, and financial functions, each serving 

specific purposes and offering extensive capabilities. Troubleshooting formulas involves 

error checking, tracing precedents and dependents, evaluating formulas, and ensuring 

accurate cell references.  

   Self Assessment Questions  

1. What task does Autofill assist with in Excel? 

A) Deleting rows 

B) Moving cells 

C) Populating cells with patterns 

D) Sorting data 

2. How can you duplicate data in Excel? 

A) Using Autofill 

B) Sorting data 
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C) Deleting rows 

D) Adjusting layouts 

3. Which option allows you to adjust the layout of rows in Excel? 

A) Autofill 

B) Inserting rows 

C) Deleting rows 

D) Moving cells 

4. What function in Excel aids in previewing documents before printing? 

A) Autofill 

B) Sorting data 

C) Printing functionalities 

D) Previewing Before Printing 

5. How do you set print areas in Excel? 

A) Using Autofill 

B) Adjusting layouts 

C) Setting print area 

D) Sorting data 

6. Which feature in Excel allows for adjusting page breaks manually? 

A) Deleting rows 

B) Sorting data 

C) Setting page breaks 

D) Moving cells 

7. What type of functions in Excel perform mathematical operations? 

A) Statistical Functions 

B) Text Functions 

C) Logical Functions 

D) Mathematical Functions 
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1.5 Databases, Sorting, Filtering and Linking 

Microsoft Excel can be used to create simple databases, perform sorting and filtering 

operations, and establish links between data in different sheets. 

Creating a Database: 

● Set Up Columns: 

● Identify the data fields you need. 

● Enter each field name in a separate column at the top of your 

worksheet. Enter Data: 

● Below the column headers, enter your data into 

rows. Format as Table: 

● Select your data range. 

● Go to the "Insert" tab and click "Table." Confirm the range and choose whether 

your table has headers. 
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Sorting Data: 

Simple Sorting: 

● Click on the drop-down arrow in the column header. 

● Choose "Sort A to Z" or "Sort Z to A" for text, or "Sort Smallest to Largest" or 

"Sort Largest to Smallest" for numbers. 
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Custom Sorting: 

● Select the data range. 

● Go to the "Data" tab and click "Sort." 

● Specify sort criteria, such as multiple columns. 
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Filtering Data: 

Basic Filtering: 

● Click on the filter icon in the column header. 

● Use the filter dropdown to select specific values to display. 
 

 

Advanced Filtering: 

● Go to the "Data" tab and click "Advanced Filter." 

● Define criteria and choose to filter data in-place or copy to another location. 
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To filter the students who scored more than 50 as average 
 



PU-CDOE MBA - Soft Skills III – Computing Skills UNIT 1 

41 Periyar University – CDOE| Self Learning Material 

 

 

 

 

Linking Data: 

Linking Within a Worksheet: 

● In another cell, type = and click on the cell you want to link to. 

● Press Enter. 

Linking Between Worksheets: 

● Navigate to the sheet where you want the link. 

● Type =SheetName!CellReference (e.g., =Sheet2!A1) and press Enter. 
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Linking Between Workbooks: 

● Open both workbooks. 

● In the destination workbook, enter 

='[WorkbookName.xlsx]SheetName'!CellReference. Creating Hyperlinks: 

● Select a cell. 

● Right-click and choose "Hyperlink." 

● Link to a place in the document, another document, or a webpage. 
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Database Functions in Excel: 

DSUM Function: 

● Adds numbers in a column based on specified conditions. 
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● =DSUM(database, field, criteria_range) 

 
 

DCOUNT Function: 

● Counts cells with numbers in a column based on specified conditions. 

● =DCOUNT(database, field, 

criteria_range) DAVERAGE Function: 

● Calculates the average of selected database entries based on specified conditions. 

● =DAVERAGE(database, field, criteria_range) 

Unit- Summary 

Thus in chapter we discussed basic functions in excel, how to build a workbook, 

working with worksheet, working with formulas and functions and finally we discussed 

how to create databases in Excel. 

Check Your Progress 

1: You have just created a new workbook and added three worksheets named 

"January", "February", and "March". How can you rename the "February" worksheet 

to "Feb"? 

A) Right-click on the "February" tab and select "Rename", then type "Feb". 

B) Click on the "January" tab and select "Change Name", then type "Feb". 

C) Go to the "File" menu and select "Rename Sheet", then type "Feb". 

D) Press "Ctrl + R" and type "Feb". 

Answer: A) Right-click on the "February" tab and select "Rename", then type "Feb". 

2: You want to fill a column with a series of numbers starting from 1 up to 10. What is 

the correct method to use Auto Fill for this task? 

A) Type "1" in the first cell, then drag the fill handle down while holding "Shift". 

B) Type "1" in the first cell and "10" in the second cell, then drag the fill handle down. 

C) Type "1" in the first cell, then drag the fill handle down while holding "Ctrl". 

D) Type "1" in the first cell, then press "Ctrl + D" to fill the column. 

Answer: B) Type "1" in the first cell and "10" in the second cell, then drag the fill 

handle down. 

3: How do you insert a new row above the currently selected row in an Excel 

worksheet? 

A) Right-click on the row number and select "Insert". 

B) Click "Insert" on the Home tab and choose "Insert Sheet Rows". 
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C) Use the "Home" tab, click on "Insert", and select "Insert Row". 

D) Press "Ctrl + Shift + +" while selecting the row number. 

Answer: A) Right-click on the row number and select "Insert". 

4: If you see the error message #DIV/0! in a cell, what is the most likely cause of this 

error? 

A) The formula is trying to divide a number by zero. 

B) The formula contains an invalid cell reference. 

C) The cell is formatted as text. 

D) The formula uses an incorrect function name. 

Answer: A) The formula is trying to divide a number by zero. 

5: To sort a list of customer names in alphabetical order, which of the following steps 

is correct? 

A) Select the range of names, go to the "Data" tab, and click "Sort A to Z". 

B) Select the range of names, go to the "View" tab, and click "Sort". 

C) Use the "Find & Select" feature and choose "Sort". 

D) Right-click the range of names, choose "Format Cells", and then "Sort". 

Answer: A) Select the range of names, go to the "Data" tab, and click "Sort A to Z". 

 

Glossary  

1. Workbook 

   Definition: A file in Excel that contains one or more worksheets. 

2. Worksheet 

   Definition: A single spreadsheet within a workbook. 

3. Building a Workbook 

   Definition: Creating a new workbook from scratch or using a template, and adding 

worksheets to it. 

4. Modifying a Workbook 

   Definition:  Making changes to an existing workbook, such as editing cell content, 

adjusting formatting, or updating data. 

5. Navigating a Workbook 

   Definition: Moving through different worksheets or cells within a workbook using 

keyboard shortcuts, mouse clicks, or the Go To feature. 

6. Auto Fill 

   Definition: A feature that automatically fills cells with data based on a pattern or 
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series (e.g., dates, numbers). 

7. Copying Cells 

   Definition: Duplicating the content of selected cells to another location. 

8. Moving Cells 

   Definition: Changing the location of selected cells by cutting and pasting them to a 

new location. 

9. Inserting Rows 

   Definition: Adding new rows to a worksheet. 

10. Deleting Rows 

    Definition: Removing rows from a worksheet. 

 

Self Assessment Questions 

           1: What is a workbook in MS Excel? 

A) A single spreadsheet 

B) A collection of cells 

C) A file containing one or more worksheets 

D) A type of formula 

           2: How can you add a new worksheet to an existing workbook? 

A) Right-click on the existing worksheet tab and select "Add New Worksheet" 

B) Use the "Insert" menu and choose "Worksheet" 

C) Press "Ctrl + N" 

D) Click on the "New Sheet" button at the bottom of the workbook 

           3: Which action is necessary to modify a cell’s content in a worksheet? 

A) Pressing "Ctrl + S" 

B) Selecting the cell and typing new content 

C) Clicking "Insert" and choosing "Cell" 

D) Using "Format Cells" to change the cell type 

           4: To save changes made to a workbook, which keyboard shortcut is used? 

A) Ctrl + P 

B) Ctrl + C 

C) Ctrl + S 

D) Ctrl + V 

           5: What does the "Go To" feature in Excel do? 

A) Opens a new workbook 
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B) Deletes the current worksheet 

C) Allows you to quickly move to a specific cell reference 

D) Creates a new worksheet 

           6: How can you navigate between worksheets within a workbook? 

A) Use the arrow keys 

B) Click on the worksheet tabs at the bottom of the workbook 

C) Press "Ctrl + N" 

D) Use the "Find" feature 

           7: What does the Auto Fill feature do in Excel? 

A) Deletes data in a series of cells 

B) Formats cells based on a pattern 

C) Automatically fills cells with a series or pattern of data 

D) Protects cells from editing 

           8: Which operation would you use to move a cell's content to a different location? 

A) Copying 

B) Cutting and pasting 

C) Auto Fill 

D) Formatting 

           9: What is the result of inserting a new row in a worksheet? 

A) The new row replaces the selected row 

B) The new row is added above the selected row 

C) The new row is added below the selected row 

D) The entire worksheet is shifted down 

          10: How can you delete a row in Excel? 

A) Right-click the row number and select "Delete" 

B) Use the "Find and Replace" feature 

C) Press "Ctrl + X" 

D) Use the "Format Cells" dialog 
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Activities  

   Activity: Create and Populate a Monthly Sales Report 

 

Objective Use Auto Fill and Copying Cells to create a simple monthly sales report in 

Excel. 

 

Steps: 

 

1. Open Excel and Create a New Workbook: 

   - Start Excel and open a new blank workbook. 

 

2. Set Up the Header Row: 

   - In the first row, enter the following headers in cells A1 through C1: 

     - A1: "Date" 

     - B1: "Sales" 

     - C1: "Cumulative Sales" 

 

3. Enter Initial Data: 

   - In cell A2, type "1/1/2024" (assuming the sales start from January 1, 2024). 

   - In cell B2, enter a random sales figure, e.g., "$500". 

 

4. Use Auto Fill to Populate Dates: 

   - Select cell A2. 

   - Move your cursor to the lower right corner of the cell until it becomes a small cross 

(Auto Fill handle). 

   - Drag the fill handle down to cell A32 to fill the dates for the entire month. Excel 

should automatically increment the dates. 

 

5. Copy Sales Data: 

   - To simplify, assume the sales figure for each day is the same. Select cell B2. 

   - Copy the cell (Ctrl + C). 

   - Select the range B3:B32 and paste the value (Ctrl + V). This will apply the same 

sales figure to the entire range. 
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6. Calculate Cumulative Sales: 

   - In cell C2, enter the formula to calculate cumulative sales: `=B2`. 

   - In cell C3, enter the formula: `=C2 + B3`. 

   - Drag the fill handle from cell C3 down to cell C32 to apply the cumulative sales 

calculation for each day of the month. 

 

7. Review and Format: 

   - Check that the dates, sales, and cumulative sales are correctly filled. 

   - Optionally, format the cells for better readability (e.g., set the date format in 

column A and the currency format in columns B and C). 

 

8. Save Your Workbook: 

   - Save the workbook with an appropriate name, such as 

"Monthly_Sales_Report.xlsx". 

 

Outcome: 

By completing this activity, you will have created a basic sales report with auto-filled 

dates and copied sales figures, as well as calculated cumulative sales for each day of 

the month. This exercise demonstrates the use of Auto Fill and copying cells to 

efficiently manage and organize data in Excel. 

Suggested Readings 

Gonda, C. M. (2016) Master of Business Etiquette: The Ultimate Guide to Corporate 

Etiquette and Soft Skills Embassy Books, First Edition. 
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Unit II - MS Excel Advanced Functions 

Vlookup – Hlookup – Charts – Count - Countif – Sum - Sumif – Product – 

Sumproduct. Functions: Mathematical - Financial - logic – Text - Statistical  

 

Unit - II Objectives 

To elucidate the students on the various advanced functions of MS Excel 
 

2.1 VLOOKUP 

VLOOKUP Function (Reference Function): 

● Searches for a value in the first column of a table and returns a value in the 

same row. What is VLOOKUP? - Searching for a value in a table and returning a 

corresponding value. 

VLOOKUP Syntax - =VLOOKUP(lookup_value, table_array, col_index_num, 

[range_lookup]) Components 

● lookup_value: The value you want to search for. 

● table_array: The range of cells that contains the data. 

● col_index_num: The column number in the table from which to retrieve the value. 

● [range_lookup]: This is an optional argument. If TRUE or omitted, VLOOKUP will 

look for an approximate match. If FALSE, itH will look for an exact match. 
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2.2 HLOOKUP FUNCTIONS 

If the data table is arranged in horizontal rows then the HLOOKUP function is used to 

look for value horizontally. 

 

HLOOKUP Syntax - =VLOOKUP(lookup_value, table_array, row_index_num, 

[range_lookup]) Components 

● lookup_value: The value you want to search for. 

● table_array: The range of cells that contains the data. 

● row_index_num: The row number in the table from which to retrieve the value. 

● [range_lookup]: This is an optional argument. If TRUE or omitted, VLOOKUP will 

look for an approximate match. If FALSE, it will look for an exact match. 

 

LET US SUM UP 

The VLOOKUP function searches for a value in the first column of a table and retrieves 

a corresponding value from the same row. Its syntax includes the lookup value, table 

array, column index number, and optional range lookup. When the data table is 

horizontally arranged, the HLOOKUP function is used, with a similar syntax but retrieves 

values horizontally based on the lookup value, table array, row index number, and 

optional range lookup. VLOOKUP and HLOOKUP are  vital Excel  functions for data 
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retrieval, offering flexibility in searching and retrieving data from tables based on 

specified criteria, whether vertically or horizontally arranged. 

Check Your Progress 

What is the purpose of the VLOOKUP function? 

a) Sorting data in a table 

b) Searching for a value in a table and returning a corresponding value 

c) Performing mathematical calculations 

d) Formatting cells in Excel 

What does the [range_lookup] parameter in the VLOOKUP function determine? 

a) Whether to include empty cells in the search 

b) Whether to search vertically or horizontally 

c) Whether to look for an approximate or exact match 

d) Whether to ignore case sensitivity in the 

search What is the primary purpose of the 

HLOOKUP function? 

a) Sorting data in a table 

b) Searching for a value vertically in a table 

c) Searching for a value horizontally in a table 

d) Calculating averages of rows in a table 

What does the [range_lookup] parameter in the HLOOKUP function determine? 

a) Whether to include empty cells in the search 

b) Whether to search vertically or horizontally 

c) Whether to look for an approximate or exact match 

d) Whether to ignore case sensitivity in the search 
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2.3 Charts 

Different types of Charts 

Excel offers a variety of chart types to visualize data effectively. Here's a list of some 

common chart types available in Excel: 

 
● Column Chart 

● Bar Chart 

● Pie Chart 

● Line Chart 

● Area Chart 

 
Column Chart: Displays data in vertical columns. 

● A column chart is a type of graph that presents data in vertical bars of varying 

heights. Each bar typically represents a different category or group, and the 

height of the bar corresponds to the value of the data it represents. Column 

charts are commonly used to compare values across different categories or to 

track changes in data over time. 

● Column chart can be used for comparing quantities, showing trends over 

time and for highlighting differences. 

● Overall, column charts are versatile and widely used for presenting and analyzing 

data in a clear and visually appealing manner, especially when comparing values 

across categories or tracking changes over time. 

 
Example for Column Chart 
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Bar Chart: Similar to a column chart but with horizontal bars. 

 
A bar chart is a graphical representation of data that uses horizontal bars to 

display values. Each bar represents a category or group, and the length of the bar 

corresponds to the value of the data it represents. Bar charts are commonly used to 

compare quantities or values across different categories or groups. They are particularly 

effective for showing rankings, distributions, and comparisons between discrete 

categories. Bar charts are visually intuitive and easy to interpret, making them a popular 

choice for presenting data in a clear and concise manner. 

 
Bar Chart example 

 
 

 

Line Chart: Connects data points with straight lines, suitable for showing trends over time. 

 
A line chart is a graphical representation of data that displays information as a series of 

data points connected by straight lines. Each data point typically represents a specific 

value at a given point in time or along a continuous scale. Line charts are commonly 

used to visualize trends and patterns over time or across ordered categories. They are 

particularly effective for showing the relationship between variables and for highlighting 

changes or fluctuations in data. Line charts are clear and easy to interpret, making 

them a popular choice for displaying time-series data, 
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such     as      stock      prices,      temperature      trends,      or     sales     figures     over     
time. 

 

 

Pie Chart: Displays data as a circular graph divided into slices to represent proportions 

of the whole. A pie chart is a circular graphical representation of data, divided into slices 

to illustrate numerical proportions. Each slice represents a category or group, and the 

size of each slice is proportional to the value it represents in relation to the whole. Pie 

charts are typically used to show the distribution of data and to highlight the relative 

sizes of different categories within a dataset. They are effective for visualizing 

percentages or proportions and are commonly used in business presentations, reports, 

and dashboards to convey simple comparisons or compositions of data. However, they 

are less effective for comparing individual values or showing precise differences 

between categories, especially when there are many categories or when the differences 

between values are small. 
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Area Chart: Similar to a line chart but the area below the line is filled with color, often 

used to represent accumulated totals over time. 

 
An area chart is a graphical representation of data that is similar to a line chart but with 

the area below the lines filled with color. Like line charts, area charts display data points 

connected by lines, typically representing trends or changes over time. However, the 

filled area under the lines in an area chart emphasizes the magnitude of accumulated 

totals or values over time. Area charts are commonly used to visualize trends in data 

over time and to compare the overall magnitude of different data series. They are 

effective for highlighting the cumulative values or proportions of data categories and 

are often used in financial analysis, market research, and other contexts where trends 

and comparisons are important. 

 

 
Other charts in Excel 

 
Scatter Plot 

Bubble Chart 

Radar Chart 

Surface Chart 

Doughnut 

Chart 
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Histogram Box 

and Whisker 

Plot (Box Plot) 

Tree map 

These are just some of the chart types available in Excel, and each serves different 

purposes depending on the nature of the data and the insights you want to convey. 

 
Let Us Sum Up 

Excel offers various chart types for effective data visualization, including Column, 

Bar, Pie, Line, and Area charts. Column and Bar charts compare quantities or show 

trends over time vertically or horizontally, respectively. Line charts connect data points 

to illustrate trends, ideal for time-series analysis. Pie charts display proportions of a 

whole, suitable for showing data distribution. Area charts, akin to line charts but filled 

beneath, highlight accumulated totals over time. Additional Excel chart types like 

Scatter, Bubble, Radar, Surface, Doughnut, Histogram, Box and Whisker, and Treemap 

serve diverse data analysis needs. Each chart type conveys insights differently, catering 

to specific data characteristics and analytical requirements. 

 
Check Your Progress 

Which chart type is best suited for comparing quantities or values across different 

categories or groups, and can also be used for showing trends over time? 

a) Pie Chart 

b) Line Chart 

c) Column Chart 

d) Bar Chart 

What chart type is effective for visualizing trends and patterns over time or across 

ordered categories by connecting data points with straight lines? 

a) Bar Chart 

b) Pie Chart 

c) Line Chart 

d) Area Chart 
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Which chart type uses horizontal bars to display values, making it particularly 

effective for showing rankings, distributions, and comparisons between discrete 

categories? 

a) Line Chart 

b) Bar Chart 

c) Pie Chart 

d) Scatter Plot 

What chart type is suitable for representing accumulated totals over time, similar to a 

line chart but with the area below the line filled with color? 

a) Pie Chart 

b) Area Chart 

c) Scatter Plot 

d) Radar Chart 

When is a pie chart most commonly used? 

a) To compare quantities across different categories 

b) To visualize trends over time 

c) To show accumulated totals 

d) To illustrate numerical proportions and distributions 

 

2.4 COUNT and Countif FUNCTIONS  

The COUNT function in Excel is used to count the number of cells in a range that 

contain numbers. It ignores any cells that contain text, logical values 

(TRUE/FALSE), errors, or are blank. Its syntax is: 

=count(value1, [value2],..) 

value1, value2, ...: These are the arguments representing the values or cells you want to 

count. You can input up to 255 arguments. 

Example 

Suppose you want to count the number of items in column b, we can use the count 

function to count the number of items. Syntax for counting the marks from cell B1 to 

B20 is 

=count(B1:B20) 

This will give the total as 20 
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Countif function 

The COUNTIF function in Excel is used to count the number of cells within a range 

that meet a specified condition. It counts cells based on a single criteria. Its syntax is 

=countif(range, criteria) 

 
● range: This is the range of cells that you want to apply the criteria to. 

● criteria: This is the condition that the cells must meet in order to be counted. 

 
Suppose you have a range of cells B2:B21 containing various numerical values 

(marks) and you want to count how many of those cells contain values greater than 50. 

You would use: 

=COUNTIF(B1:B20, ">50") 

While we enter the formula in Cell B22, it will give the result as 16 as shown below. 
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2.5  SUM, Sumif, PRODUCT and Sumproduct 

 
Sum function 

The SUM function in Excel is used to add up numbers in a range of cells. Its 

syntax is straightforward: 

=sum(number1, [number2], …) 

number1, number2, ...: These are the numbers or ranges you want to add 

together. Example 

In the following examples, we would like to find the sum of numbers from 

B1:B20. The following formula will be used to find the sum of numbers from 

B1:B20. 

=sum(B1:B20) 

This formula will add up all the numbers in cells B1 through B20 and display the results as 3440 
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SUMIF Functions 

The SUMIF function in Excel is used to sum the values in a range that meet a 

specified condition. Its syntax is: 

=SUMIF(range, criteria, [sum_range]) 

 
● range: This is the range of cells that you want to apply the criteria to. 

● criteria: This is the condition that the cells must meet in order to be included in the sum. 

● sum_range: This is an optional argument that specifies the actual cells to sum if 

different from the range. 

 
Example 

Let us sum the numbers based on the condition that the value is above 50. The 

numbers will be added up only when the condition is satisfied like the value is greater 

than 50. 

The formula for calculating the sum only if the values are greater than 50 is 

=SUMIF(B1:B20, ">50") 

This formula will sum all the values in cells B1 through B20 that are greater than 50. 

The sum is 1262 
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PRODUCT FUNCTION 

The PRODUCT function in Excel is used to multiply numbers together. Its syntax is 

similar to SUM: 

=PRODUCT(number1, [number2], ...) 

number1, number2, ...: These are the numbers or ranges you want to multiply together. 

EXAMPLE 

Let us multiply the numbers from B1 to 

B20. Formula 

=product(B1:B20) 

The results will be as shown below. 
 

SUMPRODUCT FUNCTION 

The SUMPRODUCT function in Excel is a powerful tool that allows you to multiply 

arrays together and then sum the results. It can be used for various purposes, such as 

weighted averages, summing the products of corresponding values in two or more 

arrays, etc. 

=SUMPRODUCT(array1, [array2], ...) 

array1, array2, ...: These are the arrays or ranges you want to multiply together and then sum. 
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This formula will sum the products of the corresponding values in cells A1 through A10 

and B1 through B10. 

 
LET US SUM UP 

The COUNT function in Excel tallies numeric values within a range, disregarding text, 

logical values, errors, or blanks. COUNTIF counts cells meeting a specified condition, 

SUM sums numbers in a range, SUMIF sums values meeting a condition. PRODUCT 

multiplies numbers together. SUMPRODUCT multiply arrays and sums the results. 

 
Check your Progress 

What is the purpose of the COUNT function in Excel? 

a) To find the sum of numbers in a range 

b) To calculate the average of numbers in a range 

c) To count the number of cells in a range that contain numbers 

d) To round a number to a specified number of digits 

How many arguments can be input into the COUNT function in Excel? 

a) Up to 100 arguments 

b) Up to 255 arguments 
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c) Up to 50 arguments 

d) Unlimited arguments 

What is the syntax for the COUNTIF function in Excel? 

a) =COUNTIF(criteria, range) 

b) =COUNTIF(range, criteria) 

c) =COUNTIF(range, value) 

d) =COUNTIF(value, range) 

Which function in Excel is used to multiply numbers together? 

a) SUM 

b) PRODUCT 

c) COUNT 

d) AVERAGE 

What does the SUMPRODUCT function in Excel do? 

a) Adds up numbers in a range 

b) Multiplies arrays together and then sums the results 

c) Calculates the average of numbers in a range 

d) Counts the number of cells in a range that contain numbers 
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2.6  MATHEMATICAL FUNCTIONS 

Excel provides a variety of mathematical functions to perform calculations on 

numerical data. Here are some common mathematical functions in Excel along with 

examples: 

 
● SUM 

● AVERAGE 

● MAX 

● MIN 

● COUNT 

● COUNTIF 

● ROUND 

● ABS 

● SQRT 

● POWER 

● LOG 

 
SUM: Adds up all the numbers in a range. 

 
Example: =SUM(A1:A10) adds up the values in cells A1 through A10. 

 
SUM Function: 

● Adds up a range of numbers. 

● Basic form: =SUM(A1:A10) 

● AutoSum shortcut: Select a range and press Alt + Shift + = 

AVERAGE: Calculates the average of numbers in a range. 
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Example: =AVERAGE(B1:B5) calculates the average of values in cells B1 through B5. 

 

AVERAGE Function: 

● Calculates the average of a range of numbers. 

● Basic form: =AVERAGE(A1:A10) 
 

MAX: Returns the largest value in a range. 

 
Example: =MAX(C1:C10) returns the maximum value in cells C1 through C10. 

 

MIN: Returns the smallest value in a range. 

 
Example: =MIN(D1:D10) returns the minimum value in cells D1 through D10. 

 

COUNT: Counts the number of cells that contain numbers in a range. 

 
Example: =COUNT(E1:E10) counts how many cells in the range E1 through E10 

contain numbers. 

 
COUNTIF Function (Reference Function): 

● Counts the number of cells within a range that meet a specific condition. 



69 Periyar University – CDOE| Self Learning Material 

PU-PRIDE-OLDP MBA - Soft Skills III – Computing Skills UNIT 2 

 

 

  

● Basic form: =COUNTIF(range, criteria) 

ROUND: Rounds a number to a specified number of digits. 

 
Example: =ROUND(F1, 2) rounds the value in cell F1 to 2 decimal places. 

 
ABS: Returns the absolute value of a number. 

 
Example: =ABS(G1) returns the absolute value of the number in cell G1. 

 
SQRT: Returns the square root of a number. 

 
Example: =SQRT(H1) returns the square root of the number in cell H1. 

 
POWER: Raises a number to a power. 

 
Example: =POWER(I1, 3) raises the number in cell I1 to the power of 3. 

 
LOG: Returns the logarithm of a number with a specified base. 

 
Example: =LOG(J1, 10) returns the logarithm of the number in cell J1 with base 10. 

 
These are just a few examples of the mathematical functions available in Excel. Excel 

offers many more functions for various mathematical operations, such as trigonometric 

functions, statistical functions, and financial functions, among others. 

 
LET US SUM UP 

This module we have explored the different mathematical functions in excel like Sum, 

Average, max, min, count, countif, round, abs, power and log functions. 

 
Check your Progress 

Which mathematical function in Excel is used to calculate the average of numbers in a range? 

a) MAX 

b) MIN 

c) AVERAGE 

d) COUNT 

What is the purpose of the COUNT function in Excel? 
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a) To find the sum of numbers in a range 

b) To count the number of cells in a range that contain numbers 

c) To calculate the average of numbers in a range 

d) To return the largest value from a range of 

numbers Which function in Excel is used to multiply 

numbers together? 

a) SUM 

b) PRODUCT 

c) COUNT 

d) AVERAGE 

 

2.7  FINANCIAL FUNCTIONS 

Excel provides a variety of financial functions that are useful for performing calculations 

related to finance and investment. Here are some common financial functions in Excel. 

 
● PV - PRESENT VALUE 

● FV - FUTURE VALUE 

● PMT - PAYMENT 

● RATE - INTEREST RATE 

● NPER - NUMBER OF PERIODS 

● NPV - NET PRESENT VALUE 

● IRR - INTERNAL RATE OF RETURN 

PV (Present Value): Calculates the present value of an investment based on 

a series of future cash flows and a discount rate. 

 
=PV(rate, nper, pmt, [fv], [type]) 

 
Example: =PV(0.05, 10, -1000, 0, 0) calculates the present value of an 

investment with a 5% interest rate per period, 10 periods, and a payment of 

$1000 per period. 

FV (Future Value): Calculates the future value of an investment based on 

periodic, constant payments and a constant interest rate. 
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= FV(rate, nper, pmt, [pv], [type]) 

 
Example: =FV(0.03, 5, -200, -1000, 0) calculates the future value of an 

investment with a 3% interest rate per period, 5 periods, a payment of $200 per 

period, and an initial investment of $1000. 

PMT (Payment): Calculates the payment for a loan or investment based on 

constant payments and a constant interest rate. 

 
=PMT(rate, nper, pv, [fv], [type]) 
 
Example: =PMT(0.06, 3, -10000) calculates the payment for a $10,000 loan with a 6% annual 
interest rate over 3 years. 

RATE: Calculates the interest rate for a loan or investment based on constant payments. 

 

=RATE(nper, pmt, pv, [fv], [type], [guess]) 

 
Example: =RATE(5, -200, 1000, 0, 0) calculates the interest rate for a $1000 loan with a 

$200 payment per period over 5 periods. 

NPER (Number of Periods): Calculates the number of periods required to reach a 

specific future value or pay off a loan. 

 
=NPER(rate, pmt, pv, [fv], [type]) 

 
Example: =NPER(0.04, -200, 1000) calculates the number of periods required 

to pay off a $1000 loan with a $200 payment per period and a 4% interest rate. 

 
These are just a few examples of the financial functions available in Excel. Depending 

on your financial analysis needs, 

 
Excel also offers functions for calculating net present value (NPV), internal rate of return 

(IRR), and more. NPV (Net Present Value) and IRR (Internal Rate of Return) are two 

important financial functions in Excel commonly used in investment analysis. 

 
NPV (Net Present Value): NPV calculates the present value of cash flows 
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generated by an investment, taking into account the initial investment and a 

discount rate. It helps determine whether an investment will result in a net gain or 

loss at a specified rate of return. 

 
=NPV(rate, value1, [value2], ...) 

 
● rate: The discount rate or cost of capital per period. 

● value1, value2, etc.: Cash flows or payments occurring at different 

periods. 

 Example: Suppose you're evaluating an investment opportunity with an initial 

investment of $1,000 and expected cash flows of $300, $400, $500, $600, and $700 over the next five 

years, with a discount rate of 5%. 

 
=NPV(0.05, -1000, 300, 400, 500, 600, 700) 

 
This formula calculates the net present value of the investment based on the 

cash flows and discount rate. If the NPV is positive, it indicates that the 

investment is expected to generate a positive return, while a negative NPV 

suggests a potential loss. 

IRR (Internal Rate of Return): IRR calculates the discount rate at which the net 

present value of cash flows equals zero. In other words, it represents the rate 

of return at which the investment breaks even. 

 
=IRR(values, [guess]) 

 
● values: An array or range of cash flows representing income and 

expenses, including the initial investment (which must be negative). 

● guess: An optional guess for the IRR. If omitted, Excel uses 0.1 

(10%) as the default. 

Example: Continuing from the previous example, let's use the same cash 

flows to calculate the internal rate of return. 
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=IRR({-1000, 300, 400, 500, 600, 700}) 

 
This formula calculates the internal rate of return for the investment. If the IRR 

exceeds the required rate of return or cost of capital, the investment may be 

considered acceptable. 

 
Both NPV and IRR are widely used in financial modeling and decision-making 

processes to evaluate the profitability and feasibility of investment projects. 

LET US SUM UP 

Excel offers a range of financial functions for investment analysis. Examples include PV 

for present value, FV for future value, PMT for payment calculation, RATE for interest 

rate, NPER for period calculation, NPV for net present value, and IRR for internal rate of 

return. NPV calculates the current value of future cash flows, helping assess investment 

profitability. IRR determines the discount rate at which an investment breaks even. 

These functions aid in financial modeling, offering insights into investment feasibility and 

profitability based on cash flows, interest rates, and time periods. 

 
Check your Progress 

What does the NPV function in Excel do? 

a) Calculates the present value of an investment 

b) Calculates the future value of an investment 

c) Calculates the payment for a loan or investment 

d) Calculates the interest rate for a loan or 

investment What is the purpose of the IRR function 

in Excel? 

a) To calculate the present value of an investment 

b) To calculate the future value of an investment 

c) To calculate the payment for a loan or investment 

d) To calculate the internal rate of return for an investment 

Which financial function in Excel is used to calculate the payment for a loan or 

investment based on constant payments? 

a) PV 
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b) FV 

c) PMT 

d) RATE 

 

2.8 LOGICAL FUNCTIONS 

Excel provides several logical functions that allow you to perform operations based 

on logical conditions. 

 
Here are some common logical functions in Excel 

 
● IF Function 

● AND Function 

● OR Function 

● NOT Function 

● IFERROR Function 

● IFNA function 

 
Let us explore each function with an 

example. IF function 

Checks whether a condition is met and returns one value if TRUE and another 

value if FALSE. 

 
=IF(logical_test, value_if_true, value_if_false) 

 
Example: Suppose you want to check if the value in cell A1 is greater than 

10. If it is, return "Yes"; otherwise, return "No". 

 
=IF(A1 > 10, "Yes", "No") 

 
AND Function: Checks if all arguments evaluate to TRUE and returns 

TRUE if all conditions are met; otherwise, returns FALSE. 

 
=AND(condition1, condition2, ...) 

 
Example: Check if both cell A1 and B1 contain values greater than 10. 

 
=AND(A1 > 10, B1 > 10) 

 
OR Function: Checks if any of the arguments evaluate to TRUE and returns 
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TRUE if at least one condition is met; otherwise, returns FALSE. 

 
=OR(condition1, condition2, ...) 

Example: Check if either cell A1 or B1 contains a value greater than 10. 

 
=OR(A1 > 10, B1 > 10) 

 
NOT Function: Reverses the logical value of its argument. Returns TRUE if the 

argument is FALSE and vice versa. 

 
=NOT(condition) 

 
Example: Check if the value in cell A1 is NOT equal to 10. 

 
=NOT(A1 = 10) 

 
IFERROR Function: Checks for errors in a formula and returns a custom result if 

an error is found. 

 
=IFERROR(formula, value_if_error) 

 
Example: If a division by zero error occurs in cell A1, return "Error" instead of 

the error message. 

 
=IFERROR(1/A1, "Error") 

 
IFNA Function: Checks for the #N/A error value and returns a custom result if 

#N/A is found. 

 
=IFNA(value, value_if_na) 

 
Example: If cell A1 contains #N/A, return "Not Available". 

 
=IFNA(A1, "Not Available") 

 
These logical functions help you build complex formulas and perform conditional 

calculations based on specific criteria in your Excel spreadsheets. 
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Let Us Sum UP 

Excel's logical functions enable operations based on conditions. Common ones include 

IF, AND, OR, NOT, IFERROR, and IFNA. The IF function checks a condition and returns 

values accordingly. Example: =IF(A1 > 10, "Yes", "No"). AND returns TRUE if all 

conditions are met, OR if any are true, NOT reverses logical values. IFERROR handles 

errors in formulas, IFNA deals with #N/A errors. Example: =IFERROR(1/A1, "Error"), 

=IFNA(A1, "Not Available"). These functions allow for complex formulas, facilitating 

conditional calculations in Excel, aiding users in managing data effectively based on 

specific criteria and conditions. 

Check your progress 

Which logical function in Excel checks if all arguments evaluate to TRUE? 

a) IF 

b) AND 

c) OR 

d) NOT 

What Excel function checks for errors in a formula and returns a custom result if an 

error is found? 

a) IFERROR 

b) IFNA 

c) AND 

d) OR 

Which Excel function is used to check if a condition is met and returns one value if 

TRUE and another value if FALSE? 

a) AND 

b) OR 

c) IF 

d) NOT 
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2.9 TEXT FUNCTIONS 

In Excel, text functions are used to manipulate and work with text strings. They allow 

users to perform various operations such as extracting substrings, converting text case, 

finding specific characters, and more. 

 
The commonly used text functions in Excel are: 

 
● LEFT 

● RIGHT 

● MID 

● LEN 

● LOWER 

● UPPER 

● PROPER 

● CONCATENATE 

● FIND 

● SEARCH 

Let us explore each of this functions with 

example LEFT(text, [num_chars]): 

Returns the leftmost characters from a text string. 

 
Example: =LEFT("Excel is great", 5) returns "Excel". 

 
RIGHT(text, [num_chars]): 

Returns the rightmost characters from a text string. 

 
Example: =RIGHT("Excel is great", 5) returns "great". 

 
MID(text, start_num, num_chars): 

Returns a specific number of characters from a text string, starting at the position you specify. 

 
Example: =MID("Excel is great", 7, 2) returns "is". 

 
LEN(text): 
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Returns the number of characters in a text string. 

 
Example: =LEN("Excel is great") returns 13. 

 
LOWER(text): 

Converts text to lowercase. 

 
Example: =LOWER("Hello World") returns "hello world". 

 
UPPER(text): 

Converts text to uppercase. 

 
Example: =UPPER("Hello World") returns "HELLO WORLD". 

 
PROPER(text): 

Capitalizes the first letter of each word in a text string. 

 
Example: =PROPER("hello world") returns "Hello World". 

 
CONCATENATE(text1, [text2], ...): 

Joins several text strings into one text string. 

 
Example: =CONCATENATE("Hello", " ", "World") returns "Hello World". 

 
FIND(find_text, within_text, [start_num]): 

Finds one text string within another (case-sensitive) and returns the starting position of 

the first occurrence. 

 
Example: =FIND("is", "Excel is great") returns 7. 

 
SEARCH(find_text, within_text, [start_num]): 

Finds one text string within another (not case-sensitive) and returns the starting position 

of the first occurrence. 

 
Example: =SEARCH("IS", "Excel is great") returns 7. 

 
These are just a few examples of the numerous text functions available in Excel. They 

can be combined and nested within each other to perform more complex operations on 

text data within spreadsheets. 
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Let Us Sum Up 

Excel's text functions facilitate text string manipulation and analysis. Common functions 

include LEFT, RIGHT, MID, LEN, LOWER, UPPER, PROPER, CONCATENATE, 

FIND, and 

SEARCH. LEFT and RIGHT extract characters from the start or end of a string. MID 

retrieves characters from a specified position. LEN counts characters. LOWER, 

UPPER, and PROPER change case. CONCATENATE joins strings. FIND and SEARCH 

locate text within a string, with SEARCH being case-insensitive. These functions 

empower users to manipulate text efficiently, allowing for diverse operations such as 

substring extraction, case conversion, and string concatenation, enhancing data 

analysis and presentation in Excel spreadsheets. 

Check your progress 

What does the LEFT function in Excel do? 

a) Returns the leftmost characters from a text string 

b) Returns the rightmost characters from a text string 

c) Returns a specific number of characters from a text string, starting at the 

position you specify 

d) Returns the number of characters in a text string 

Which text function in Excel is used to capitalize the first letter of each word in a text string? 

a) LEFT 

b) RIGHT 

c) PROPER 

d) CONCATENATE 

What does the FIND function in Excel do? 

a) Finds one text string within another (case-sensitive) and returns the starting 

position of the first occurrence. 

b) Finds one text string within another (not case-sensitive) and returns the starting 

position of the first occurrence. 

c) Returns the number of characters in a text string. 

d) Joins several text strings into one text string. 

 
 

Which Excel function would you use to capitalize all words in a text string? 
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A) UPPER 

B) LOWER 

C) PROPER 

D) CONCATENAT

E Answer: C) 

PROPER 

If you want to find the starting position of the word "world" in the text string "Hello 

world, how are you?", which function would you use? 

A) FIND("world", "Hello world, how are you?") 

B) SEARCH("world", "Hello world, how are you?") 

C) FIND("world", "Hello world, how are you?", 1) 

D) SEARCH("world", "Hello world, how are you?", 1) 

 

2.10  STATISTICAL FUNCTIONS 

Statistical functions in Excel are used to analyze data sets, calculate descriptive 

statistics, and perform various statistical operations. 

 
The commonly used statistical functions in Excel are: 

 
● AVERAGE 

● MEDIAN 

● MODE 

● STDEV 

● STDDEVP 

● VAR 

● VARP 

● COUNT 

● MAX 

● MIN 

 
AVERAGE(range): 

Calculates the arithmetic mean of a range of numbers. 
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Example: =AVERAGE(A1:A10) calculates the average of numbers in cells A1 to A10. 

 
MEDIAN(range): 

Returns the median (middle value) of a range of numbers. 

 
Example: =MEDIAN(B1:B20) returns the median of numbers in cells B1 to B20. 

 
MODE(range): 

Returns the most frequently occurring value in a range of numbers. 

 
Example: =MODE(C1:C15) returns the mode of numbers in cells C1 to C15. 

 
STDEV(range): 

Estimates the standard deviation based on a sample of numbers in a range. 

 
Example: =STDEV(D1:D30) calculates the standard deviation of numbers in 

cells D1 to D30. 

 
STDEVP(range): 

Calculates the standard deviation of a population based on an entire population of numbers. 

 
Example: =STDEVP(E1:E25) calculates the standard deviation of the entire 

population in cells E1 to E25. 

 
VAR(range): 

Estimates the variance based on a sample of numbers in a range. 

 
Example: =VAR(F1:F40) calculates the variance of numbers in cells F1 to F40. 

 
VARP(range): 

Calculates the variance of a population based on an entire population of numbers. 

 
Example: =VARP(G1:G35) calculates the variance of the entire population in 

cells G1 to G35. 

 
COUNT(range): 
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Counts the number of cells in a range that contain numbers. 

 
Example: =COUNT(H1:H50) counts the number of cells in the range H1 to 

H50 that contain numbers. 

 
MAX(range): 

Returns the largest value from a range of numbers. 

 
Example: =MAX(I1:I60) returns the maximum value from cells I1 to I60. 

 
MIN(range): 

Returns the smallest value from a range of numbers. 

 
Example: =MIN(J1:J70) returns the minimum value from cells J1 to J70. 

 
These functions can be combined and nested within each other to perform more 

complex statistical analyses in Excel. They are essential tools for summarizing and 

understanding numerical data in spreadsheets. 

 

Let Us Sum Up 

 
Excel's statistical functions facilitate data analysis by calculating descriptive statistics 

and performing various statistical operations. Common functions include AVERAGE, 

MEDIAN, MODE, STDEV, STDDEVP, VAR, VARP, COUNT, MAX, and MIN. AVERAGE 

computes the 

mean, MEDIAN finds the middle value, MODE identifies the most frequent value, and 

STDEV estimates standard deviation. STDEVP calculates population standard 

deviation, while VAR estimates variance, and VARP calculates population variance. 

COUNT tallies numeric cells, MAX retrieves the maximum value, and MIN the minimum. 

These functions aid in summarizing and comprehending numerical data, enabling users 

to conduct diverse statistical analyses efficiently within Excel spreadsheets. 
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Check your Progress 

Which statistical function in Excel returns the median (middle value) of a range of numbers? 

a) AVERAGE 

b) MEDIAN 

c) MODE 

d) STDEV 

What is the purpose of the STDEV function in Excel? 

a) To calculate the standard deviation based on a sample of numbers 

b) To calculate the variance based on a sample of numbers 

c) To calculate the standard deviation of a population 

d) To calculate the variance of a population 

Unit Summary 

This unit we have explored the different functions used in excel with examples like 

vlookup, hlookup, count, countif, sum, sumif, product, sumproduct etc. We also explored 

the working of different functions in excel like mathematical functions, financial 

functions, logical functions, text functions and statistical functions. In this unit, different 

charts that are available in Excel like bar chart, pie chart, line chart, column chart and 

area chart with examples 

Glossary  

1. VLOOKUP 

Definition: 

-VLOOKUP (Vertical Lookup): A function that searches for a value in the first column of 

a table and returns a value in the same row from a specified column. It's used to find 

data in a vertical list. 

2. HLOOKUP 

Definition: 

HLOOKUP (Horizontal Lookup): A function that searches for a value in the first row of a 

table and returns a value in the same column from a specified row. It's used to find data 

in a horizontal list. 
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3. COUNTIF 

Definition: 

COUNTIF: A function that counts the number of cells within a range that meet a single 

condition or criterion. 

4. SUMPRODUCT 

Definition: 

SUMPRODUCT: A function that multiplies corresponding components in given arrays 

and then returns the sum of those products. It's often used for complex calculations 

involving multiple criteria. 

5. Charts 

Definition: 

Charts: Visual representations of data in Excel that help in understanding patterns, 

trends, and comparisons. Common types of charts include pie charts, bar charts, line 

charts, and scatter plots. 

Self Assessment Questions 

1: What does the VLOOKUP function do in Excel? 

A) Looks up a value in the first column and returns a value from a specified column in the 

same row. 

B) Looks up a value in the first row and returns a value from a specified row in the same 

column. 

C) Finds the highest value in a range and returns it. 

D) Searches for a value and replaces it with a new value. 

Answer: A) Looks up a value in the first column and returns a value from a specified 

column in the same row. 

2: In the HLOOKUP function, what does the argument 2 represent? 

A) The column index from which to return a value. 
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B) The row index from which to return a value. 

C) The number of rows to look up. 

D) The number of columns to look up. 

Answer: B) The row index from which to return a value. 

3: Which type of chart is most suitable for showing the relationship between two 

numerical variables? 

A) Pie Chart 

B) Bar Chart 

C) Line Chart 

D) Scatter Plot 

Answer: D) Scatter Plot 

4: What does the COUNT function do in Excel? 

A) Counts the number of cells containing numbers in a range. 

B) Counts the number of non-empty cells in a range. 

C) Counts the number of cells containing text in a range. 

D) Counts the number of cells that meet a specific condition. 

Answer: A) Counts the number of cells containing numbers in a range. 

5: Which formula counts the number of cells in the range B2 that are equal to "Pending"? 

A) =COUNTIF(B2:B10, "Pending") 

B) =COUNTIF(B2:B10, "Completed") 

C) =COUNT(B2:B10, "Pending") 

D) =COUNTBLANK(B2:B10) 

Answer: A) =COUNTIF(B2:B10, "Pending") 

 



86 Periyar University – CDOE| Self Learning Material 

PU-PRIDE-OLDP MBA - Soft Skills III – Computing Skills UNIT 2 

 

 

  

6: Which function would you use to add up the values in cells C1 through C10? 

A) =SUM(C1:C10) 

B) =ADD(C1:C10) 

C) =TOTAL(C1:C10) 

D) =SUMIF(C1:C10) 

Answer: A) =SUM(C1:C10) 

7: To sum the values in range B2 where the corresponding cells in range A2 are equal to 

"Completed", which formula should be used? 

A) =SUMIF(A2:A10, "Completed", B2:B10) 

B) =SUMIF(B2:B10, "Completed", A2:A10) 

C) =SUMIF(A2:A10, B2:B10, "Completed") 

D) =SUM(B2:B10, A2:A10, "Completed") 

Answer: A) =SUMIF(A2:A10, "Completed", B2:B10) 

8: What does the PRODUCT function do in Excel? 

A) Multiplies all the numbers given as arguments. 

B) Adds all the numbers given as arguments. 

C) Subtracts all the numbers given as arguments. 

D) Divides all the numbers given as arguments. 

Answer: A) Multiplies all the numbers given as arguments. 

9: Which formula calculates the total revenue by multiplying quantities in column A with 

prices in column B and summing the results? 

A) =SUMPRODUCT(A2:A10, B2:B10) 

B) =SUM(A2:A10 * B2:B10) 

C) =PRODUCT(A2:A10, B2:B10) 

D) =SUM(A2:A10 + B2:B10) 
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Answer: A) =SUMPRODUCT(A2:A10, B2:B10) 

10: What is the result of the formula =IF(A1 > 10, "Over 10", "10 or less") if cell A1 

contains the value 15? 

A) "Over 10" 

B) "10 or less" 

C) 15 

D) TRUE 

      Answer: A) "Over 10" 

Activities 

Activity: Monthly Sales Report and Analysis 

Objective: Utilize advanced Excel functions to analyze sales data, generate summaries, 

and create a chart for visual representation. 

Instructions: 

1. Set Up Your Workbook: 

o Open a New Workbook in Excel. 

2. Enter Raw Data: 

o In Sheet1, manually input the following data into a range of cells (without using a 

table format): 

 A1: Product Name 

 A2: Product A 

 A3: Product B 

 A4: Product C 

 A5: Product D 

 A6: Product E 

 B1: Sales Amount 
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 B2: 1000 

 B3: 1500 

 B4: 1200 

 B5: 1800 

 B6: 1600 

 C1: Quantity Sold 

 C2: 50 

 C3: 60 

 C4: 55 

 C5: 70 

 C6: 65 

 D1: Month 

 D2: January 

 D3: January 

 D4: February 

 D5: February 

 D6: March 

3. Calculate Total Sales Using SUM Function: 

o In Sheet2, type the following: 

 A1: Total Sales 

 B1: =SUM(Sheet1!B2:B6) 

o This formula calculates the total sales amount from the range B2 

. 

4. Find the Average Quantity Sold Using AVERAGE Function: 



89 Periyar University – CDOE| Self Learning Material 

PU-PRIDE-OLDP MBA - Soft Skills III – Computing Skills UNIT 2 

 

 

  

o In Sheet2, type: 

 A2: Average Quantity Sold 

 B2: =AVERAGE(Sheet1!C2:C6) 

o This formula calculates the average quantity sold from the range C2 

. 

5. Use VLOOKUP to Find Sales for a Specific Product: 

o In Sheet2, type: 

 A3: Sales for Product C 

 B3: =VLOOKUP("Product C", Sheet1!A2:C6, 2, FALSE) 

o This formula retrieves the sales amount for "Product C" from the Sales Amount 

column. 

6. Use COUNTIF to Count Products Sold More Than 60 Units: 

o In Sheet2, type: 

 A4: Products Sold > 60 Units 

 B4: =COUNTIF(Sheet1!C2:C6, ">60") 

o This formula counts the number of products sold in quantities greater than 60 

units. 

7. Create a Chart for Sales Amount by Product: 

o Select the range from Sheet1: 

 Select cells A1 

(Product Name and Sales Amount). 

o Go to the "Insert" tab on the Ribbon. 

o Choose a "Column Chart" to visualize the sales amounts for each product. 

o Format the chart to clearly display sales data by product name. 

8. Calculate Total Sales Value by Multiplying Quantity and Sales Amount Using 
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SUMPRODUCT: 

o In Sheet2, type: 

 A5: Total Sales Value (Quantity x Sales Amount) 

 B5: =SUMPRODUCT(Sheet1!C2:C6, Sheet1!B2:B6) 

o This formula calculates the total sales value by multiplying each quantity sold by 

its corresponding sales amount and summing the results. 

Outcome: 

By completing this activity, you will: 

 Calculate total and average sales using SUM and AVERAGE functions. 

 Use VLOOKUP to find specific data. 

 Count occurrences based on criteria with COUNTIF. 

 Create and format a chart to visualize sales data. 

 Use SUMPRODUCT to compute total sales value based on quantities and sales 

amounts 

Suggested Readings 

Mehra, S. K. (2012) Business Etiquette A Guide For The Indian Professional. Noula: 

HarperCollins 

 

 
                —----------------—------------ 
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Unit Objectives: 
 To educate the students on MS Access and its application in database 
management 
 

Unit- III MICROSOFT ACCESS 
MS Access – Components, creating a database and project, import and exporting, 
customizing; Tables – creating and setting fields; Queries – types, creating, 
wizards – Reports – creating and layout.,. 
 

3.1 INTRODUCTION TO MICROSOFT Access 

 
Microsoft Access is a powerful relational database management system (RDBMS) 

developed by Microsoft. It is part of the Microsoft Office suite of applications and is 

widely used for creating, managing, and manipulating databases. 

 
MS Access provides users with a user-friendly interface for building databases without 

requiring extensive programming knowledge. It allows users to store, retrieve, and 

manipulate large amounts of data efficiently. With its intuitive design tools and pre-built 

templates, users can quickly create databases to meet their specific needs, whether for 

personal or business use. 

 
Key Features of MS Access: 

 
1. Database Creation: MS Access allows users to create databases from scratch or 

use pre-designed templates to get started quickly. Users can define tables, 

relationships, queries, forms, and reports to organize and analyze their data 

effectively. 

2. Data Management: Users can enter, edit, and manage data easily within Access. 

It supports various data types, including text, numbers, dates, and more, allowing 

for flexible data storage and manipulation. 

3. Querying: MS Access offers powerful querying capabilities to extract specific 

data from databases. Users can create queries using a visual interface or SQL 

(Structured Query Language) to filter, sort, and analyze data based on specific 

criteria. 

4. Forms: Access provides tools for creating custom forms to input and view data in 

a user-friendly manner. Forms can be designed with controls such as text boxes, 

buttons, and drop-down lists to streamline data entry and improve usability. 

5. Reports: MS Access enables users to generate professional-looking reports to 
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summarize and present data. Users can customize report layouts, add 

calculations, and include graphical elements to convey information effectively. 

6. Integration: MS Access integrates seamlessly with other Microsoft Office 

applications, such as Excel, Word, and Outlook. Users can import and export 

data between Access and other Office programs, enhancing productivity and 

collaboration. 

Microsoft Access is a versatile database management tool suitable for individuals, small 

businesses, and organizations of all sizes. Whether you need to track inventory, 

manage customer information, or analyze business data, MS Access provides the tools 

and features to help you build robust database solutions. 

3.1.1 Understanding MS Access components 

Microsoft Access comprises several components that work together to facilitate the 

creation, management, and utilization of databases. These components include: 

 
● Database Engine: The core component of MS Access is its relational database 

engine, responsible for managing data storage, retrieval, and manipulation. It 

organizes data into tables, enforces relationships between tables, and executes 

queries to extract and modify data. 

● Tables: Tables are the fundamental building blocks of an Access database. 

They store data in rows and columns, with each column representing a field and 

each row representing a record. Tables define the structure of the database and 

hold the actual data. 

● Queries: Queries allow users to retrieve, manipulate, and analyze data stored in 

tables. Users can create queries to perform tasks such as filtering, sorting, 

aggregating, and joining data from one or more tables. Queries can be created 

using a visual design interface or by writing SQL (Structured Query Language) 

code. 

● Forms: Forms provide a user-friendly interface for interacting with data in an 

Access database. They allow users to input, edit, and view data in a structured 

and intuitive manner. Forms can include various controls such as text boxes, 

buttons, drop-down lists, and checkboxes to facilitate data entry and navigation. 

● Reports: Reports enable users to present data from tables and queries in a 

formatted and organized manner. They allow users to generate professional-

looking documents for printing or sharing, incorporating features such as headers, 
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footers, page numbering, and graphical elements. Reports can include calculated 

fields, summaries, and groupings to summarize and analyze data effectively. 

● Macros: Macros are a feature in Access that allows users to automate repetitive 

tasks and perform actions in response to user interactions or events. Users can 

create macros to automate tasks such as opening forms, running queries, or 

executing custom actions. Modules: Modules are containers for storing Visual 

Basic for Applications (VBA) code in an Access database. Users can write 

custom VBA code to extend the functionality of Access, automate complex 

processes, or implement custom business logic. Modules allow for advanced 

customization and integration with other applications. 

 
These components work together to provide users with a comprehensive toolset for 

creating and managing databases in Microsoft Access, enabling efficient data storage, 

retrieval, analysis, and reporting. 

 
3.1.2 Creating a new database and project 

 
Creating a new database 

Creating a new database in Microsoft Access is a straightforward process. Here are the 

steps to create a new database: 

 
Open Microsoft Access: Launch Microsoft Access on your computer. You can 

typically find it in the Microsoft Office folder in your Start menu or Applications 

folder (depending on your operating system). 

Choose a Database Template (Optional): Upon opening Access, you may be 

presented with a list of database templates to choose from. These templates 

provide pre-designed structures for common database types, such as inventory 

management, contacts, or task tracking. You can select a template that best 

matches your needs or choose to create a blank database. 

Select "Blank Database" (If Not Using a Template): If you opt not to use a 

template or if you've dismissed the template selection screen, you'll start with a 

blank database. Click on the "Blank Database" option to proceed. 

Name Your Database: After selecting the blank database option, a dialog box will 

prompt you to name your new database. Enter a descriptive name for your 

database in the "File Name" field. This name will be used to identify your 
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database file (.accdb) on your computer. 
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Choose a Location: Specify the location where you want to save your database 

file. You can select an existing folder or create a new one. It's advisable to 

choose a location that's easily accessible and well-organized for future reference. 

Click "Create": Once you've named your database and chosen a location, click 

the "Create" button. Access will then create a new blank database file with 

the specified name and save it to the selected location. 

Access the New Database: After the database is created, you can start working 

with it. Access will open the new database file, displaying a blank workspace 

where you can begin designing tables, queries, forms, and reports, depending on 

your database needs. 

Begin Designing Your Database: Now that your new database is created, you 

can start designing its structure and adding objects such as tables, queries, 

forms, and reports. Use the various design tools and features in Access to 

customize your database according to your requirements. 

 
By following these steps, you can create a new database in Microsoft Access and begin 

building your database solution to manage and analyze your data effectively. 

 
Creating a project 

In Microsoft Access, creating a project typically refers to creating a new database 

project to organize related database objects, such as tables, queries, forms, reports, 

macros, and modules. Here are the steps to create a new project in MS Access: 

 
Open Microsoft Access: Launch Microsoft Access on your computer. You can 

find it in the Microsoft Office folder in your Start menu or Applications folder 

(depending on your operating system). 

Create a New Database: To create a new project, you first need to create a new 

database. You can either choose to create a blank database or start with a 

database template. If you choose to start with a template, Access provides 

various pre-designed templates for common database types. If you prefer to start 

with a blank database, select the "Blank Database" option. 
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Name Your Database: After selecting the option to create a new database, 

Access will prompt you to provide a name for your database project. Enter a 

descriptive name for your project in the "File Name" field. 

Choose a Location: Specify the location where you want to save your 

database project file (.accdb). You can select an existing folder or create a new 

one. Choose a location that's easily accessible and well-organized for future 

reference. 

Click "Create": Once you've named your database project and chosen a location, 

click the "Create" button. Access will then create a new blank database project file 

and save it to the specified location. 

Access the New Database Project: After the database project is created, Access 

will open the new project file, displaying a blank workspace where you can begin 

designing and organizing your database objects. 

Organize Database Objects: Begin organizing your database objects within the 

project. You can create and design tables to store data, create queries to analyze 

and manipulate data, design forms for data entry and user interaction, and create 

reports for presenting and summarizing data. Additionally, you can create macros 

and modules to automate tasks and add custom functionality to your project. 

Save Your Work: It's essential to save your work periodically as you progress. 

Access automatically saves changes to your database project as you work, but 

you can also manually save your project file by clicking the "Save" button or 

selecting "Save" from the File menu. 

 
By following these steps, you can create a new project in Microsoft Access and begin 

designing and organizing your database objects to build a comprehensive database 

solution tailored to your needs. 

3.1.3 Importing and exporting data 

 
 

Importing and exporting data in Microsoft Access allows users to move data between 

Access databases, Excel spreadsheets, text files, and other external data sources. Here 

are the steps to import and export data in MS Access: 
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Importing Data: 

Open Your Access Database: Launch Microsoft Access and open the database 

where you want to import data. 

Select the External Data Tab: In the ribbon at the top of the Access window, click 

on the "External Data" tab. This tab contains commands related to importing and 

exporting data. Choose the Data Source: Click on the appropriate option to select 

the type of data source you want to import from. Options may include Excel, Text 

File, Access, ODBC Database, etc. 

Follow the Wizard: Access will guide you through a wizard to import the data. 

You'll need to specify details such as the file location, data source name, and 

whether the first row contains column headings. 

Select Import Options: Depending on the data source, Access may offer 

additional import options such as specifying the delimiter for text files, choosing 

the worksheet in an Excel file, or selecting specific tables from an Access 

database. 

Review Data: After selecting import options, Access will display a preview of the 

data to be imported. Review the data to ensure it appears as expected. 

Complete Import: Once you're satisfied with the import settings and previewed 

data, proceed to complete the import process. Access will import the data into 

your database. 
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Exporting Data: 

Open Your Access Database: Launch Microsoft Access and open the database 

containing the data you want to export. 

Select the External Data Tab: Click on the "External Data" tab in the ribbon at the 

top of the Access window. 

Choose the Data Source: Click on the appropriate option to select the type of 

data you want to export. Options may include Excel, Text File, Access, ODBC 

Database, etc. 

Select Data to Export: Choose the specific data you want to export. This could be 

a table, query, form, or report within your Access database. 

Follow the Wizard: Access will guide you through a wizard to export the selected 

data. You'll need to specify details such as the file location, export format, and 

any formatting options. 

Review Export Options: Depending on the export format, Access may offer 

additional options such as field delimiters, file encoding, or layout settings. 

Complete Export: Once you've reviewed and confirmed the export options, 

proceed to complete the export process. Access will export the selected data to 

the specified file format and location. 
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By following these steps, you can easily import data into Microsoft Access from external 

sources and export data from Access to other formats for use in different applications or 

analysis purposes. 

 
3.1.4 Customizing MS Access Interface 

Customizing the Microsoft Access interface allows users to tailor the appearance and 

functionality of the application to their specific preferences and needs. Here are some 

ways to customize the MS Access interface: 

 
Ribbon Customization: 

● Right-click on the ribbon and select "Customize the Ribbon." 

● In the Access Options dialog box, you can customize the ribbon by 

adding, removing, or rearranging tabs and groups. 

● You can also create custom tabs and groups, and assign commands 

to them. Quick Access Toolbar: 

● Customize the Quick Access Toolbar by clicking on the dropdown arrow 

next to it and selecting "More Commands." 

● From here, you can add frequently used commands to the toolbar for 

quick access. 

Navigation Pane: 

● Customize the Navigation Pane by right-clicking on it and selecting 

"Navigation Options." 

● Here, you can choose which objects (tables, queries, forms, reports, 

etc.) are displayed in the Navigation Pane and how they are sorted. 

Form and Report Design: 

● Customize the design of forms and reports by adding controls, changing 

colors, fonts, and formatting. 

● Use the Design View to modify the layout and properties of form and 

report controls. 

Themes and Templates: 

● Access provides built-in themes and templates that you can apply to 

forms, reports, and databases to change their appearance. 
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● You can also create custom themes and templates to match your 

branding or design preferences. 

Options and Settings: 

● Access the Access Options dialog box by clicking on "File" > "Options." 

● Here, you can customize various settings related to the interface, 

datasheet view, object design, and more. 

Startup Options: 

● Customize the startup options by going to "File" > "Options" > "Current 

Database." 

● Here, you can specify which form or report opens when the database is 

launched, set startup options for a shared database, and configure 

navigation options. 

Keyboard Shortcuts: 

● Customize keyboard shortcuts by going to "File" > "Options" > 

"Customize Ribbon" > "Keyboard Shortcuts." 

● Here, you can assign or modify keyboard shortcuts for various 

commands and functions in Access. 
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By utilizing these customization options, users can personalize the Microsoft Access 

interface to suit their workflow and improve efficiency when working with databases and 

database objects. 

Let Us Sum Up 

Microsoft Access, part of the Microsoft Office suite, is a robust relational database 

management system (RDBMS). It offers an intuitive interface for database creation, 

management, and manipulation, catering to users without extensive programming 

knowledge. Key features include database creation, data management, querying, forms, 

reports, and seamless integration with other Office applications. MS Access is versatile, 

serving individuals, small businesses, and large organizations. Understanding its 

components reveals the database engine's role in managing data, tables' organization, 

querying capabilities, form interface, report generation, and customization through 

macros and modules. Creating new projects involves naming, selecting a location, and 

designing database elements. Importing and exporting data facilitate seamless data 

transfer, while interface customization enhances user experience and productivity. 

Check your progress 

1. Which of the following is NOT a key feature of Microsoft Access? 

A) Database creation 

B) Data management 

C) Spreadsheet editing 

D) Querying 

2. What is the primary function of the Database Engine in Microsoft Access? 

A) Designing forms 

B) Managing data storage and retrieval 

C) Customizing reports 

D) Writing VBA code 

3. Which component of Microsoft Access allows users to create custom interfaces 

for data entry? 

A) Queries 

B) Macros 

C) Forms 

D) Modules 
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4. What is the purpose of importing data in Microsoft Access? 

A) To create new database objects 

B) To move data between Access databases 

C) To customize the interface 

D) To generate reports 

5. How can users customize the Quick Access Toolbar in Microsoft Access? 

A) By rearranging tables and queries 

B) By adding frequently used commands 

C) By changing font styles 

D) By creating custom  

Answer Key 

1. C) Spreadsheet editing 

2. B) Managing data storage and retrieval 

3. C) Forms 

4. B) To move data between Access databases 

5. B) By adding frequently used commands 

 

3.2  Tables in MS Access 

In Microsoft Access, tables serve as fundamental components for organizing and 

storing data within a database. Here's an overview of tables in MS Access: 

 
Structure: Tables in MS Access are structured as grids, with columns 

representing fields and rows representing records. Each field holds a specific 

type of data, such as text, numbers, dates, or binary data. 

Data Storage: Tables store data in a structured format, allowing users to 

efficiently manage and retrieve information. Users can define the data types, 

formats, and constraints for each field to ensure data integrity. 

Primary Key: In Access, tables typically have a primary key, which is a unique 

identifier for each record. This primary key ensures that each record in the table 

is distinct and identifiable. 

Relationships: Tables can be related to each other through common fields, 

establishing relationships that define how data in one table relates to data in 

another. These relationships are essential for maintaining data consistency and 

integrity across the database. 
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Design View: Users can view and modify the structure of tables in Design View, 

where they can add, remove, or modify fields, set data types and properties, and 

define relationships with other tables. 

Data Entry: Tables in MS Access provide a user-friendly interface for entering 

and editing data. Users can input data directly into tables or use forms for 

more structured data entry. 

Indexing: Access allows users to create indexes on fields within tables to improve 

data retrieval performance. Indexes speed up query processing by organizing 

data in a specified order and facilitating quicker data access. 

Import and Export: Tables can be imported from external sources, such as Excel 

spreadsheets or text files, into an Access database. Similarly, users can export 

tables from Access to other formats for sharing or analysis purposes. 

Overall, tables are foundational elements in MS Access databases, providing a 

structured framework for organizing, storing, and managing data effectively. They play a 

crucial role in building robust database solutions tailored to the specific needs of users 

and organizations. 

3.2.1 Creating tables 

Creating tables in Microsoft Access involves several steps to define the structure and 

properties of the table. Here's a detailed explanation of the process: 

 
Open Microsoft Access: Launch Microsoft Access on your computer. You can 

typically find it in the Microsoft Office folder in your Start menu or Applications 

folder, depending on your operating system. 

Create a New Database or Open an Existing One: You can either create a new 

database or open an existing one where you want to create the table. To create a 

new database, click on "File" > "New" > "Blank Database." Specify the name and 

location for the new database file and click "Create." 

Navigate to the Tables Tab: In the navigation pane on the left side of the Access 

window, click on the "Tables" tab. This will display a list of existing tables in the 

database, if any. Create a New Table: To create a new table, click on the "New" 

button in the Tables tab. You'll have several options for creating a table: 

● Table Design: Allows you to define the table structure manually. 

● Datasheet View: Provides a spreadsheet-like interface for entering data 

directly into the table. 
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● Import Table: Lets you import data from external sources into a new table. 

● Table Wizard: Guides you through a step-by-step process to create a 

table based on predefined templates. 

Choose Table Design: If you select "Table Design," Access opens the table in 

Design View, where you can define the fields and properties of the table. 

Define Table Fields: In Design View, you'll see a grid with columns for Field 

Name, Data Type, Description, and other properties. Enter the details for each 

field, including: 

● Field Name: Name of the field (e.g., "CustomerID"). 

● Data Type: Type of data the field will store (e.g., Text, Number, Date/Time). 

● Description: Optional description or explanation of the field. 
 

 Field Properties: Additional properties specific to the data type, such as 

field size, format, default value, validation rules, and index settings. 

Set Primary Key (Optional): If one of the fields will serve as the primary key, 

select the field in Design View and click on the "Primary Key" button in the 

toolbar. Alternatively, you can right-click on the field and choose "Primary Key" 

from the context menu. 

Save the Table: Once you've defined the table structure and properties, click on 

the "Save" button in the toolbar. Access will prompt you to enter a name for the 

table. Provide a descriptive name and click "OK" to save the table. 

Close the Table: After saving the table, you can close the Design View window. 

Access will return you to the Tables tab, where you can see the newly created 

table listed. 
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By following these steps, you can create tables in Microsoft Access and define their 

structure and properties to store and manage your data effectively within the database. 

 
3.2.2 Setting fields and data types 

Setting fields and data types in Microsoft Access involves defining the structure of each 

field in a table, specifying the type of data it will store, and configuring additional 

properties as needed. Here are the steps to set fields and data types in MS Access: 
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Open Microsoft Access: Launch Microsoft Access on your computer and 

open the database where you want to set fields and data types. 

Navigate to the Tables Tab: In the navigation pane on the left side of the Access 

window, click on the "Tables" tab. This will display a list of existing tables in the 

database, if any. Select or Create a Table: Choose the table where you want 

to set fields and data types. You can either select an existing table or create a 

new one by clicking on the "New" button in the Tables tab and selecting "Table 

Design." 

Enter Design View: If you're creating a new table, you'll enter Design View 

automatically. If you're modifying an existing table, right-click on the table name 

in the Tables tab and select "Design View." 

Define Field Names: In Design View, you'll see a grid with columns for Field 

Name, Data Type, Description, and other properties. Enter the names of the 

fields in the "Field Name" column. Each field represents a column in the table. 

Set Data Types: In the "Data Type" column, select the appropriate data type for 

each field from the dropdown list. Common data types in Access include: 

● Text: Stores alphanumeric characters. 

● Number: Stores numeric values. 

● Date/Time: Stores date and time values. 

● Currency: Stores monetary values. 

● Yes/No: Stores boolean (true/false) values. 

● Memo: Stores large amounts of text. 

● Attachment: Stores files or documents as attachments. 

● OLE Object: Stores objects from other applications. 

Configure Additional Properties (Optional): Depending on the selected data 

type, you may need to configure additional properties for each field. These 

properties include: 

● Field Size: Limits the number of characters for text fields. 

● Format: Specifies the display format for date/time fields. 

● Default Value: Sets a default value for the field. 

● Validation Rule: Defines criteria for valid data entry. 

● Required: Specifies whether the field requires a value. 

● Indexed: Creates an index for the field to improve search performance. 
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Set Primary Key (Optional): If one of the fields will serve as the primary key, 

select the field in Design View and click on the "Primary Key" button in the 

toolbar. Alternatively, you can right-click on the field and choose "Primary Key" 

from the context menu. 

Save the Table: Once you've defined the fields and data types, click on the 

"Save" button in the toolbar to save the changes to the table design. 

Close Design View: After saving the changes, you can close the Design View 

window. Access will prompt you to confirm saving the changes if you haven't 

already done so. 

 

 
By following these steps, you can set fields and data types in Microsoft Access to 

define the structure of your tables and specify the type of data they will store within the 

database. 
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3.2.3  Defining relationships between tables 

Defining relationships between tables in Microsoft Access is crucial for establishing 

connections and maintaining data integrity in a relational database. Here's a step-by-

step guide to defining relationships between tables: 

 
Open Microsoft Access: Launch Microsoft Access on your computer and open 

the database containing the tables you want to establish relationships between. 

Navigate to Relationships View: In the navigation pane on the left side of the 

Access window, locate and click on the "Database Tools" tab. Then, click on the 

"Relationships" button. If prompted, confirm that you want to enable the 

automatic creation of relationships between related tables. 

Add Tables: In the Relationships View window, you'll see a list of all tables in the 

database. Drag and drop the tables you want to establish relationships between 

from the navigation pane onto the design grid. 

Define Relationships: Once the tables are added to the design grid, Access will 

attempt to automatically detect potential relationships based on common field 

names and data types. However, you may need to manually define relationships 

in some cases: 

● Click on and hold down the primary key field (usually denoted by a key 

icon) in one table. 

● Drag the primary key field to the corresponding foreign key field in the 

related table. The foreign key field is typically the one that references the 

primary key in the related table. 

● Release the mouse button to create the relationship line between the two 

fields. Edit Relationship Properties (Optional): Double-click on the relationship 

line to open the Edit Relationships dialog box. Here, you can: 

● Specify the join type (e.g., one-to-many, many-to-many). 

● Enforce referential integrity to ensure data consistency. 

● Enable cascade update and cascade delete options to automatically 

update or delete related records. 
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Confirm Relationships: After defining the relationships, click on the "Create" 

button in the Edit Relationships dialog box to confirm the relationship. The 

relationship line will appear with arrowheads indicating the direction of the 

relationship (one-to-many). 

Review Relationships: Review the Relationships View to ensure that all desired 

relationships have been defined correctly. You can zoom in or out, rearrange 

tables, and adjust layout options for better visibility. 

Save Relationships: Click on the "Save" button in the toolbar to save the defined 

relationships between tables. 

Close Relationships View: Once you've saved the relationships, you can close 

the Relationships View window. Access may prompt you to confirm saving 

changes if you haven't already done so. 

 

 
By following these steps, you can define relationships between tables in Microsoft Access, 

establishing connections that ensure data consistency and integrity throughout the database. 

Let Us Sum Up 

In Microsoft  Access, tables  are fundamental  for  data organization,  structured as 

grids with columns as fields and rows as records. They store data efficiently, allowing 

users to define types 
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and ensure integrity. Each table typically has a primary key for record identification. 

Relationships between tables ensure data consistency. Design View enables 

customization of table structure, while data can be input directly or via forms. Indexes 

enhance data retrieval, and tables support import/export functionalities. Crucially, tables 

form the foundation of Access databases, providing a structured framework for effective 

data management, tailored to user and organizational requirements. 

Check Your progress 

What do columns represent in tables within Microsoft Access? 

a) Records 

b) Fields 

c) Data types 

d) Constraints 

What is the purpose of a primary key in Access tables? 

a) Storing binary data 

b) Defining relationships 

c) Ensuring data integrity 

d) Specifying field properties 

Which view in Access allows users to modify table structure and properties? 

a) Data Entry View 

b) Design View 

c) Datasheet View 

d) Relationship View 

What feature in Access improves data retrieval performance by organizing data in a 

specified order? 

a) Data Entry 

b) Indexing 

c) Data Storage 

d) Import and Export 

How are relationships between tables typically established in Access? 

a) Through field descriptions 

b) Using relationship menu 
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c) Using import/export functions 

d) By setting primary keys 

 
 

Answer Key 

Answer: b) Fields 

Answer: c) Ensuring data 

integrity Answer: b) Design 

View 

Answer: b) Indexing 

Answer: b) Using relationship menu 

3.3 QUERIES IN MS Access 

· Introduction to Queries 

- Types of Queries (Select, Action, Parameter, Crosstab, etc.) 

· Creating Queries using Query Design View 

· Using Query Wizards for Quick Query Creation 

 
 

3.3.1 Introduction to queries 

In Microsoft Access, queries are powerful tools used to retrieve, manipulate, and 

analyze data stored in tables. They provide a way to extract specific information from 

one or more tables based on defined criteria or conditions. Queries allow users to 

perform tasks such as filtering records, sorting data, performing calculations, and 

combining information from multiple tables. 

 
With queries, users can create custom views of data without altering the original tables. 

This capability enhances data management and analysis by providing a flexible and 

efficient means of accessing information. Access offers various types of queries, 

including select queries, parameter queries, action queries, and aggregate queries, each 

serving different purposes and catering to specific data manipulation needs. 

 
Queries in Access are typically created using the Query Design View, where users can 

visually design their queries by selecting tables, specifying criteria, and defining 

calculations. Alternatively, users can utilize the Query Wizard to guide them through the 

process of creating basic queries based on predefined templates. 

 
Overall, queries play a crucial role in database management and analysis in MS 
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Access, enabling users to extract valuable insights and generate customized views of 

their data with ease and precision. 

3.2.2 Types of Queries (Select, Action, Parameter, Crosstab, etc.) 

In Microsoft Access, there are several types of queries, each serving different purposes 

and facilitating various data manipulation tasks. Here's an explanation of the most 

common types of queries: 

Select Query: 

● A Select Query is the most basic type of query in Access. 

● It retrieves data from one or more tables based on specified criteria. 

● Users can select specific fields to include in the query result and define 

criteria to filter records. 

● Select queries are commonly used for retrieving information and 

generating customized views of data. 

Action Query: 

● Action Queries perform operations that modify data in tables. 

● Examples include: 

● Append Query: Adds records from one or more tables to another table. 

● Delete Query: Removes records from a table based on specified criteria. 

● Update Query: Modifies existing records in a table based on 

specified criteria. 

● Make-Table Query: Creates a new table and populates it with 

data based on specified criteria. 

● Action queries are useful for data manipulation tasks such as adding, 

deleting, or updating records. 

Parameter Query: 

● Parameter Queries prompt users to input parameters or criteria when the 

query is run. 

● Users can specify values for parameters, which are then used to filter 

query results dynamically. 

● Parameter queries provide flexibility by allowing users to customize the 

query results at runtime based on their input. 

Crosstab Query: 

● A Crosstab Query is used to summarize and aggregate data in a 

cross-tabular format. 
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● It allows users to analyze data by displaying rows as columns and 

aggregating values based on specified row and column headings. 

● Crosstab queries are commonly used for creating summary reports and 

analyzing data trends. 

Update Query: 

● An Update Query is an action query used to modify existing records in 

a table based on specified criteria. 

● It allows users to update values in one or more fields of a table. 

● Update queries are useful for making bulk changes to data, such as 

correcting errors or updating outdated information. 

Delete Query: 

● A Delete Query is an action query used to remove records from a table 

based on specified criteria. 

● It permanently deletes records that match the specified conditions from the table. 

● Delete queries are handy for removing unnecessary or outdated data from 

a database. 

Make-Table Query: 

● A Make-Table Query creates a new table based on the results of a select query. 

● It allows users to specify criteria for selecting records and defining the 

structure of the new table. 

● Make-table queries are useful for creating temporary tables or generating 

subsets of data for further analysis. 

 
Each type of query in Microsoft Access serves a specific purpose and offers unique 

functionality to meet various data manipulation and analysis needs within a database. 

 
3.3.2 Creating Queries using Query Design View 

Creating queries using Query Design View in Microsoft Access allows users to construct 

custom queries by visually designing the criteria and layout. Here are the steps to create 

queries using Query Design View: 

 
Open Microsoft Access: Launch Microsoft Access on your computer and 

open the database containing the tables you want to query. 
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Navigate to Queries Tab: In the navigation pane on the left side of the Access 

window, click on the "Queries" tab. This will display a list of existing queries in the 

database, if any. 

Create a New Query: To create a new query, click on the "New" button in the 

Queries tab. You'll have several options for creating a query. Choose "Design 

View" to open the Query Design window. 

Add Tables: In the Query Design window, you'll see a Show Table dialog box. 

Select the tables from which you want to query data and click "Add." Close the 

dialog box once you've added all the necessary tables. 

Design Query: In the Query Design window, you'll see a grid with columns for 

Field, Table, and Sort. Drag and drop the fields you want to include in the query 

from the table list onto the design grid. You can also double-click on a field to add 

it to the grid. 

Define Criteria: To specify criteria for filtering records, enter the criteria directly 

into the Criteria row of the grid. You can use comparison operators (e.g., "=", 

"<>", ">", "<"), wildcards (e.g., "*", "?"), and logical operators (e.g., "AND", "OR") 

to define complex criteria. 

Add Sorting: To sort the query results, enter the sorting criteria in the Sort 

row of the grid. You can specify ascending (A-Z) or descending (Z-A) order for 

each field. 

Run the Query: Once you've designed the query, you can run it to see the 

results. Click on the "Run" button in the toolbar, or switch to Datasheet View by 

clicking on the "View" button. Access will display the query results based on the 

specified criteria and sorting. 

Save the Query: If you want to save the query for future use, click on the 

"Save" button in the toolbar. Access will prompt you to enter a name for the query. 

Provide a descriptive name and click "OK" to save the query. 

Close Query Design View: After saving the query, you can close the Query 

Design window. Access will return you to the Queries tab, where you can see the 

newly created query listed. 

 
By following these steps, you can create queries using Query Design View in Microsoft 

Access to retrieve, filter, and sort data from one or more tables within your database. 

Query Wizards 
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In Microsoft Access, Query Wizards provide a quick and easy way to create queries 

without needing to manually design them from scratch. Here's how to use Query 

Wizards for quick query creation: 

 
Open Microsoft Access: Launch Microsoft Access on your computer and open 

the database where you want to create the query. 

Navigate to Queries Tab: In the navigation pane on the left side of the Access 

window, click on the "Queries" tab. This will display a list of existing queries in the 

database, if any. 

Create a New Query: To create a new query using a Query Wizard, click on the 

"New" button in the Queries tab. Choose the type of query you want to create 

from the available options, such as "Simple Query Wizard" or "Cross-tab Query 

Wizard." 

Specify Criteria (OptionSelect Query Type: Once you've chosen a Query Wizard, 

Access will prompt you to select the tables or queries you want to use as data 

sources for the query. Select the appropriate tables or queries from the list and 

click "Next." 

Choose Fields: In the next step, the Query Wizard will ask you to select the fields 

you want to include in the query. You can choose fields from the selected tables 

or queries by moving them from the Available Fields list to the Selected Fields 

list. Click "Next" when you're done. 

al): Depending on the type of query you're creating, the Query Wizard may 

ask you to specify criteria for filtering records. Enter the criteria as requested and 

click "Next." Choose Sorting (Optional): If you want to sort the query results, the 

Query Wizard may provide options for specifying sorting criteria. Choose the 

fields you want to sort by and select the desired sorting order (ascending or 

descending). Click "Next" to proceed. 

Name and Save the Query: Finally, the Query Wizard will prompt you to enter a 

name for the query and specify whether you want to open the query immediately 

or modify the design further. Provide a descriptive name for the query and click 

"Finish" to create the query. 

View Query Results: If you chose to open the query immediately, Access will 

display the query results based on the selections you made in the Query Wizard. 

You can further refine the query or save it for future use. 
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By using Query Wizards in Microsoft Access, you can quickly create queries by 

following a step-by-step process guided by the wizard, making it easier to retrieve and 

analyze data from your database. 

 

Let Us Sum Up 

In Module 3 of Microsoft Access, queries are explored as powerful tools for retrieving, 

manipulating, and analyzing data stored in tables. Various query types like Select, 

Action, Parameter, and Crosstab facilitate different data manipulation tasks. Users can 

create queries using Query Design View, visually designing criteria and layout, or opt for 

Query Wizards for quick query creation. Query Design View allows for precise 

customization of queries by adding tables, defining criteria, and sorting data. Query 

Wizards offer a guided approach, simplifying the query creation process for users. Both 

methods enhance data management and analysis, providing flexibility and efficiency in 

accessing database information. 

Check your progress 

What is the primary purpose of queries in Microsoft Access? 

a) To create tables 

b) To retrieve, manipulate, and analyze data 

c) To design forms 

d) To generate reports 

Which type of query in Microsoft Access allows users to modify existing records in a table? 

a) Select Query 

b) Parameter Query 

c) Update Query 

d) Crosstab Query 

How are queries typically created in Microsoft Access? 

a) Using Visual Basic for Applications (VBA) 

b) Using Query Wizards 

c) Using tables 

d) Using reports 

What is the purpose of a Crosstab Query in Microsoft Access? 

a) To delete records from a table 
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b) To prompt users for input parameters 

c) To summarize and aggregate data in a cross-tabular format 

d) To create a new table based on query results 

Which view in Microsoft Access is used for visually designing queries by selecting 

tables, specifying criteria, and defining calculations? 

a) Form View 

b) Datasheet View 

c) Query Design View 

d) Report 

View Answer 

key 

1. b) To retrieve, manipulate, and analyze data 

2. c) Update Query 

3. b) Using Query Wizards 

4. c) To summarize and aggregate data in a cross-tabular format 

5. c) Query Design View 
 

3.4 Reports in MS Access 

 
4.1 Introduction to Reports 

4.2 Creating Basic Reports 

4.3 Customizing Report Layouts 

4.4 ·Adding Controls and Formatting in Reports 

 
 

4.1 Introduction to Reports 

Reports in Microsoft Access are powerful tools used for presenting and summarizing 

data in a structured and visually appealing format. They provide a way to organize, 

format, and present data from tables or queries in a professional manner, making it 

easier for users to understand and analyze information. 

 
Reports offer various features to enhance data presentation, including customizable 

layouts, formatting options, grouping and sorting capabilities, and calculations. Users 

can design reports to include headers, footers, page numbers, logos, and other 

elements to provide context and improve readability. 
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With reports, users can generate printed documents or electronic files for sharing, 

distributing, or presenting data to stakeholders. Reports play a crucial role in data 

analysis, decision-making, and communication within organizations, enabling users to 

extract valuable insights and convey information effectively. 

 
4.2 CREATING REPORTS 

To create reports in Microsoft Access, you can follow these steps: 

 
Open Microsoft Access: Launch Microsoft Access on your computer. 

Navigate to the Reports Tab: In the navigation pane on the left side of the 

Access window, click on the "Reports" tab. This will display a list of existing 

reports in the database, if any. 

Create a New Report: To create a new report, click on the "New" button in the 

Reports tab. You'll have several options for creating a report: 

● Choose "Design View" to open the Report Design window, where you can 

design the report layout from scratch. 

● Select "Report Wizard" to use a step-by-step wizard that guides you 

through the process of creating a basic report based on a table or query. 

● Pick "Blank Report" to create a report without any predefined layout 

or data source. 

Design the Report (Design View): If you chose Design View, you'll enter the 

Report Design window. Here, you can design the report layout by adding fields, 

labels, images, and other elements. You can drag and drop fields from the Field 

List pane onto the report layout, customize formatting, adjust sizing and 

positioning, and add grouping and sorting if needed. 

Use the Report Wizard: If you chose the Report Wizard, Access will prompt you 

to select a data source (table or query) for the report. Follow the wizard's prompts 

to select fields, specify grouping and sorting options, choose a layout, and 

customize formatting. The wizard will generate the report based on your 

selections. 

Save the Report: Once you've designed the report to your satisfaction, click on 

the "Save" button in the toolbar. Access will prompt you to enter a name for the 

report. Provide a descriptive name and click "OK" to save the report. 

View the Report: After saving the report, you can view it by double-clicking on its 
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name in the navigation pane. Access will display the report in Print Preview 

mode, allowing you to see how it will look when printed or exported. 

Modify the Report (if needed): If you need to make changes to the report layout 

or design, you can reopen it in Design View by right-clicking on its name in the 

navigation pane and selecting "Design View." Make the necessary modifications, 

then save the report again. 

Print or Export the Report: Once you're satisfied with the report, you can print it 

by clicking on the "Print" button in the toolbar or export it to various file formats 

(such as PDF, Excel, or Word) by clicking on the "Export" button and selecting 

the desired format. 

By following these steps, you can create customized reports in Microsoft Access to present 

and summarize your data effectively. 

 
4.3 CUSTOMIZING MS ACCESS REPORTS 

In Microsoft Access, you can customize report layouts in several ways to tailor them 

to your specific needs. Here's how you can do it: 

 
Open the Report in Design View: Double-click on the report's name in the 

navigation pane to open it in Design View. 

Add and Remove Controls: In Design View, you can add various controls to the 

report, such as text boxes, labels, images, and shapes, from the "Design" tab in 

the Ribbon. You can also remove existing controls by selecting them and 

pressing the "Delete" key. 

Adjust Control Properties: Select a control on the report to access its properties 

in the Property Sheet pane. Here, you can modify properties such as the 

control's size, font, color, alignment, and format. You can also set properties 

related to data source fields, such as Control Source and Format. 

Arrange and Align Controls: Use the alignment tools in the "Arrange" group on 

the Ribbon to align controls horizontally or vertically, distribute them evenly, or 

resize them to the same size. You can also drag controls to reposition them on 

the report canvas. 

Group and Sort Data: If your report includes grouped data, you can customize 

group headers and footers by adding additional controls or modifying existing 

ones. You can also adjust the sorting order of grouped data by modifying group 

properties. 
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Apply Themes and Styles: Access provides built-in themes and styles that you 

can apply to your report to change its appearance quickly. You can access these 

options from the "Themes" and "Styles" galleries in the "Themes" group on the 

Ribbon. 

Format Page Layout: Access allows you to customize the page layout of your 

report, including page size, orientation (portrait or landscape), margins, and page 

breaks. You can access these options from the "Page Setup" group on the 

"Design" tab. 

Add Calculated Controls: You can add calculated controls to your report to 

perform calculations based on data in the report. For example, you can add a 

calculated control to calculate the sum, average, count, or other aggregate 

functions of a group of values. 

Preview and Adjust: After making changes to the report layout, switch to Print 

Preview mode to see how the report will look when printed or exported. If 

necessary, make further adjustments based on the preview. 

Save Your Changes: Once you're satisfied with the customized layout, save your 

changes by clicking the "Save" button in the Quick Access Toolbar or pressing 

Ctrl + S. 

 
By following these steps, you can customize report layouts in Microsoft Access to 

create professional-looking reports that effectively present your data. 

4.4 ADDING CONTROLS AND FORMATTING REPORTS 

 
Adding Controls: 

Open the Report in Design View: Double-click on the report's name in the 

navigation pane to open it in Design View. 

Access the Design Tab: Once in Design View, navigate to the "Design" tab on 

the Ribbon. 

Select the Control: Click on the control type you want to add from the Controls 

group on the Ribbon. Common controls include Text Box, Label, Image, and 

Rectangle. 

Place the Control: Click and drag the mouse on the report canvas to draw the 

control at the desired location. Release the mouse button to place the control. 

Adjust Properties: With the control selected, you can adjust its properties in the 
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Property Sheet pane. This includes properties such as Control Source (for data-

bound controls), Font, Color, Size, and Alignment. 

Repeat as Needed: Continue adding controls to the report as necessary, 

following the same process. 

 
Formatting Controls: 

Select the Control: Click on the control you want to format to select it. 

Access Formatting Options: In the Property Sheet pane, navigate to the Format 

tab. Here, you'll find various formatting options specific to the selected control. 

Apply Formatting: Modify the formatting properties as needed. This may 

include changing the font size, font color, background color, border style, and 

more. 

Preview Changes: Switch to Print Preview mode to see how the formatting changes 

affect the appearance of the report. You can do this by clicking the "View" button in the 

Views group on the Ribbon and selecting "Print Preview." 

Adjust as Necessary: If the formatting doesn't look as expected, go back to 

Design View and make further adjustments until you're satisfied. 

Save Your Changes: Once you're happy with the formatting, save your 

changes by clicking the "Save" button in the Quick Access Toolbar or pressing 

Ctrl + S. 

 
In Microsoft Access, you can format reports to improve their appearance and 

readability. Here's how to format reports in MS Access: 

 
Formatting Text and Fields: 

Open the Report in Design View: Double-click on the report's name in the 

navigation pane to open it in Design View. 

Select the Text or Field: Click on the text box or field you want to format to select 

it. Access Formatting Options: In the Property Sheet pane, navigate to the 

Format tab. Here, you'll find various formatting options specific to the selected text 

box or field. 

Apply Formatting: Modify the formatting properties as needed. This may 

include changing the font size, font style, font color, alignment, and more. 

Preview Changes: Switch to Print Preview mode to see how the formatting 
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changes affect the appearance of the report. You can do this by clicking the 

"View" button in the Views group on the Ribbon and selecting "Print Preview." 

Adjust as Necessary: If the formatting doesn't look as expected, go back to 

Design View and make further adjustments until you're satisfied. 

 
Formatting Report Sections: 

Select the Section: Click on the edge of the section you want to format to select 

it. Sections include Report Header, Page Header, Group Header, Detail, Group 

Footer, Page Footer, and Report Footer. 

Access Formatting Options: In the Property Sheet pane, navigate to the Format 

tab. Here, you'll find various formatting options specific to the selected section. 

Apply Formatting: Modify the formatting properties as needed. This may 

include changing the background color, border style, height, and visibility 

of the section. 

Preview Changes: Switch to Print Preview mode to see how the formatting 

changes affect the appearance of the report. 

Adjust as Necessary: If the formatting doesn't look as expected, go back to 

Design View and make further adjustments until you're satisfied. 

 
Adding Graphics and Images: 

Insert the Image Control: Click on the "Image" control in the Controls group 

on the Ribbon, then click and drag on the report canvas to draw the control 

at the desired location. 

Select the Image Control: Click on the image control to select it. 

Access Formatting Options: In the Property Sheet pane, navigate to the Format 

tab. Here, you can adjust properties such as Picture Size Mode (Stretch, Zoom, 

Clip), Picture Alignment, and Picture Type. 

Insert Image: Click on the "Picture" property in the Property Sheet, then click the 

ellipsis (...) button to browse for and select the image file you want to insert. 

Preview Changes: Switch to Print Preview mode to see how the image 

appears in the report. 

Adjust as Necessary: If needed, go back to Design View to resize or reposition 

the image control. 
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Saving Your Changes: 

Once you're satisfied with the formatting changes, save your report by clicking the 

"Save" button in the Quick Access Toolbar or by pressing Ctrl + S. 

 
By following these steps, you can format reports in Microsoft Access to create visually 

appealing and professional-looking documents tailored to your specific needs. 

Let Us Sum Up 

Reports in Microsoft Access are essential tools for presenting and summarizing data 

effectively. They allow users to organize, format, and present data from tables or 

queries professionally. 

Creating basic reports involves opening Access, navigating to the Reports tab, and 

selecting a new report type, such as Design View or Report Wizard. Customizing report 

layouts entails adding controls, adjusting properties, and formatting text and fields. Users 

can also enhance reports by adding graphics and images. Formatting reports involves 

modifying text and field properties, adjusting section formatting, and inserting images. 

These steps ensure that reports are visually appealing and convey information effectively 

to stakeholders. 

Check your progress 

1 What is the primary purpose of reports in Microsoft Access? 

a) Creating tables 

b) Summarizing data 

c) Importing data 

d) Designing queries 

2. Which option allows you to create a report layout from scratch in Access? 

a) Design View 

b) Report Wizard 

c) Blank Report 

d) Query Design View 

3. What feature in Access enables users to add headers, footers, and page numbers to reports? 

a) Data validation 

b) Sorting 

c) Formatting 

d) Themes and styles 

4. How can users customize group headers and footers in a report? 
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a) By using calculated controls 

b) By adding and removing controls 

c) By applying themes and styles 

d) By adjusting formatting options 

5. Which tab in Access allows users to adjust properties such as font size, color, and 

alignment for report elements? 

a) Home 

b) Design 

c) View 

d) Format 

 
 

Answer key 

1. b) Summarizing data 

2. a) Design View 

3. c) Formatting 

4. b) By adding and removing controls 

5. b) Design 

Unit Summary  
 
This unit covers essential aspects of statistical analysis using SPSS (Statistical Package for the Social 

Sciences). It begins with Data Entry, where data is input into SPSS either manually or through file 

imports. Coding follows, involving the transformation of categorical data into numerical codes for easier 

analysis. Percentage Analysis is used to interpret data by expressing it as a percentage of the total. The 

Chi-Square Test examines relationships between categorical variables, while ANOVA (Analysis of 

Variance) compares means across multiple groups to identify significant differences. Correlation 

measures the strength and direction of relationships between continuous variables, and Regression 

models the relationship between a dependent variable and one or more independent variables to make 

predictions. Finally, Garrett Ranking is employed to analyze and rank respondents' preferences or 

opinions systematically. 

GLOSSARY  
  SPSS (Statistical Package for the Social Sciences): A widely used software for 

statistical analysis in social science research, offering tools for data entry, coding, and various 

statistical tests. 

 Data Entry: The process of inputting data into SPSS, either manually or through 

importing datasets from external sources such as Excel or CSV files. 



PU-PRIDE-OLDP MBA - Soft Skills III – Computing Skills UNIT 3 
 

125 Periyar University – CDOE| Self Learning Material 
  

 Coding: The process of categorizing and labeling variables or responses for easier 

analysis, often transforming categorical data into numerical codes. 

 Percentage Analysis: A descriptive statistical technique used to express data as a 

percentage of the total, enabling easy interpretation of proportions and relative importance. 

 Chi-Square Test: A statistical test used to examine the association between two 

categorical variables, determining whether observed frequencies deviate from expected frequencies. 

 ANOVA (Analysis of Variance): A statistical method used to compare the means of 

three or more groups to determine if at least one group is significantly different from the others. 

 Correlation: A statistical measure that describes the strength and direction of a 

relationship between two continuous variables, often represented by a correlation coefficient (r). 

 

 Regression: A statistical technique used to model the relationship between a 

dependent variable and one or more independent variables, helping to predict outcomes and 

understand variable relationships. 

 Garrett Ranking: A ranking technique used to analyze respondents' preferences or 

opinions by assigning ranks based on predetermined scores. 

 P-Value: A statistical measure that helps determine the significance of results; in 

hypothesis testing, a p-value less than 0.05 typically indicates significant findings. 

 
Self Assessment Questions: 
 
1. Which of the following is the main purpose of SPSS software? 
a) Document formatting 
b) Statistical analysis 
c) Web design 
d) Image editing 
Answer: b) Statistical analysis 
2. What is the primary function of data coding in SPSS? 
a) Assigning numerical values to categorical data 
b) Sorting data alphabetically 
c) Automatically generating charts 
d) Filtering missing data 
Answer: a) Assigning numerical values to categorical data 
3. Which statistical test is used to examine the relationship between two categorical variables? 
a) ANOVA 
b) Chi-Square 
c) Correlation 
d) Regression 
Answer: b) Chi-Square 
4. In ANOVA, the purpose of the test is to compare the means of: 
a) Two groups 
b) Three or more groups 
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c) Paired samples 
d) One group with a standard value 
Answer: b) Three or more groups 
5. Which statistical measure is used to describe the strength and direction of a linear relationship 
between two continuous variables? 
a) ANOVA 
b) Regression 
c) Correlation 
d) Garrett Ranking 
Answer: c) Correlation 
6. In regression analysis, the dependent variable is also known as the: 
a) Predictor variable 
b) Response variable 
c) Independent variable 
d) Control variable 
Answer: b) Response variable 
7. Which of the following methods helps analyze respondents’ preferences by assigning ranks based on 
pre-determined scores? 
a) Chi-Square 
b) Correlation 
c) Garrett Ranking 
d) Percentage Analysis 
Answer: c) Garrett Ranking 
8. In a Chi-Square test, a p-value less than 0.05 typically indicates: 
a) No significant relationship between variables 
b) A significant relationship between variables 
c) The need to collect more data 
d) The test was invalid 
Answer: b) A significant relationship between variables 
9. Which statistical test would you use to analyze the impact of multiple independent variables on one 
continuous dependent variable? 
a) ANOVA 
b) Chi-Square 
c) Regression 
d) Garrett Ranking 
Answer: c) Regression 
10. What does the term 'percentage analysis' help you determine in a dataset? 
a) The central tendency 
b) Proportions of a whole 
c) Standard deviations 
d) Variance between groups 
Answer: b) Proportions of a whole 
 

ACTIVITY  
Activity:  Analyzing Customer Satisfaction in a Retail Store Using SPSS 
Objective: 
Students will collect data on customer satisfaction from a retail store and analyze it using SPSS to 
understand various relationships between factors such as service quality, product quality, pricing, and 
overall satisfaction. They will perform data entry, coding, percentage analysis, Chi-Square, ANOVA, 
correlation, regression, and Garrett Ranking to derive meaningful insights. 
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Steps: 
1. Data Collection: 

Collect survey data from 50 customers on various factors (service quality, product quality, 
pricing, and overall satisfaction) using a Likert scale (1-5). 
Demographic variables such as age, gender, and income level should also be collected. 

2. Data Entry in SPSS: 
Input the survey responses into SPSS. 
Label variables (e.g., "Service Quality", "Product Quality", "Pricing", "Satisfaction"). 

3. Data Coding: 
Code categorical variables like gender (1 = Male, 2 = Female) and satisfaction levels (1 = 
Very Dissatisfied, 5 = Very Satisfied). 

4. Percentage Analysis: 
Perform percentage analysis to understand the distribution of responses across 
demographic categories (e.g., % of males and females who are satisfied). 

5. Chi-Square Test: 
Test the relationship between categorical variables like gender and satisfaction using a 
Chi-Square test. 
Hypothesis: There is no significant association between gender and customer satisfaction. 

6. ANOVA: 
Conduct a one-way ANOVA to compare the satisfaction levels across different income 
groups. 
Hypothesis: There is no significant difference in satisfaction levels based on income. 

7. Correlation Analysis: 
Analyze the correlation between service quality, product quality, pricing, and overall 
satisfaction to identify which factors are most closely related to satisfaction. 

8. Regression Analysis: 
Run a regression analysis to predict overall satisfaction (dependent variable) based on 
service quality, product quality, and pricing (independent variables). 

9. Garrett Ranking: 
Use Garrett Ranking to rank the factors (service quality, product quality, pricing) based on 
customer preferences in terms of their impact on satisfaction. 

Outcome: 
1. Data Entry and Coding: 

Students will successfully enter and code the data in SPSS, ensuring all variables are correctly 
labeled and prepared for analysis. 

2. Percentage Analysis: 
They will derive percentages, such as 65% of customers are satisfied (4 or 5 on the Likert scale), 
and notice trends across demographics. 

3. Chi-Square Result: 
The Chi-Square test might show that there is no significant association between gender and 
satisfaction (p-value > 0.05), meaning satisfaction is not dependent on gender. 

4. ANOVA Result: 
The ANOVA test may reveal significant differences in satisfaction levels across income groups 
(p-value < 0.05), indicating income influences satisfaction. 

5. Correlation Analysis: 
They may find a strong positive correlation between service quality and satisfaction (r = 0.75), 
showing that better service quality is closely tied to higher satisfaction. 

6. Regression Outcome: 
The regression analysis could indicate that service quality is the most significant predictor of 
overall satisfaction (with the highest beta value), while pricing has a lower impact. 

7. Garrett Ranking: 
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Through Garrett Ranking, students might rank service quality as the top factor influencing 
customer satisfaction, followed by product quality and then pricing. 

Learning Outcome: 
By the end of the activity, students will have hands-on experience using SPSS for data entry, coding, 
percentage analysis, and advanced statistical methods like Chi-Square, ANOVA, correlation, 
regression, and Garrett Ranking. They will be able to interpret the results, draw meaningful conclusions, 
and understand the factors affecting customer satisfaction in a retail setting. 

Suggested Readings:  
Pachter, B. (2013). The Essentials of Business Etiquette: How to Greet, Eat, and 
Tweet Your Way to Success (1) edition New York: McGraw-Hill Education. 

—-------------------—---------------- 
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Unit Objectives: 
 To enable the students to understand the functions and usage of various cloud 
based apps like Google Drive, Google Sheets and Google Docs 

 

INTRODUCTION TO CLOUD BASED APPS 

 

Cloud based apps – Google Drive, Google Sheets, Google Docs,. 

 
4.1 Introduction to Cloud computing and Google workspace 

 
Cloud computing has revolutionized the way businesses and individuals store, access, 

and manage data and applications. Instead of relying on physical hardware and 

infrastructure, cloud computing utilizes remote servers hosted on the internet to store, 

manage, and process data. This paradigm shift offers numerous advantages, including 

scalability, flexibility, cost-effectiveness, and accessibility from anywhere with an 

internet connection. 

 
One of the leading providers of cloud-based productivity tools is Google Workspace, 

formerly known as G Suite. Google Workspace offers a suite of powerful applications 

designed to streamline collaboration, enhance productivity, and facilitate communication 

within organizations of all sizes. 

 
Google Workspace includes a range of applications, but three of the most widely used 

are Google Drive, Google Sheets, and Google Docs. Google Drive provides a 

centralized platform for storing and sharing files, Google Sheets offers powerful 

spreadsheet capabilities, and Google Docs enables collaborative document creation 

and editing in real-time. 

 
Throughout this course, we will explore the fundamentals of cloud computing, delve into 

the features and capabilities of Google Workspace applications, and learn how to 

leverage these tools to streamline workflows, enhance collaboration, and boost 

productivity. By the end of the course, you will have the skills and knowledge to 

confidently utilize Google Drive, Google Sheets, and Google Docs to their fullest 

potential, empowering you to work more efficiently and effectively in today's digital 

landscape. 

   
UNIT IV CLOUD BASED APPS 
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4.1.1 Understanding Cloud Computing and Its Benefits: 

 
Cloud computing is a model for delivering computing services over the internet, 

providing access to a shared pool of resources, including storage, processing power, 

and applications. Instead of owning physical infrastructure or data centers, users can 

access computing resources on-demand from cloud service providers, paying only for 

what they use. 

 
–Cloud can be public or private 

 

–Storage services Dropbox, iCloud, Google Drive, or OneDrive 
 

–Allows companies to minimize I T investments 
 

–Drawbacks: Concerns of security, reliability 
 

–Hybrid cloud computing model - A hybrid cloud—sometimes called a cloud hybrid—is 

a computing environment that combines an on-premises datacenter (also called a 

private cloud) with a public cloud, allowing data and applications to be shared between 

them. 

 

 
Key Components of Cloud Computing: 

 
Infrastructure as a Service (IaaS): Offers virtualized computing resources over 

the internet, including servers, storage, and networking infrastructure. Users can 

provision and manage these resources remotely, scaling up or down as needed. 

 
Platform as a Service (PaaS): Provides a platform for developing, deploying, and 

managing applications without the complexity of infrastructure management. 

PaaS offerings typically include development tools, databases, and middleware. 

 
Software as a Service (SaaS): Delivers software applications over the internet on 

a subscription basis. Users can access applications through a web browser 

without the need for installation or maintenance. 
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Benefits of Cloud Computing: 

 
Cost Efficiency: Cloud computing eliminates the need for upfront investment in 

hardware and infrastructure, reducing capital expenses. Users pay only for the 

resources they consume on a pay-as-you-go basis, leading to cost savings and 

predictable expenses. 

 
Scalability: Cloud services offer scalability, allowing users to easily scale 

resources up or down based on demand. This flexibility ensures that 

organizations can meet fluctuating workload requirements without over-

provisioning or underutilizing resources. 

Flexibility and Accessibility: Cloud computing enables users to access computing 

resources from anywhere with an internet connection, using a variety of devices, 

including laptops, smartphones, and tablets. This flexibility facilitates remote 

work, collaboration, and mobility. 

Reliability and Resilience: Cloud service providers typically offer high levels of 

reliability and uptime through redundant infrastructure and data replication. This 

ensures business continuity and minimizes the risk of downtime due to hardware 

failures or disasters. 

Security: Cloud providers invest heavily in security measures to protect data and 

infrastructure from unauthorized access, data breaches, and cyber threats. 

Features such as encryption, identity and access management, and compliance 

certifications help ensure data privacy and regulatory compliance. 

Innovation and Agility: Cloud computing enables rapid deployment of new 

applications and services, accelerating innovation and time-to-market. 

Developers can leverage cloud-based development platforms and services to 

build, test, and deploy applications more efficiently. 

 
Overall, cloud computing offers numerous benefits for organizations of all sizes, 

including cost efficiency, scalability, flexibility, reliability, security, and agility. By 

understanding the fundamentals of cloud computing and its advantages, businesses 

can harness the power of the cloud to drive growth, innovation, and competitive 

advantage. 
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4.1.2 INTRODUCTION TO GOOGLE WORKSPACE 

 
Google Workspace, formerly known as G Suite, is a suite of cloud-based productivity 

tools developed by Google. It offers a range of applications designed to facilitate 

communication, collaboration, and productivity within organizations of all sizes. 

Google Workspace is built on the principles of cloud computing, providing users with 

access to their data and applications from any device with an internet connection. 

 
Key Components of Google Workspace: 

 
Gmail: Google Workspace includes Gmail, a widely-used email service with 

advanced features such as customizable email addresses, powerful search 

capabilities, and integration with other Google Workspace applications. 

Google Drive: Google Drive is a cloud storage service that allows users to store, 

access, and share files and folders securely. It offers generous storage 

space and integrates seamlessly with other Google Workspace applications, 

enabling collaboration on documents, spreadsheets, and presentations. 

Google Docs: Google Docs is a web-based word processing application that 

enables collaborative document creation and editing in real-time. Users can work 

together on documents, track changes, and leave comments, making it ideal for 

team projects and document collaboration. 

Google Sheets: Google Sheets is a cloud-based spreadsheet application that 

offers powerful data analysis and collaboration features. Users can create, edit, 

and analyze spreadsheets, collaborate with team members in real-time, and 

visualize data using charts and graphs. 

Google Slides: Google Slides is a presentation application that allows users to 

create, edit, and share presentations online. It offers a range of templates, 

themes, and customization options, making it easy to create professional-looking 

presentations for meetings, pitches, and lectures. 

Google Meet: Google Meet is a video conferencing service that enables users to 

hold virtual meetings, conferences, and webinars. It offers features such as 

screen sharing, 
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chat, and integration with Google Calendar, making it easy to schedule and join 

meetings from any device. 

Google Calendar: Google Calendar is a calendar application that helps users 

organize their schedules, events, and appointments. It offers features such as 

event scheduling, reminders, and integration with other Google Workspace 

applications, ensuring users stay organized and on track. 

Google Chat: Google Chat is a messaging and collaboration tool that allows 

users to communicate in real-time with colleagues, teams, and external partners. 

It offers features such as group chat, direct messaging, and integration with other 

Google Workspace applications, facilitating seamless communication and 

collaboration. 

 
Benefits of Google Workspace: 

 
Collaboration: Google Workspace enables real-time collaboration and teamwork, 

allowing users to work together on documents, spreadsheets, and presentations 

from anywhere with an internet connection. 

Productivity: Google Workspace offers a suite of productivity tools designed to 

streamline workflows, enhance communication, and boost efficiency within 

organizations. 

Accessibility: Google Workspace applications are accessible from any device 

with an internet connection, allowing users to access their data and applications 

on the go. 

Security: Google Workspace includes robust security features to protect user 

data and infrastructure from unauthorized access, data breaches, and cyber 

threats. 

Cost-effectiveness: Google Workspace offers flexible pricing plans and 

subscription options, allowing organizations to scale their usage based on their 

needs and budget. 

 
Overall, Google Workspace is a powerful suite of cloud-based productivity tools that 

enables organizations to collaborate, communicate, and work more efficiently in today's 

digital landscape. By leveraging the features and capabilities of Google Workspace, 

businesses can drive productivity, innovation, and success. 
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4.1.3 Overview of Google Drive, Google Sheets, and Google Docs 

 
Google Drive, Google Sheets, and Google Docs are three core applications within 

Google Workspace (formerly G Suite) that offer powerful capabilities for document 

management, spreadsheet analysis, and collaborative document creation. Here's an 

overview of each: 

 
Google Drive: 

● Google Drive is a cloud-based file storage service provided by Google. It 

allows users to store files securely in the cloud and access them from any 

device with an internet connection. 

● Key features of Google Drive include: 

● File organization: Users can organize files into folders, apply labels, 

and use search functionality to quickly find files. 

● File sharing: Google Drive enables users to share files and folders 

with individuals or groups, allowing for seamless collaboration. 

● Version history: Google Drive keeps track of changes made to files, 

allowing users to review previous versions and restore or revert 

changes if needed. 

● Integration with other Google Workspace apps: Google Drive 

integrates seamlessly with Google Docs, Google Sheets, and other 

Google Workspace applications, facilitating collaboration and 

document editing. 

Google Sheets: 

● Google Sheets is a cloud-based spreadsheet application that offers 

powerful data analysis and collaboration features. 

● Key features of Google Sheets include: 

● Spreadsheet creation and editing: Users can create and edit 

spreadsheets online, using a variety of formatting options, formulas, 

and functions. 

● Data analysis tools: Google Sheets offers a range of data analysis 

tools, including pivot tables, charts, and conditional formatting, 

allowing users to visualize and analyze data effectively. 
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● Collaboration: Google Sheets enables real-time collaboration, 

allowing multiple users to work on the same spreadsheet 

simultaneously. Users can leave comments, track changes, and 

discuss data within the spreadsheet. 

● Integration with other Google Workspace apps: Google Sheets 

integrates seamlessly with Google Drive, Google Docs, and other 

Google Workspace applications, enabling users to import data, link 

spreadsheets, and embed charts and tables in documents and 

presentations. 

Google Docs: 

● Google Docs is a cloud-based word processing application that enables 

collaborative document creation and editing in real-time. 

● Key features of Google Docs include: 

● Document creation and editing: Users can create and edit 

documents online, using a range of formatting options, fonts, and 

styles. Google Docs supports features such as headers and 

footers, page numbering, and table of contents. 

● Collaboration: Google Docs enables real-time collaboration, 

allowing multiple users to work on the same document 

simultaneously. Users can leave comments, suggest edits, and 

track changes within the document. 

● Version history: Google Docs keeps track of changes made to 

documents, allowing users to review previous versions and revert 

changes if needed. 

● Integration with other Google Workspace apps: Google Docs 

integrates seamlessly with Google Drive, Google Sheets, and other 

Google Workspace applications, facilitating collaboration and 

document sharing. 

 
Overall, Google Drive, Google Sheets, and Google Docs are powerful cloud-based 

applications that offer a range of features and capabilities for document management, 

spreadsheet analysis, and collaborative document creation. By leveraging these tools, 

users can streamline workflows, enhance productivity, and collaborate more effectively 

within their teams and organizations. 
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Let Us Sum Up 

Google Workspace, formerly G Suite, offers cloud-based productivity tools for 

communication and collaboration. It includes Gmail, Google Drive, Docs, Sheets, 

Slides, Meet, Calendar, and Chat, enabling real-time collaboration and efficient 

workflow management. Cloud computing provides scalability, flexibility, and cost-

efficiency, while Google Workspace ensures accessibility, security, and productivity. 

Google Drive facilitates file storage and sharing with version history and integration with 

other apps. Google Sheets offers powerful spreadsheet capabilities for data analysis 

and collaboration. Google Docs enables collaborative document creation and editing in 

real-time. Together, these tools empower users to work efficiently and effectively, 

driving innovation and success in the digital era. 

 
Check your progress 

What is one of the advantages of cloud computing mentioned in the text? 

A) Limited accessibility 

B) Reliance on physical hardware 

C) Scalability and flexibility 

D) High upfront investment 

Answer: C) Scalability and flexibility 

Which of the following is NOT a component of Google Workspace? 

A) Google Drive 

B) Google Photos 

C) Google Sheets 

D) Google Docs 

Answer: B) Google Photos 

What is the primary function of Google Drive? 

A) Real-time collaboration on documents 

B) Centralized platform for storing and sharing files 

C) Creating and editing spreadsheets 

D) Facilitating communication within organizations 

Answer: B) Centralized platform for storing and sharing files 
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Which application within Google Workspace enables collaborative document creation 

and editing in real-time? 

A) Google Drive 

B) Google Sheets 

C) Google Docs 

D) Google Calendar 

Answer: C) Google 

Docs 

What is the goal of the course described in the text? 

A) To limit access to digital tools 

B) To explore the fundamentals of cloud computing 

C) To rely solely on physical hardware 

D) To discourage collaboration within organizations 

Answer: B) To explore the fundamentals of cloud 

computing What is the primary function of Google 

Drive? 

A) Creating and editing spreadsheets 

B) Cloud-based file storage and organization 

C) Real-time collaboration on documents 

D) Data analysis and visualization 

Answer: B) Cloud-based file storage and organization 

Which feature of Google Sheets allows multiple users to work on the same 

spreadsheet simultaneously? 

A) Version history 

B) Data analysis tools 

C) Collaboration 

D) Integration with other Google Workspace 

apps Answer: C) Collaboration 

What type of documents can be created and edited using Google Docs? 

A) Spreadsheets 

B) Presentations 

C) Word processing documents 
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D) Emails 

Answer: C) Word processing documents 

Which Google Workspace application is best suited for data analysis and visualization? 

A) Google Drive 

B) Google Sheets 

C) Google Docs 

D) Google Calendar 

Answer: B) Google 

Sheets 

What is a key advantage of using Google Drive, Google Sheets, and Google Docs? 

A) Offline access only 

B) Limited collaboration features 

C) Seamless integration with other Google Workspace apps 

D) Incompatibility with different devices 

Answer: C) Seamless integration with other Google Workspace apps 

4.2  GOOGLE DRIVE AND FUNDAMENTALS  
 
4,2,1 Setting up a Google account 

 
The steps in setting up a google account 

 
Visit the Google Sign Up page: Open your web browser and go to the Google 

account creation page. You can do this by typing "create Google account" or 

"Google sign up" into the search bar and clicking on the appropriate link. 

Enter your information: On the sign-up page, you'll be prompted to enter some 

basic information, including your first and last name, desired email address, and 

password. Make sure to choose a strong password that includes a mix of letters, 

numbers, and special characters to enhance security. 

Verify your phone number: Google may require you to provide a phone number 

for account verification purposes. This is to ensure the security of your account 

and to help you recover it if you ever lose access. Enter your phone number and 

choose whether you want to receive a verification code via text message or 

phone call. 

Complete the CAPTCHA: Google uses CAPTCHA (Completely Automated Public 

Turing test to tell Computers and Humans Apart) to verify that you're a real 
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person and not a bot. Complete the CAPTCHA challenge by entering the 

characters you see in the image or by solving the puzzle. 

Agree to the terms of service and privacy policy: Read through Google's terms of 

service and privacy policy, then check the box to indicate that you agree to them. 

It's essential to understand your rights and responsibilities when using Google 

services. Verify your email address: After completing the sign-up process, 

Google may send you a verification email to the address you provided during 

registration. Open the email and click on the verification link to confirm your email 

address. This step is necessary to activate your Google account fully. 

Set up account recovery options: To ensure you can regain access to your 

account if you ever forget your password or get locked out, it's essential to set up 

account recovery options. This typically involves providing an alternate email 

address and/or phone number that Google can use to verify your identity and 

help you reset your password. 

Personalize your account settings (optional): Once your account is set up, you 

can customize your settings to suit your preferences. This may include setting a 

profile picture, adjusting privacy settings, and enabling or disabling features like 

two-factor authentication for added security. 

Explore Google services: With your Google account created and verified, you 

can now access a wide range of Google services, including Gmail, Google Drive, 

Google Docs, Google Calendar, and more. Take some time to explore these 

services and start using them to stay organized, communicate effectively, and 

collaborate with others. 

 
By following these steps, you can easily set up a Google account and gain access to a 

wealth of online resources and services offered by Google. 

 
4.2.2 Navigating Google Drive interface 

 
Navigating to the Google Drive interface involves a few simple steps. Here's how you can do it: 

 
Open your web browser: Launch your preferred web browser on your computer 

or mobile device. Google Drive can be accessed from any modern web browser, 

including Google Chrome, Mozilla Firefox, Safari, and Microsoft Edge. 

Go to the Google Drive website: In the address bar of your web browser, type in 
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the URL for Google Drive, which is "https://drive.google.com" and press Enter. 

This will take you to the Google Drive homepage. 

Sign in to your Google account: If you're not already signed in to your Google 

account, you'll be prompted to do so. Enter your email address and password, 

then click "Sign in." 

If you don't have a Google account, you can create one by clicking on the 

"Create account" link and following the on-screen instructions. 

Access Google Drive: Once you're signed in to your Google account, you'll be 

taken to the Google Drive interface. Here, you'll see your files and folders 

organized in a grid or list view, depending on your preference. You can navigate 

through your files and folders by clicking on them or using the search bar at the 

top of the page to find specific items. 

Explore the interface: Take some time to familiarize yourself with the Google 

Drive interface. You'll find a menu on the left side of the screen with options to 

view files, access folders, create new documents, upload files, and more. There's 

also a toolbar at the top of the screen with additional options for managing your 

files and customizing your Google Drive settings. 

Start using Google Drive: Once you're comfortable with the interface, you can 

start using Google Drive to store, organize, and share your files and folders. You 

can create new documents, spreadsheets, and presentations using Google's 

productivity tools, collaborate with others in real-time, and access your files from 

any device with an internet connection. 

By following these steps, you can easily navigate to the Google Drive interface 

and begin using this powerful cloud storage and file management tool. 

4.2.3 Uploading, organizing, and managing files and folders 

 
● Sign in to Google Drive: Open your web browser and navigate to the Google 

Drive website (https://drive.google.com). Sign in to your Google account if you 

haven't already done so. 

● Upload files or folders: 

a. To upload files: Click on the "+ New" button located in the top-left corner of 

the Google Drive interface. Select "File upload" from the dropdown 

menu. Choose the file you want to upload from your computer and click 

"Open." The file will be uploaded to your Google Drive. 

https://drive.google.com/
https://drive.google.com/
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b. To upload folders: Click on the "+ New" button and select "Folder upload" 

from the dropdown menu. Choose the folder you want to upload from your 

computer and click "Upload." The folder and all its contents will be 

uploaded to your Google Drive. 

● Organize files and folders: 

a. Create folders: Click on the "+ New" button and select "Folder" from the 

dropdown menu. Enter a name for the folder and press Enter. You can 

then drag and drop files into the folder to organize them. 

b. Move files and folders: Select the file or folder you want to move by 

clicking on it. Click and hold the item, then drag it to the desired location 

within your Google Drive. Release the mouse button to drop the item into 

the new location. 

c. Rename files and folders: Right-click on the file or folder you want to 

rename and select "Rename" from the dropdown menu. Enter the new 

name for the item and press Enter. 

d. Delete files and folders: Right-click on the file or folder you want to delete 

and select "Remove" or "Move to trash" from the dropdown menu. Confirm 

the deletion if prompted. 

● Share files and folders: 

a. Select the file or folder you want to share by clicking on it. 

b. Click on the "Share" button located at the top of the Google Drive 

interface, or right-click on the item and select "Share" from the dropdown 

menu. 

c. Enter the email addresses of the people you want to share the file or 

folder with. Choose whether they can view, comment on, or edit the item. 

d. Click "Send" to share the file or folder with the selected recipients. 

● Manage files and folders: 

a. View file details: Click on a file to select it, then click on the "i" button 

located at the top-right corner of the Google Drive interface. This will 

display information about the file, including its name, size, and sharing 

settings. 

b. Sort files and folders: Click on the "Sort" button located at the top of the 

Google Drive interface to sort your files and folders by name, date 

modified, size, or type. 



PU-PRIDE-OLDP MBA - Soft Skills III – Computing Skills UNIT 4 
 

142 Periyar University – CDOE| Self Learning Material 
  

c. Search for files and folders: Use the search bar located at the top of the 

Google Drive interface to search for specific files and folders by name or 

keyword. 

 
By following these steps, you can easily upload, organize, and manage files and folders 

in Google Drive, making it easier to store and access your important documents, 

photos, and other files from anywhere with an internet connection. 

 
4.2.4 Sharing files and folders securely 

 
Sharing files and folders securely in Google Drive involves taking several precautions to 

ensure that only authorized individuals have access to your shared content. Here are 

the steps to share files and folders securely: 

 
Set appropriate sharing permissions: 

● When sharing files or folders, carefully choose the sharing settings to 

control who can access the content. 

● Avoid making files or folders publicly accessible unless necessary. 

Instead, restrict access to specific individuals or groups. 

● Choose the appropriate sharing permissions, such as "View," "Comment," 

or "Edit," based on the level of access you want to grant to collaborators. 

Use secure sharing options: 

● Share files and folders directly with specific individuals or groups by 

entering their email addresses. 

● Avoid sharing files publicly via a link unless absolutely necessary. If you 

must use link sharing, consider using the "Restricted" option to limit access 

to specific people. 

● Enable the "Notify people" option when sharing files to alert collaborators 

via email about the shared content. This helps ensure that recipients are 

aware of the shared files and can take appropriate action. 

Enable advanced sharing settings: 
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● Utilize advanced sharing settings to enhance security further. For 

example, you can prevent collaborators from resharing files or disable 

downloading, printing, or copying of content. 

● Consider enabling "View-only" mode for sensitive files to restrict 

collaborators from making changes or leaving comments. 

Regularly review and manage sharing permissions: 

● Periodically review the sharing settings for your files and folders to ensure 

that access is limited to authorized individuals. 

● Remove unnecessary collaborators or revoke access for individuals who 

no longer require access to the shared content. 

● Monitor sharing activity to detect any unauthorized access or suspicious 

behavior. Use encryption and two-factor authentication: 

● Enable encryption for files stored in Google Drive to protect data both at 

rest and in transit. 

● Implement two-factor authentication (2FA) for your Google account to add 

an extra layer of security. This helps prevent unauthorized access even if 

someone obtains your login credentials. 

Educate collaborators about security best practices: 

● Educate collaborators about the importance of maintaining security 

when accessing shared files and folders. 

● Encourage the use of strong, unique passwords for Google accounts 

and regular password updates. 

● Remind collaborators to avoid sharing sensitive information outside of 

secure channels and to be cautious when opening email attachments or 

clicking on links. 

 
By following these steps and implementing security best practices, you can share files 

and folders securely in Google Drive, protecting your sensitive information from 

unauthorized access or exposure. 
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Let Us Sum Up 

Module 2 of "Google Drive Fundamentals" covered essential aspects such as setting up 

a Google account, navigating the Drive interface, managing files/folders, and securely 

sharing content. Setting up an account involves steps like providing personal 

information and verifying contact details. Navigating the interface is straightforward: log 

in, access Drive, and explore its features. Uploading, organizing, and managing 

files/folders include actions like creating, moving, renaming, and deleting items. Secure 

sharing entails setting appropriate permissions, using secure sharing options, managing 

access, enabling advanced settings, and educating collaborators on security measures. 

Following these steps ensures efficient usage and protection of data in Google Drive. 

Check your progress 

1. Which step is NOT involved in setting up a Google account? 

a) Entering basic information like name and email address 

b) Providing a phone number for verification 

c) Completing a CAPTCHA challenge 

d) Choosing a preferred browser for Google services 

2. How can you access Google Drive after signing in to your Google account? 

a) Click on the "Google Docs" button 

b) Type "Google Drive" in the search bar 

c) Visit the Google Drive website 

d) Open the Google Drive app from your device's home screen 

3. What action is NOT part of managing files and folders in Google Drive? 

a) Viewing file details 

b) Sorting files and folders 

c) Editing files directly in the Drive interface 

d) Searching for specific files or folders 

4. What precaution should you take when sharing files or folders in Google Drive? 

a) Make all files publicly accessible 

b) Share files via unsecured email attachments 

c) Avoid using advanced sharing settings 
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d) Choose appropriate sharing permissions based on collaborators' needs 

 
 

5. Which security measure is recommended for protecting data stored in Google Drive? 

a) Enabling encryption for files 

b) Disabling two-factor authentication 

c) Sharing sensitive information via unencrypted channels 

d) Allowing unrestricted access to shared files and folders 

 

4. 3.1 Creating and formatting Google Sheets 
Opening Google Sheets: Open your web browser and navigate to Google 

Sheets by typing "sheets.google.com" into the address bar or searching for 

"Google Sheets" in the search engine. Alternatively, you can access Google 

Sheets from your Google Drive by clicking on the "+ New" button and selecting 

"Google Sheets." 

Creating a New Spreadsheet: Once in Google Sheets, click on the "+ Blank" 

option to create a new, empty spreadsheet. This will open a new tab with a blank 

spreadsheet where you can begin entering data. 

Entering Data: Click on a cell and start typing to enter your data. You can 

navigate between cells using the arrow keys on your keyboard or by clicking on a 

cell with your mouse. 

Formatting Text: To format text in Google Sheets: 

● Select the cell or range of cells containing the text you want to format. 

● Use the toolbar at the top to change font size, style (bold, italic), 

alignment (left, center, right), and text color. 

Formatting Numbers: To format numerical data: 

● Select the cell or range of cells containing the numbers you want to format. 

● Use the toolbar to apply number formats such as currency, percentage, 

date, or scientific notation. 

● You can also adjust decimal places and add thousands separators from 

the toolbar. Inserting Rows and Columns: To insert rows or columns: 
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● Right-click on the row number or column letter where you want to insert 

the new row or column. 

● Select "Insert 1 above" or "Insert 1 below" for rows, or "Insert 1 left" or 

"Insert 1 right" for columns. 

Merging and Splitting Cells: To merge or split cells: 

● Select the cells you want to merge or split. 

● Go to the "Format" menu, hover over "Merge cells," and choose either 

"Merge all" to merge cells or "Unmerge" to split merged cells. 

● For splitting cells, you can also use the "Split text to columns" feature 

under the "Data" menu to split text into separate cells based on a delimiter. 

Applying Conditional Formatting: To apply conditional formatting: 

● Select the range of cells you want to format. 

● Go to the "Format" menu and select "Conditional formatting." 

● Set up rules to format cells based on specific conditions, such as text 

contains, value is greater than, or date is before/after. 

Protecting and Locking Cells: To protect and lock cells: 

● Select the cells you want to protect. 

● Right-click and choose "Protect range" from the context menu. 

● Set permissions for the range, such as who can edit, comment, or view 

the range. You can also add a description for reference. 

● Click "Set permissions" to apply the protection settings. 

Saving the Spreadsheet: Google Sheets automatically saves your work as 

you make changes. However, to save a copy or download the spreadsheet: 

● Click on "File" in the menu bar. 

● Choose "Download" to save the spreadsheet in various formats (e.g., 

Excel, PDF, CSV). 

● Alternatively, select "Save" or "Save as" to save the spreadsheet directly 

to your Google Drive or another location. 

 
By following these steps, you can efficiently create and format spreadsheets using 

Google Sheets for various purposes, whether personal, educational, or professional. 
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4.3.2 Entering and manipulating data 

Entering and manipulating data in Google Sheets involves several steps to input, 

organize, analyze, and visualize data effectively. Here's a detailed explanation of the 

process: 

 
Entering Data: 

● Click on a cell to select it. 

● Start typing to enter your data directly into the selected cell. 

● Press Enter on your keyboard to move to the cell below or use the arrow 

keys to navigate to adjacent cells. 

Editing Data: 

● Double-click on a cell to enter edit mode. Alternatively, select the cell 

and press F2 on your keyboard. 

● Make changes to the content of the cell. 

● Press Enter to save your changes or press Esc to cancel 

editing. Copying and Pasting Data: 

● Select the cell or range of cells you want to copy. 

● Right-click on the selected cells and choose "Copy" from the context 

menu, or press Ctrl + C on your keyboard. 

● Move to the destination where you want to paste the copied data. 

● Right-click and choose "Paste" from the context menu, or press Ctrl + V 

on your keyboard. 

Filling Data Series: 

● Enter data in a sequence in two adjacent cells (e.g., 1 and 2). 

● Select both cells. 

● Click and drag the fill handle (a small square at the bottom-right corner 

of the selection) down or across to fill the cells with the series. 

Using AutoFill: 

● Enter a pattern or sequence of data in a cell (e.g., days of the week, months). 

● Hover over the bottom-right corner of the cell until you see the AutoFill 

handle (a small square). 
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● Click and drag the handle to automatically fill adjacent cells with the 

pattern or sequence. 

Inserting Rows and Columns: 

● Right-click on the row number or column letter where you want to insert 

the new row or column. 

● Choose "Insert 1 above" or "Insert 1 below" for rows, or "Insert 1 left" or 

"Insert 1 right" for columns. 

Deleting Rows and Columns: 

● Right-click on the row number or column letter you want to delete. 

● Select "Delete row" or "Delete column" from the context 

menu. Sorting Data: 

● Select the range of cells you want to sort. 

● Click on "Data" in the menu bar. 

● Choose "Sort range" or "Sort sheet by column" from the dropdown menu. 

● Select the column you want to sort by and choose the sorting order 

(ascending or descending). 

Filtering Data: 

● Select the range of cells you want to filter. 

● Click on "Data" in the menu bar. 

● Choose "Create a filter" from the dropdown menu. 

● Use the filter arrows in the header row to filter data based on specific 

criteria. Using Formulas and Functions: 

● Enter an equals sign (=) in a cell to start a formula. 

● Type the function name followed by the arguments within parentheses (e.g., 

=SUM(A1:A10)). 

● Press Enter to calculate the 

result. Formatting Data: 

● Select the cells or range of cells you want to format. 

● Use the toolbar options to change font size, style, alignment, text 

color, background color, borders, and more. 
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By following these steps, you can efficiently enter and manipulate data in Google 

Sheets, enabling you to organize, analyze, and visualize your data effectively for various 

purposes. 

 

4.3.3 Using basic formulas and functions in google sheet 

 
Using basic formulas and functions in Google Sheets allows you to perform 

calculations, manipulate data, and automate tasks. Here's a step-by-step explanation of 

how to use basic formulas and functions: 

 
Entering Formulas: 

● Click on the cell where you want to enter the formula. 

● Start the formula with an equal sign "=" to indicate that it's a formula. 

● Type the formula expression, including cell references, operators, and functions. 

● Press Enter on your keyboard to apply the formula and display 

the result. Cell References: 

● Use cell references to include the value of other cells in your formula. 

● For example, to add the values in cells A1 and B1, you would type 

"=A1+B1". Operators: 

● Use operators to perform arithmetic operations in your formulas. 

● Common operators include addition (+), subtraction (-), multiplication 

(*), division (/), and exponentiation (^). 

Functions: 

● Google Sheets offers a wide range of built-in functions for various purposes. 

● Functions are predefined formulas that perform specific calculations or actions. 

● You can use functions to sum numbers, calculate averages, find 

maximum or minimum values, perform logical tests, manipulate text, and 

much more. 

Using Functions: 

● To use a function, start the formula with an equal sign "=" followed 

by the function name and its arguments enclosed in parentheses "()". 

● For example, to sum the values in a range of cells, you would use 

the SUM function like this: "=SUM(A1:A10)". 
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● The function name is followed by the range of cells or values you want to 

include in the calculation. 

Common Functions: 

● SUM: Adds up a range of numbers. 

● AVERAGE: Calculates the average of a range of numbers. 

● MAX: Returns the maximum value in a range. 

● MIN: Returns the minimum value in a range. 

● COUNT: Counts the number of cells containing numbers. 

● IF: Performs a logical test and returns one value if the test is true and 

another value if it's false. 

● CONCATENATE: Combines multiple strings into one. 

● LEFT/RIGHT/MID: Extracts characters from a string. 

● DATE/DAY/MONTH/YEAR: Extracts components of a 

date. Autosum Feature: 

● Google Sheets provides an Autosum feature to quickly sum a range of numbers. 

● Select the cell where you want the sum to appear. 

● Click on the "Σ" symbol in the toolbar, or press Alt + = on your keyboard. 

● Google Sheets will automatically insert the SUM function with the 

appropriate range. 

Autofill Feature: 

● After entering a formula in a cell, you can use the Autofill feature to 

copy the formula to adjacent cells. 

● Click and drag the fill handle (a small square at the bottom-right corner 

of the selected cell) down or across to fill adjacent cells with the formula. 

 
By following these steps, you can effectively use basic formulas and functions in 

Google Sheets to perform calculations and manipulate data according to your 

requirements. 
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4.3.4 Collaborative editing and sharing of spreadsheets 

 
Collaborative editing and sharing of spreadsheets in Google Sheets allow multiple 

users to work together in real-time on the same document. Here's a detailed explanation 

of the process: 

 
Sharing a Spreadsheet: 

● Open the spreadsheet you want to share in Google Sheets. 

● Click on the "Share" button located in the top-right corner of the screen, 

next to your profile picture. 

● In the sharing dialog box, enter the email addresses of the individuals or 

groups you want to share the spreadsheet with. 

● Choose their permissions from the dropdown menu: "Viewer," 

"Commenter," or "Editor." 

● Optionally, you can add a message to notify the recipients about the 

shared document. 

● Click on "Send" to share the spreadsheet. Recipients will receive an 

email notification with a link to access the document. 

Setting Permissions: 

● Viewer: Users with viewer access can only view the spreadsheet and its 

contents. They cannot make any edits or comments. 

● Commenter: Users with commenter access can view the spreadsheet 

and add comments. They cannot make direct edits to the content. 

● Editor: Users with editor access can view, edit, and comment on the 

spreadsheet. They have full control over the document. 

Collaborative Editing: 

● Once the spreadsheet is shared, all invited users can simultaneously 

edit the document in real-time. 

● Each user's changes are automatically saved and synced across all 

devices connected to the internet. 

● Users can see each other's edits as they happen, marked by color-

coded cursors and highlighting. 
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● Collaborators can communicate with each other using the built-in chat 

feature on the right side of the screen. 

Reviewing Changes: 

● Google Sheets keeps track of changes made by different users through 

the revision history feature. 

● To access the revision history, click on "File" in the menu bar, then select 

"Version history" > "See version history." 

● You can review past versions of the spreadsheet, see who made each 

change, and revert to previous versions if needed. 

Commenting and Discussion: 

● Collaborators can add comments to specific cells or ranges within the 

spreadsheet to discuss changes or provide feedback. 

● To add a comment, right-click on the cell or range and select "Comment" 

from the context menu. Alternatively, click on the "Insert" menu and choose 

"Comment." 

● Type your comment in the comment box that appears, then click 

"Comment" to post it. Others can reply to the comment thread. 

Notifications: 

● Users receive notifications when changes are made to the shared 

spreadsheet or when comments are added or resolved. 

● Notifications appear as pop-up messages in the bottom-right corner of 

the screen and as email notifications if enabled. 

Managing Sharing Settings: 

● You can change sharing settings at any time by clicking on the "Share" 

button and adjusting the permissions for individual users or groups. 

● Additionally, you can stop sharing the spreadsheet altogether by clicking 

on "Advanced" in the sharing dialog box and selecting "Stop sharing." 

 
By following these steps, you can effectively collaborate with others and share 

spreadsheets in Google Sheets, enabling seamless teamwork and productivity. 
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Let Us Sum Up 

 

Creating and formatting spreadsheets in Google Sheets involves several steps, 

beginning with accessing Google Sheets via a web browser or Google Drive. After 

creating a new spreadsheet, users can enter data, format text and numbers, insert and 

delete rows/columns, merge and split cells, apply conditional formatting, and protect 

cells as needed. The process includes using basic formatting tools such as font size, 

style, alignment, and background color, along with more advanced features like 

conditional formatting and protection settings. Google Sheets automatically saves 

changes, but users can also save copies in various formats or download them. This 

process enables efficient creation and customization of spreadsheets for diverse 

purposes. 

 

Check your Progress 
 

What is the shortcut key to paste copied data in Google Sheets? 

 
a) Ctrl + C 

 
b) Ctrl + V 

 
c) Ctrl + X 

 
d) Ctrl + P 

 
Answer: b) Ctrl + V 

How can you merge cells in Google Sheets? 

 
a) Right-click and select "Merge Cells" 

 
b) Go to the "Format" menu and choose "Merge Cells" 

 
c) Press Ctrl + M 

 
d) Drag and drop cells to merge 

 
Answer: b) Go to the "Format" menu and choose "Merge Cells" 

Which function is used to find the average of a range of numbers in Google Sheets? 

 
a) SUM 
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b) MAX 

 
c) AVERAGE 

 
d) COUNT 

 
Answer: c) AVERAGE 

What does the Autofill feature in Google Sheets allow you to do? 

 
a) Automatically save changes 

 
b) Automatically fill cells with a series or pattern 

 
c) Automatically apply conditional formatting 

 
d) Automatically share spreadsheets with collaborators 

 
Answer: b) Automatically fill cells with a series or pattern 

How can you access the revision history of a shared spreadsheet in Google Sheets? 

 
a) Click on the "File" menu and select "Revision History" 

 
b) Right-click on the spreadsheet and choose "Revision History" 

 
c) Click on the "View" menu and select "Revision History" 

 
d) Press Ctrl + H 

 
Answer: a) Click on the "File" menu and select "Revision History" 

 
4. 4.1 Creating and Formatting Documents in Google Docs 

 
Google Docs is a web-based word processing application developed by Google. It 

allows users to create, edit, and collaborate on documents online in real-time. Launched 

in 2006, Google Docs offers a wide range of features, including text formatting, inserting 

images and links, creating tables, and more. One of its standout features is the ability 

for multiple users to work on the same document simultaneously, enabling seamless 

collaboration. Google Docs is accessible from any device with internet access and 

offers automatic saving, ensuring that users' work is always up to date. It has become a 

popular tool for personal, educational, and professional use due to its convenience, 

accessibility, and collaborative capabilities. 

Creating and formatting documents in Google Docs is a straightforward process. Here 

are the steps involved: 
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Access Google Docs: Open your web browser and navigate to Google Docs by 

typing "docs.google.com" into the address bar or searching for "Google Docs" in 

the search engine. Alternatively, you can access Google Docs from your Google 

Drive by clicking on the "+ New" button and selecting "Google Docs." 

Creating a New Document: Once in Google Docs, click on the "+ Blank" option to 

create a new, empty document. This will open a new tab with a blank document 

where you can begin typing your content. 

Entering Text: Click anywhere on the document and start typing to enter your 

text. You can use the keyboard to navigate between different parts of the 

document or click with your mouse to place the cursor where you want to type. 

Formatting Text: To format text in Google Docs, you can use the toolbar at the 

top of the document editor. Here's how to apply formatting: 

Font: Select the text you want to format and use the font dropdown menu to choose a 

different font style. 

● Font Size: Use the font size dropdown menu to change the size of the 

selected text. 

● Bold, Italic, Underline: Use the bold (B), italic (I), and underline (U) 

buttons to apply these formatting styles to the selected text. 

● Text Color: Click on the "A" with a color palette icon to change the color 

of the selected text. 

● Alignment: Use the alignment buttons (left align, center align, right 

align, and justify) to align text within the document. 

● Line Spacing: Use the line spacing dropdown menu to adjust the spacing 

between lines of text. 

● Lists: Use the bulleted list or numbered list buttons to create lists in 

your document. 

Inserting Images and Links: To insert images or links into your document, click 

on the "Insert" menu in the toolbar and choose either "Image" or "Link." You can 

upload images from your computer or insert images from the web by providing a 

URL. For links, you can paste the URL and add the link text. 

Formatting Paragraphs: You can format paragraphs by adjusting the indentation, 

line spacing, and alignment. Use the toolbar buttons or the "Format" menu to 

change paragraph settings such as indentation and line spacing. 
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Inserting Tables and Drawings: If you need to include tables or drawings in your 

document, you can do so by clicking on the "Insert" menu and choosing either 

"Table" or "Drawing." You can create tables of various sizes and insert drawings 

or shapes to illustrate your content. 

Adding Headers and Footers: To add headers and footers to your document, 

click on the "Insert" menu and choose either "Header" or "Footer." You can enter 

text or insert page numbers into the header or footer section of the document. 

Saving and Sharing: Google Docs automatically saves your work as you make 

changes. However, to save a copy or download the document, click on "File" in 

the menu bar and choose "Download" to save the document in various 

formats (e.g., Word, PDF, plain text). To share the document with others, click 

on the "Share" button in the top-right corner and enter the email addresses of 

the individuals or groups you want to share it with. 

 
By following these steps, you can efficiently create and format documents in Google 

Docs for various purposes, whether personal, educational, or professional. 

 
4.4.2 Collaboration features: real-time editing, commenting, and suggesting 

changes 

Google Docs offers robust collaboration features that enable real-time editing, 

commenting, and suggesting changes, facilitating seamless teamwork and document 

collaboration. Here's an explanation of each feature: 

 
Real-Time Editing: Google Docs allows multiple users to edit a document 

simultaneously. Changes made by one user are instantly visible to others, and 

each collaborator can see cursor positions and edits made by other users in real-

time. This feature is invaluable for teams working together on a document, as it 

enables them to collaborate efficiently without version control issues. Users can 

see edits as they happen, making it easy to track changes and work together 

seamlessly. 

Commenting: Collaborators can add comments to specific parts of the document 

to provide feedback, ask questions, or suggest improvements. To add a 

comment, users simply select the text they want to comment on and click the 

"Insert" menu, then choose "Comment." Comments are displayed in the 
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document margin, allowing other users to read and reply to them. Commenting 

helps facilitate communication and collaboration among team members, allowing 

them to discuss changes and provide input directly within the document. 

Suggesting Changes: Google Docs allows users to suggest edits instead of 

making direct changes to the document. This feature is useful when collaborators 

want to propose changes without altering the original content. When suggesting 

changes, edits are displayed as suggestions rather than being implemented 

immediately. Collaborators can accept or reject each suggested change 

individually, giving them full control over the final document. Suggesting 

changes is especially helpful for reviewing and editing documents 

collaboratively while preserving the integrity of the original content. 

 
Overall, Google Docs' collaboration features enhance productivity and streamline 

teamwork by enabling real-time editing, commenting, and suggesting changes. These 

features facilitate seamless communication and collaboration among team members, 

allowing them to work together efficiently on documents from anywhere with an internet 

connection. 

4. 4.3 Version history and revision tracking 

Version history and revision tracking in Google Docs allow users to view and manage 

changes made to a document over time. Here's how to use these features effectively: 

 
Accessing Version History: 

● Open the Google Docs document you want to review. 

● Click on "File" in the menu bar. 

● Select "Version history" from the dropdown menu. 

● Choose "See version history" to open the version history pane on the 

right side of the document. 

Viewing Document Versions: 

● In the version history pane, you'll see a list of document versions 

organized by date and time. 

● Each version represents a snapshot of the document at a specific point in time. 

● Click on a specific version to view it. The document will revert to the 

selected version, allowing you to see how it looked at that time. 

Comparing Versions: 

● To compare two document versions, select one version from the list. 
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● Then, click on the three vertical dots next to the version and choose 

"Compare version" from the dropdown menu. 

● Google Docs will open a new document with a comparison between the 

selected version and the current document. 

● Changes between the two versions will be highlighted, making it easy to 

see what has been added, removed, or modified. 

Restoring Previous Versions: 

● If you want to revert to a previous version of the document, select the 

desired version from the version history list. 

● Then, click on "Restore this version" at the top of the version history pane. 

● Google Docs will replace the current document with the selected 

version, effectively restoring it to its previous state. 

Tracking Changes with Suggested Edits: 

● To track changes made by collaborators in real-time, you can enable 

"Suggesting" mode in Google Docs. 

● Click on "Editing" in the top-right corner of the document and select 

"Suggesting" from the dropdown menu. 

● Any edits made in this mode will appear as suggestions rather than direct 

changes, allowing collaborators to review and accept/reject them 

individually. 

 
By using version history and revision tracking in Google Docs, users can review past 

document versions, compare changes, and revert to previous states if needed. These 

features are essential for tracking document revisions, managing edits, and ensuring 

document integrity during collaborative work. 

 
4. 4.4 Exporting and Printing documents in Google Docs 

Exporting and printing documents in Google Docs is a straightforward process. Here's a 

step-by-step guide: 

 
Exporting Documents: 

 
Open the Document: 

● Sign in to your Google account and navigate to Google Docs. 

● Open the document you want to 
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export. Access the File Menu: 

● Click on "File" in the menu bar at the top of the 

document. Choose Export Format: 

● Hover over "Download" in the dropdown menu. 

● Select the desired export format from the available options. Common 

formats include: 

● Microsoft Word (.docx) 

● PDF Document (.pdf) 

● Plain Text (.txt) 

● Rich Text Format (.rtf) 

● Web Page (.html, 

zipped) Download the Document: 

● Click on the desired export format. 

● Google Docs will generate the exported file and prompt you to save it 

to your computer. 

● Choose a location to save the file and click "Save" or 

"Download." Printing Documents: 

Open the Document: 

● Sign in to your Google account and navigate to Google Docs. 

● Open the document you want to 

print. Access the Print Menu: 

● Click on "File" in the menu bar at the top of the 

document. Select Print Settings: 

● Choose "Print" from the dropdown menu. 

● This action will open the Print dialog 

box. Adjust Print Settings (Optional): 

● In the Print dialog box, you can adjust settings such as: 

● Printer: Select the printer you want to use. 

● Copies: Specify the number of copies to print. 

● Pages: Choose specific pages or a range of pages to print. 

● Layout: Adjust orientation (portrait or landscape) and 

paper size. Preview and Print: 

● Review the document preview to ensure it appears as expected. 
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● Click on "Print" to send the document to the selected printer. 

Confirm Printing: 

● Depending on your printer settings, you may need to confirm the printing 

action on your printer's control panel. 

 
By following these steps, you can easily export documents from Google Docs into 

various file formats and print them directly from the Google Docs interface. These 

features make it convenient to share and distribute documents in digital or physical 

formats as needed. 

Let Us Sum Up 

Google Docs Essentials encompass creating, formatting, collaborating, version tracking, 

exporting, and printing documents. In creating and formatting documents, users can 

access Google Docs, enter text, format it with various tools like fonts, alignment, and 

lists, and insert images, links, tables, and headers/footers. Collaboration features 

enable real-time editing, commenting, and suggesting changes, enhancing teamwork 

efficiency. Version history and revision tracking allow users to review, compare, and 

restore previous document versions. Exporting documents offers formats like Word, 

PDF, and Plain Text, while printing provides customizable settings for efficient physical 

copies. These features collectively empower users for versatile document management. 

 
Check your progress 

1. Which of the following is a standout feature of Google Docs? 
A) Real-time editing 
B) Automatic saving 
C) Formatting options 
D) Inserting images 

 
2. What feature of Google Docs allows multiple users to work on the same document 

simultaneously? 

 
A) Commenting 

B) Suggesting changes 

C) Real-time editing 

D) Version history 

         3.How can users add comments to specific parts of a Google Docs document? 

A) Select text and press Ctrl + C 

B) Click on the "Insert" menu and choose "Comment" 

C) Right-click on the text and select "Add Comment" 
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D) Use the keyboard shortcut Ctrl + Alt + M 

 
4 What does version history allow users to do in Google Docs? 

A) View and manage changes made to a document over time 

B) Compare documents with different formats 

C) Print documents directly from Google Docs 

D) Export documents into various file formats 

5. How can users export a Google Docs document into a different file format? 

A) Click on "File" and select "Print" 

B) Right-click on the document and choose "Export" 

C) Hover over "Download" in the File menu and select the desired format 

     D) Use the keyboard shortcut Ctrl  

Unit Summary  

 

Cloud-based apps like Google Drive, Google Sheets, and Google Docs revolutionize how users store, 

manage, and collaborate on documents. **Google Drive** serves as a centralized platform for cloud 

storage, enabling users to upload, organize, and share files across devices. **Google Sheets** provides 

a powerful tool for creating and analyzing spreadsheets, with features like real-time collaboration, 

formulas, and data visualization. **Google Docs** facilitates document creation and editing, supporting 

multiple users to work on the same file simultaneously, with comprehensive editing and commenting 

tools. All three applications seamlessly integrate, offering a cohesive experience for managing and 

working on various types of documents in the cloud. They support offline access, version history, and 

extensive sharing options, enhancing productivity and collaboration. 

GLOSSARY  
 
1. Cloud Storage: A service that stores data on remote servers accessed via the internet, allowing users 

to save files and access them from any device. 

2. Google Drive: A cloud-based file storage service by Google that allows users to store, share, and 

collaborate on files and documents online. 

3. Google Docs: An online word processing application that enables users to create, edit, and 

collaborate on documents in real-time. 

4. Google Sheets: A cloud-based spreadsheet application that allows users to create, edit, and 

collaborate on data sheets and perform calculations or analysis. 

5. Collaboration: A feature in cloud-based apps that allows multiple users to work together on the same 

document, spreadsheet, or file in real-time. 

6. Version History: A feature in Google Drive, Docs, and Sheets that allows users to view, restore, and 

track changes made to a document or file over time. 
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7. Sharing Permissions: Options that allow users to control access to their files, such as view-only, 

comment-only, or full editing rights for others. 

8. Template: Pre-designed formats available in Google Docs and Google Sheets to help users create 

documents or spreadsheets with predefined styles and layouts. 

9. Add-ons: Third-party tools and extensions that can be integrated with Google Docs and Google 

Sheets to enhance functionality, such as custom formatting, analytics, or automated workflows. 

10. Offline Mode: A feature that allows users to create and edit Google Docs and Google Sheets files 

without an internet connection, syncing changes when reconnected to the internet. 

 

 

Self Assessment Test 

1. What is the primary function of Google Drive? 

   a) To create presentations 

   b) To store and share files in the cloud 

   c) To create spreadsheets 

   d) To edit videos 

   Answer: b) To store and share files in the cloud 

2. Which feature allows multiple users to collaborate in real-time on the same Google Docs file? 

   a) Comments 

   b) Offline mode 

   c) Version history 

   d) Real-time editing 

   Answer: d) Real-time editing 

3. What is the maximum individual file size you can upload to Google Drive for free accounts? 

   a) 10 GB 

   b) 5 GB 

   c) 100 MB 

   d) 50 GB 

  Answer: a) 10 GB 

4. In Google Sheets, which formula is used to add up a range of numbers?** 

   a) `=ADD()` 

   b) `=SUM()` 

   c) `=COUNT()` 

   d) `=TOTAL()` 
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   Answer: b) `=SUM()` 

5. Which of the following file formats can you export a Google Docs file as? 

   a) .PDF 

   b) .DOCX 

   c) .ODT 

   d) All of the above 

   Answer: d) All of the above 

6. How can you track changes made to a Google Docs document over time? 

   a) By using the Comment feature 

   b) Through the Version History 

   c) By copying and comparing the document manually 

   d) Using Add-ons 

   Answer: b) Through the Version History 

7. What is the maximum free storage limit for Google Drive? 

   a) 5 GB 

   b) 10 GB 

   c) 15 GB 

   d) 20 GB 

   Answer: c) 15 GB 

8. Which Google Sheets function is used to find the average of a set of numbers? 

   a) `=AVERAGE()` 

   b) `=MEAN()` 

   c) `=AVG()` 

   d) `=MEDIAN()` 

   Answer: a) `=AVERAGE()` 

9. Which of the following features allows you to work offline in Google Docs?** 

   a) Offline mode extension 

   b) Google Sync 

   c) Offline Access Setting 

   d) Google Docs Backup 

 Answer: c) Offline Access Setting 

10. Which of the following is NOT a built-in template option available in Google Sheets? 

   a) To-do list 

   b) Timesheet 
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   c) Resume 

   d) Calendar 

   Answer: c) Resume 

 

Suggested Readings 

Past, K. (2008). Indian Business Etiquette: 1 (First edition). Ahmedabad Jaico Publishing House
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Unit Objectives: 
 To enable the students learn the functions and usage of Cloud based apps like 
          Google Forms, Google Slides and Google Cloud Printing. 

 

 

 

Introduction To GOOGLE FORMS, GOOGLE SLIDES And GOOGLE CLOUD PRINTING 

 
In today's digital age, cloud-based applications have revolutionized the way we create, 

collaborate, and share information. Among the leading providers of such applications is 

Google, offering a suite of powerful tools designed to streamline various tasks. Three 

notable offerings from Google's suite are Google Forms, Google Slides, and Google 

Cloud Print. 

 
Google Forms: Google Forms is a versatile tool that enables users to create custom 

online forms and surveys effortlessly. With a user-friendly interface and a range of 

question types, such as multiple-choice, short answer, and dropdown menus, Google 

Forms caters to diverse data collection needs. From event RSVPs to customer 

feedback surveys, Google Forms empowers users to gather information efficiently and 

analyze responses in real-time. 

 
Google Slides: Google Slides is a dynamic presentation tool that allows users to create, 

edit, and share multimedia-rich slideshows from any device with internet access. With 

features for adding text, images, videos, charts, and more, Google Slides offers endless 

possibilities for crafting engaging presentations. Its collaborative capabilities enable 

multiple users to work on a presentation simultaneously, facilitating seamless teamwork 

and creative brainstorming. 

 
Google Cloud Print: Google Cloud Print was a cloud-based printing service that 

simplified the printing process across multiple devices. By connecting printers to the 

cloud, users can print documents from anywhere, using smartphones, tablets, or 

computers. Due to many reasons, google cloud print was discontinued from 31st 

December 2020. 

 
UNIT V CLOUD Based Apps 
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In summary, Google Forms and Google Slides are invaluable tools that leverage the 

power of the cloud to streamline workflows, enhance collaboration, and simplify 

everyday tasks. From creating surveys to delivering presentations these applications 

empower users to accomplish more with less effort, making them essential components 

of modern digital workspaces. 

5.1 Google Forms 

5.1.1 Understanding the purpose of google forms 

The purpose of Google Forms is to provide a user-friendly platform for creating 

customizable online forms and surveys. Google Forms offers a wide range of features 

and functionalities designed to streamline the process of collecting data from individuals 

or groups. Some key purposes of Google Forms include: 

 
Data Collection: Google Forms allows users to gather information efficiently by 

creating forms with various question types, including multiple-choice, short 

answer, dropdown menus, checkboxes, and more. This makes it suitable for 

conducting surveys, quizzes, feedback forms, event registrations, and other 

types of data collection activities. 

Customization: Users can customize the appearance and structure of their forms 

to suit their specific needs. Google Forms offers options for adding images, 

videos, and custom themes to make forms visually appealing and engaging. 

Users can also personalize the form settings, such as response collection limits, 

required questions, and response validation rules. 

Accessibility: Google Forms can be accessed from any device with an internet 

connection, making it convenient for both creators and respondents. Whether on 

a computer, smartphone, or tablet, users can easily access and fill out forms 

without the need for specialized software or hardware. 

Real-Time Responses: Responses submitted through Google Forms are 

automatically collected and organized in a Google Sheets spreadsheet in real-

time. This allows users to view, analyze, and share response data instantly, 

facilitating quick decision-making and data-driven insights. 

Collaboration: Google Forms supports collaborative editing, enabling multiple 

users to work on a form simultaneously. Team members can collaborate on form 

creation, review responses together, and share forms with others seamlessly, 

enhancing teamwork and efficiency. 
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Integration: Google Forms seamlessly integrates with other Google Workspace 

applications, such as Google Sheets and Google Drive. This integration enables 

users to automate workflows, export data to spreadsheets for further 

analysis, and store form responses securely in the cloud. 

 
Overall, the purpose of Google Forms is to provide individuals, businesses, educators, 

and organizations with a powerful yet intuitive tool for collecting, organizing, and 

analyzing data effectively. Whether for conducting surveys, gathering feedback, or 

managing event registrations, Google Forms simplifies the process of data collection 

and empowers users to make informed decisions based on valuable insights. 

5.1.2 Creating a google form 

Creating a Google Form is a straightforward process that involves several steps. Below 

are the detailed steps to create a Google Form: 

 
Access Google Forms: Open your web browser and navigate to Google Forms 

by typing "forms.google.com" into the address bar or searching for "Google 

Forms" in the search engine. Alternatively, you can access Google Forms from 

your Google Drive by clicking on the "+ New" button and selecting "Google 

Forms." 

Sign in (if necessary): If you're not already signed in to your Google account, 

you'll be prompted to do so. Sign in with your Google account credentials. 

Start a New Form: Once in Google Forms, click on the "+ Blank" option to start a 

new form. This will open a new form template where you can begin creating your 

form. 

Add Questions: Click on the first question field to enter your first question. You 

can choose from various question types, including multiple-choice, short answer, 

paragraph, dropdown, checkboxes, and more. To add more questions, click on 

the "+" icon below the last question field or click on the "Add question" button in 

the toolbar. 

Customize Question Settings: After adding a question, you can customize its 

settings by clicking on the three dots on the bottom right corner of the question 

box. This allows you to mark the question as required, shuffle the options (for 

multiple-choice questions), add descriptions or help text, and more. 

Organize Questions: You can rearrange the order of questions by clicking and 
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dragging them to the desired position. This helps in organizing your form 

logically. 

Add Sections (Optional): To group related questions together or break your form 

into sections, you can add sections. Click on the "Add section" button in the 

toolbar to create a new section. Sections help in organizing longer forms and 

provide clarity to respondents. 

Customize Form Settings: Click on the settings icon (gear icon) in the top-right 

corner to access the form settings. Here, you can customize various settings 

such as the form title, description, confirmation message, response destination 

(Google Sheets), and more. 

Preview Your Form: To see how your form will look to respondents, click on the 

"Preview" button in the top-right corner. This allows you to test your form before 

sharing it with others. 

Share Your Form: Once you're satisfied with your form, you can share it with 

others. Click on the "Send" button in the top-right corner to get the shareable link 

or embed code. You can also share the form via email, social media, or QR code. 

Collect Responses: Share the form link with your audience, and they can start 

filling out the form. Responses are automatically collected and stored in a Google 

Sheets spreadsheet, which you can access from your Google Drive. 

View Responses: To view responses in real-time, open the form and click on the 

"Responses" tab. Here, you can see summary charts, individual responses, and 

download responses to Google Sheets for further analysis. 

 
By following these steps, you can create a Google Form for various purposes, including 

surveys, quizzes, feedback forms, event registrations, and more. The intuitive interface 

and customizable features of Google Forms make it a versatile tool for collecting data 

efficiently. 

 
5.1.3 Adding different types of questions in Google forms 

In Google Forms, you can add various types of questions to gather different types of 

information from respondents. Here's how you can add different types of questions: 

 
Multiple Choice: 

● Click on the "+" icon to add a new question. 

● Choose "Multiple choice" from the question types. 
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● Enter the question text and options. 

● Optionally, mark the question as required and add descriptions or 

images. Checkbox: 

● Follow the same steps as for multiple choice questions but choose "Checkbox" 

instead. 

● Enter the question text and provide options. 

● Respondents can select multiple 

options. Dropdown: 

● Similar to multiple choice and checkbox questions. 

● Choose "Dropdown" as the question type. 

● Enter the question text and options. 

● Respondents can select one option from a 

dropdown list. Short Answer: 

● Choose "Short answer" as the question type. 

● Enter the question text. 

● Respondents provide a brief text 

response. Paragraph: 

● Similar to short answer but for longer text responses. 

● Choose "Paragraph" as the question type. 

● Enter the question text. 

● Respondents provide a longer text 

response. Linear Scale: 

● Choose "Linear scale" as the question type. 

● Enter the question text and define the scale's range (e.g., from 1 to 5). 

● Respondents select a point on a scale within the defined 

range. Multiple Choice Grid: 

● Choose "Multiple choice grid" as the question type. 

● Enter the question text and define rows and columns. 

● Respondents select one option per 

row. Checkbox Grid: 

● Similar to multiple choice grid but allows multiple selections. 

● Choose "Checkbox grid" as the question type. 

● Enter the question text and define rows and columns. 

● Respondents can select multiple options per 
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row. Date: 

● Choose "Date" as the question type. 

● Enter the question text. 

● Respondents select a date from a calendar 

picker. Time: 

● Choose "Time" as the question type. 

● Enter the question text. 

● Respondents enter a time using a time 

picker. File Upload: 

● Choose "File upload" as the question type. 

● Enter the question text. 

● Respondents can upload files as their 

response. Section Header: 

● Not a question but used to divide the form into sections. 

● Choose "Section header" as the question type. 

● Enter the section title or description. 

 
By adding these different types of questions, you can create comprehensive and 

engaging forms to collect various types of data from your respondents. 

5.1.4 Customizing google form settings 

To customize the form settings and themes in Google Forms, follow these steps: 

 
Access Form Settings: 

● Open Google Forms and create a new form or open an existing one. 

● Click on the "Settings" (gear icon) located at the top right corner of 

the form builder. 

Adjust General Settings: 

● In the Settings menu, you can adjust various options such as: 

● Collect email addresses: Choose whether to collect 

respondents' email addresses. 

● Limit to 1 response: Restrict respondents to submitting only one response. 

● Edit after submit: Allow respondents to edit their responses 

after submission. 
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● See summary charts and text responses: Allow respondents to 

see a summary of their responses after submission. 

Customize Presentation Settings: 

● In the Settings menu, scroll down to Presentation. 

● Here, you can customize how the form appears to respondents: 

● Show progress bar: Display a progress bar to indicate how far 

respondents are in completing the form. 

● Show link to submit another response: Provide an option for 

respondents to submit another response. 

● Confirmation message: Customize the message displayed to 

respondents after they submit the form. 

Change Theme: 

● Click on the "Theme" (palette icon) located at the top right corner of 

the form builder. 

● Choose from the available themes or click on "Customize" to create 

your own theme. 

● Customize the background color, font style, and header image to 

match your preferences or branding. 

Preview Changes: 

● After customizing the form settings and theme, click on the eye icon to 

preview how the form will look to respondents. 

● Review the changes and make further adjustments if 

necessary. Save Settings and Themes: 

● Once you're satisfied with the settings and theme, click on the "Save" 

button to apply the changes. 

● Your form will now reflect the customized settings and theme when 

shared with respondents. 

 
By customizing the form settings and themes in Google Forms, you can tailor the form's 

appearance and functionality to suit your specific needs and preferences, creating a 

more engaging and branded experience for respondents. 
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5.1.5 Sharing and Collaborating on forms 

Sharing and collaborating on Google Forms is a straightforward process that allows 

multiple users to work on the same form simultaneously. Here's how to share and 

collaborate on forms: 

 
Access the Form: 

● Open Google Forms and navigate to the form you want to share or 

collaborate on. Share the Form: 

● Click on the "Send" button located at the top right corner of the form builder. 

● In the "Send form" window, you have several options for sharing the form: 

● Send via email: Enter email addresses of individuals you want to 

share the form with. You can also include a personalized message. 

● Get a shareable link: Copy the link provided and share it via any 

communication channel (email, messaging apps, social media, 

etc.). 

● Embed HTML: Get an HTML code to embed the form directly 

into a webpage or blog. 

● Share on social media: Share the form link directly on various 

social media platforms. 

● Choose the sharing option that best suits your needs and 

preferences. Set Collaboration Permissions: 

● By default, collaborators you share the form with can edit the form. 

● If you want to restrict collaborators' permissions, you can do so by clicking 

on the gear icon next to the "Send" button and selecting "Collaborators can 

edit" or "Collaborators can view" depending on your preference. 

Invite Collaborators: 

● If you want specific individuals to collaborate on the form, you can invite 

them directly by entering their email addresses in the sharing settings. 

● Collaborators will receive an email notification with a link to access the 

form. Collaborate in Real-Time: 

● Once the form is shared, all collaborators can work on the form 

simultaneously in real-time. 

● Changes made by one collaborator are instantly visible to others, allowing for 
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seamless collaboration without version control issues. 

● Collaborators can see each other's cursor positions and edits as 

they happen. Review Changes and Responses: 

● As collaborators work on the form, you can review changes and 

responses in real-time. 

● Google Forms automatically collects and organizes responses in a Google 

Sheets spreadsheet, allowing you to analyze data and track submissions. 

Manage Collaboration Settings: 

● At any time, you can manage collaboration settings by clicking on the gear 

icon next to the "Send" button and adjusting permissions or 

adding/removing collaborators as needed. 

 
By following these steps, you can easily share and collaborate on Google Forms with 

colleagues, team members, or other stakeholders, enabling efficient teamwork and data 

collection. 

5.1.6 Analyzing google form responses 

Analyzing Google Form responses is a crucial step in understanding the data 

collected and gaining insights from the submissions. Here's how to analyze Google 

Form responses: 

 
Access Form Responses: 

● Open Google Forms and navigate to the form for which you want to 

analyze responses. 

● Click on the "Responses" tab at the top of the form 

builder. View Summary of Responses: 

● In the "Responses" tab, you'll see a summary of responses, including the 

total number of responses and a summary of each question's responses. 

● Google Forms provides charts and graphs to visualize response data 

for multiple-choice questions, making it easier to interpret the data at a 

glance. 

View Individual Responses: 

● Scroll down to view individual responses submitted by respondents. 

● Each response is displayed in a separate row, with each column 

representing a question from the form and the respondent's answer. 
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Export Response Data to Google Sheets: 

● To perform more in-depth analysis or further manipulate the data, you 

can export response data to Google Sheets. 

● Click on the Google Sheets icon (located next to the "Summary of 

responses" section) to create a new Google Sheets spreadsheet linked to 

your form. 

● All response data will be automatically populated in the spreadsheet, 

allowing you to perform various data analysis tasks. 

Analyze Data in Google Sheets: 

● Once response data is imported into Google Sheets, you can use 

various built-in features and functions to analyze the data further. 

● Conduct data validation, create pivot tables, apply filters, and perform 

statistical analysis to gain insights from the responses. 

● Use formulas and conditional formatting to highlight trends, patterns, and 

outliers in the data. 

Visualize Data with Charts and Graphs: 

● In Google Sheets, you can create charts and graphs based on 

response data to visualize trends and patterns more effectively. 

● Choose from various chart types (e.g., bar charts, pie charts, line 

graphs) to represent the data in a visually appealing and understandable 

way. 

Share Analysis with Collaborators: 

● Once you've analyzed the response data, you can share your findings 

with collaborators or stakeholders. 

● Share the Google Sheets spreadsheet containing the response data 

and analysis with specific individuals or groups. 

 
By following these steps, you can effectively analyze Google Form responses, gain 

valuable insights from the data, and share your findings with others to inform decision-

making and drive action. 

5.1.7 Integrating google forms with other applications 

Integrating Google Forms with other Google apps allows you to streamline workflows, 

automate tasks, and enhance the functionality of your forms. Here's how to integrate 

Google Forms with other Google apps: 
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Google Sheets Integration: 

● Responses collected in Google Forms can be automatically exported to 

Google Sheets for further analysis and data management. 

● To integrate with Google Sheets, open your form, go to the "Responses" 

tab, and click on the Google Sheets icon to create a linked spreadsheet. 

● Every time someone submits a response to your form, it will be added as 

a new row in the linked Google Sheets spreadsheet, making it easy to 

manage and analyze response data. 

Google Drive Integration: 

● Google Forms and their associated response data can be stored and 

organized in Google Drive. 

● When you create a Google Form, it's automatically saved in your Google 

Drive. You can access it directly from Google Drive, share it with 

collaborators, and organize it into folders. 

● Additionally, any linked Google Sheets spreadsheet containing form 

responses will also be stored in Google Drive. 

Google Calendar Integration: 

● You can use Google Forms to create event registration forms or surveys, 

and integrate them with Google Calendar to schedule events or reminders 

based on form submissions. 

● For example, you can create a form for event RSVPs and set up a 

Google Calendar event whenever someone submits the form. 

Google Docs Integration: 

● Google Forms can be used to collect information or feedback, which can 

then be automatically populated into Google Docs for creating reports, 

summaries, or other documents. 

● For example, you can use Google Forms to gather input from team 

members, and then automatically generate a report in Google Docs 

summarizing the responses. 

Google Sites Integration: 

● Google Forms can be embedded into Google Sites to create interactive 

web forms or surveys directly within a website. 
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● This integration allows you to seamlessly collect data from visitors to your 

website using customized forms. 

Google Classroom Integration: 

● If you're an educator using Google Classroom, you can integrate Google 

Forms with Classroom to create assignments, quizzes, or surveys for your 

students. 

● Google Forms assignments can be distributed to students through Google 

Classroom, and responses are automatically collected and graded. 

Google Analytics Integration: 

● If you're using Google Forms for collecting feedback or conducting 

surveys on a website, you can integrate with Google Analytics to track 

form submissions and analyze user behavior. 

● This integration provides insights into form engagement, completion rates, 

and user demographics. 

 
By integrating Google Forms with other Google apps, you can enhance productivity, automate 

workflows, and leverage the full potential of your forms for various purposes. 

Let Us Sum Up 

Google Forms serves as a versatile tool for creating customizable online forms and 

surveys, simplifying data collection from individuals or groups. Its key purposes include 

efficient data gathering through various question types, customization options for 

personalized forms, accessibility across devices, real-time response collection, 

collaborative editing, and seamless integration with other Google Workspace 

applications. Creating a form involves setting up columns, entering data, and 

formatting as a table. Users can then sort, filter, and link data, analyze responses in 

real-time, and share or collaborate on forms effortlessly. Google Forms empowers 

individuals, businesses, educators, and organizations to collect, organize, and analyze 

data effectively for informed decision-making. 

Check Your Progress 

1. What is the primary purpose of Google Forms? 

a) Creating online presentations 

b) Collecting and organizing data 

c) Sharing files with collaborators 
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d) Editing documents in real-time 

2. Which of the following is NOT a key purpose of Google Forms? 

a) Customization 

b) Accessibility 

c) Video editing 

d) Real-time responses 

3. What types of questions can you add to a Google Form for data collection? 

a) Only multiple-choice questions 

b) Only short answer questions 

c) Multiple-choice, short answer, dropdown, and more 

d) Only true or false questions 

4. How can Google Forms enhance collaboration among users? 

a) By restricting access to form creation 

b) By allowing only one user to edit the form at a time 

c) By enabling multiple users to work on the same form simultaneously 

d) By limiting the number of responses collected 

5. What does Google Forms integrate with to automate workflows? 

a) Google Maps 

b) Google Drive 

c) Google Translate 

d) Google Photos 

5.3. Google Slides 
● Exploring the features of Google Slides 

● Creating a new presentation 

● Adding and formatting slides 

● Inserting text, images, and multimedia elements 

● Applying themes and layouts 

● Collaborating on presentations in real-time 

● Presenting slides and using speaker notes 

● Exporting and sharing presentations 

 
5.3.1 Exploring the features of Google Slides 

 
Exploring the features of Google Slides involves understanding its capabilities for 

creating, editing, and presenting slideshows. Here's an overview: 
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Creating Slides: Users can easily create slides by adding text, images, shapes, 

and multimedia elements such as videos and audio files. Google Slides offers a 

variety of pre-designed templates to choose from. 

Editing Tools: Google Slides provides a range of editing tools for formatting text, 

images, and shapes. Users can change fonts, colors, alignments, and apply 

effects like shadows and reflections. 

Collaboration: Like other Google Workspace apps, Google Slides supports 

real-time collaboration, allowing multiple users to work on the same presentation 

simultaneously. Users can leave comments, suggest edits, and track changes. 

Import and Export: Users can import existing PowerPoint presentations into 

Google Slides and export presentations as PowerPoint files or PDFs. This 

facilitates compatibility with other presentation software and sharing with non-

Google users. 

Sharing and Publishing: Presentations can be shared with specific individuals or 

made publicly accessible. Users can control viewing and editing permissions, 

shareable links, and embed presentations into websites. 

Animations and Transitions: Google Slides offers various animation and transition effects 

to enhance the visual appeal of slideshows. Users can apply entrance, exit, and 

motion path animations, as well as slide transitions. 

Speaker Notes: Users can add speaker notes to each slide to provide additional 

context or reminders for presenters. Speaker notes are only visible to the 

presenter and not to the audience during a presentation. 

Presenting: Google Slides includes a full-screen presentation mode with features 

like presenter view, laser pointer, and audience Q&A. Presenters can control 

slideshows from any device connected to the internet. 

Revision History: Google Slides automatically saves revisions and allows users 

to view and restore previous versions of a presentation. This feature helps track 

changes and revert to earlier iterations if needed. 

Integration with Google Drive: Presentations created in Google Slides are 

automatically saved to Google Drive, where users can organize, search, and 

access them from any device. Integration with Google Drive ensures seamless 

file management and backup. 

 
Exploring these features empowers users to create dynamic and engaging 
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presentations efficiently using Google Slides. Whether for business meetings, 

educational lectures, or personal projects, Google Slides offers a versatile platform for 

visual storytelling. 

 
5.3.2 Creating a new presentation 

 
Creating a presentation using Google Slides is a straightforward process. Here's a step-

by-step guide: 

 
Access Google Slides: Open your web browser and navigate to Google Slides by 

typing "slides.google.com" into the address bar or searching for "Google Slides" 

in the search engine. 

Sign in (if necessary): If you're not already signed in to your Google account, 

you'll be prompted to do so. Sign in with your Google account credentials. 

Start a New Presentation: Once in Google Slides, click on the "+ Blank" option to 

start a new presentation. This will open a new presentation template where you 

can begin creating your slides. 

Add Slides: Click on the "+" icon in the toolbar to add new slides to your 

presentation. You can choose from various slide layouts, including title slides, 

content slides, and more. Select the layout that best suits your content for each 

slide. 

Insert Content: Populate your slides with content such as text, images, shapes, 

charts, and multimedia elements. Click on the respective icons in the toolbar to 

add these elements to your slides. You can also copy and paste content from 

other sources or import existing PowerPoint presentations. 

Format Slides: Customize the appearance of your slides by formatting text, 

adjusting font styles, colors, and sizes, and applying styles and effects. Use the 

toolbar options to change slide backgrounds, apply themes, and add animations 

or transitions. 

Organize Slides: Rearrange the order of slides by clicking and dragging them to 

the desired position in the slide navigator pane on the left side of the screen. This 

helps in organizing your presentation logically. 

Add Speaker Notes (Optional): For each slide, you can add speaker notes to 

provide additional context or reminders for presenters. Click on the "Speaker 

notes" section below the slide to enter your notes. 



PU-PRIDE-OLDP MBA - Soft Skills III – Computing Skills UNIT 5 
 

181 Periyar University – CDOE| Self Learning Material 
  

Preview Your Presentation: To see how your presentation will look to viewers, 

click on the "Present" button in the top-right corner. This allows you to test your 

slides and navigate through your presentation in full-screen mode. 

Share Your Presentation: Once you're satisfied with your presentation, you can 

share it with others. Click on the "Share" button in the top-right corner to get the 

shareable link or invite specific people to view or edit the presentation. You can 

also embed the presentation into a website or download it as a PowerPoint file or 

PDF. 

Collaborate (Optional): Google Slides supports real-time collaboration, allowing 

multiple users to work on the same presentation simultaneously. Share the 

presentation with collaborators and work together to edit and refine the content. 

Save Your Presentation: Google Slides automatically saves your presentation as 

you work on it. However, you can manually save your changes by clicking on the 

"File" menu and selecting "Save" or pressing Ctrl + S (Cmd + S on Mac). 

 
By following these steps, you can create a professional-looking presentation using Google 
Slides 

for various purposes, including business meetings, educational lectures, or personal 

projects. Adding and formatting slides 

5. 3.3 Adding and formatting Slides: 

5.3.3.1 Adding Slides 
 

Open Google Slides: Navigate to Google Slides by typing "slides.google.com" 

in your web browser and sign in to your Google account if necessary. 

Create a New Presentation: Click on the "+ Blank" option to create a new 

presentation. This will open a blank slide template. 

Add New Slides: 

● Click on the "+" icon in the toolbar at the top of the screen. 

● Choose the slide layout you want to add (Title slide, Title and content, 

etc.) from the dropdown menu. 

● Alternatively, you can right-click on the left pane where the slide 

thumbnails are displayed and select "New slide" from the context menu. 

Duplicate Slides: 

● Right-click on the slide thumbnail in the left pane. 
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● Select "Duplicate slide" from the context 

menu. Delete Slides: 

● Right-click on the slide thumbnail in the left pane. 

● Select "Delete" from the context menu. 

 
5.3.3.2 Formatting Slides: 

Change Slide Layout: 

● Click on the slide you want to change the layout for. 

● Go to the "Slide" menu in the top navigation bar. 

● Select "Change layout" and choose the desired layout from the 

options. Customize Background: 

● Click on the slide you want to customize. 

● Go to the "Slide" menu. 

● Select "Change background" and choose a solid color, gradient, image, 

or custom background. 

Format Text: 

● Click on the text box you want to format. 

● Use the toolbar options to change font type, size, color, alignment, 

and style (bold, italic, underline). 

● You can also access additional text formatting options from the "Format" 

menu. Add Bullets and Numbering: 

● Select the text you want to add bullets or numbering to. 

● Click on the "Bulleted list" or "Numbered list" icon in the 

toolbar. Insert Images: 

● Click on the slide where you want to insert an image. 

● Go to the "Insert" menu. 

● Choose "Image" and select the image file from your computer or Google Drive. 

● Alternatively, you can drag and drop an image file directly onto the 

slide. Insert Shapes: 

● Click on the slide where you want to insert a shape. 

● Go to the "Insert" menu. 

● Choose "Shape" and select the desired shape from the dropdown menu. 

● Click and drag on the slide to draw the 

shape. Apply Transitions: 
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● Click on the slide you want to apply a transition to. 

● Go to the "Slide" menu. 

● Select "Change transition" and choose the transition effect you want 

to apply. Add Animations: 

● Click on the object (text box, image, shape) you want to animate. 

● Go to the "Insert" menu. 

● Choose "Animation" and select the animation effect you want to 

apply. Arrange Elements: 

● Click and drag objects on the slide to reposition them. 

● Use the "Arrange" options in the toolbar to bring objects forward or backward, 

align them, or distribute them evenly. 

Group and Ungroup Objects: 

● Select multiple objects by holding down the Shift key while clicking on 

each object. 

● Right-click on one of the selected objects. 

● Choose "Group" or "Ungroup" from the context 

menu. Apply Slide Master (for consistent formatting 

across slides): 

● Go to the "Slide" menu. 

● Select "Edit master" to access the Slide Master view. 

● Make changes to the master slide layout, fonts, colors, etc. 

● Close the Slide Master view to apply changes to all slides based on that master. 

 
By following these steps, you can add and format slides in Google Slides to create visually 

appealing and engaging presentations 

 
5.3.4 Inserting text, images, multimedia, audio in google slides 

 
Inserting Text: 

Click on a Slide: Open the Google Slides presentation and click on the slide 

where you want to insert text. 

Add Text Box: 

● Click on the "Text box" icon in the toolbar (it looks like a "T"). 

● Click anywhere on the slide to place the text box, then start 

typing. Type Text Directly: 
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● Click directly on the slide and start typing. A text box will 

automatically be created. 

Format Text: 

● Highlight the text you want to format. 

● Use the toolbar options to change font type, size, color, alignment, 

and style (bold, italic, underline). 

● You can also access additional text formatting options from the "Format" menu. 

Inserting Images: 

Click on a Slide: Select the slide where you want to insert an 

image. Go to Insert Menu: 

● Click on the "Insert" menu in the top navigation 

bar. Choose Image: 

● Select "Image" from the dropdown menu. 

● Choose the source of the image: "Upload from computer," "Search 

the web," "Drive," "Photos," or "By URL." 

Upload Image from Computer: 

● Select "Upload from computer." 

● Choose the image file from your computer and click 

"Open." Search the Web: 

● Select "Search the web" to search for images using Google's search engine. 

● Type keywords into the search bar and press Enter. 

● Click on the desired image to insert it into the 

slide. Insert Image from Drive or Photos: 

● Choose "Drive" or "Photos" to access images stored in your Google 

Drive or Google Photos. 

● Navigate to the desired image and click 

"Insert." Insert Image by URL: 

● Choose "By URL" to insert an image using its web address (URL). 

● Paste the image URL into the box and click 

"Insert." Resize and Position Image: 

● Click and drag the handles of the image to resize it. 

● Click and drag the image to reposition it on the slide. 
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Inserting Multimedia Elements: 

Click on a Slide: Select the slide where you want to insert a multimedia 

element. Go to Insert Menu: 

● Click on the "Insert" menu in the top navigation 

bar. Choose Video: 

● Select "Video" from the dropdown menu. 

● Choose the source of the video: "Google Drive," "Search the web," or "By 

URL." Insert Video from Google Drive: 

● Select "Google Drive." 

● Navigate to the video file in your Google Drive and click "Select" to 

insert it. Search the Web: 

● Select "Search the web" to search for videos using Google's search engine. 

● Type keywords into the search bar and press Enter. 

● Click on the desired video to insert it into the 

slide. Insert Video by URL: 

● Choose "By URL" to insert a video using its web address (URL). 

● Paste the video URL into the box and click 

"Insert." Resize and Position Video: 

● Click and drag the handles of the video to resize it. 

● Click and drag the video to reposition it on the slide. 

 
Inserting Audio: 

Click on a Slide: Select the slide where you want to insert 

audio. Go to Insert Menu: 

● Click on the "Insert" menu in the top navigation 

bar. Choose Audio: 

● Select "Audio" from the dropdown menu. 

● Choose the source of the audio: "Google Drive," "Search the web," or "By 

URL." Insert Audio from Google Drive: 

● Select "Google Drive." 

● Navigate to the audio file in your Google Drive and click "Select" to 

insert it. Search the Web: 

● Select "Search the web" to search for audio files using Google's search engine. 

● Type keywords into the search bar and press Enter. 
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● Click on the desired audio file to insert it into the 

slide. Insert Audio by URL: 

● Choose "By URL" to insert audio using its web address (URL). 

● Paste the audio URL into the box and click 

"Insert." Resize and Position Audio Player: 

● Click and drag the handles of the audio player to resize it. 

● Click and drag the audio player to reposition it on the slide. 

 
By following these steps, you can easily insert text, images, videos, and audio files 

into your Google Slides presentations, enhancing their visual appeal and multimedia 

richness. 

 
5.3.5 Applying themes and layouts 

 
Applying Themes: 

Open Your Presentation: Go to Google Slides and open the presentation you 

want to work on. 

Go to the Theme Options: 

● Click on the "Slide" menu in the top navigation bar. 

● Select "Change theme" from the dropdown 

menu. Choose a Theme: 

● A panel will appear on the right side of the screen with various theme options. 

● Scroll through the themes or use the search bar to find a specific theme. 

● Click on the theme you want to 

apply. Preview Theme (Optional): 

● Before applying the theme, you can preview how it will look on your slides. 

● Move your cursor over the theme thumbnails to see a preview of your 

slides with that theme applied. 

Apply Theme: 

● Once you've selected a theme, click on it to apply it to your presentation. 

● All slides in your presentation will be updated to reflect the new 

theme. Customize Theme (Optional): 

● After applying a theme, you can customize it further to match your preferences. 

● Click on the "Customize" button in the theme panel to access options for 

modifying colors, fonts, and effects. 
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● Make changes to the theme elements as desired and click "Done" when finished. 

 
Applying Layouts: 

Open Your Presentation: Go to Google Slides and open the presentation where 

you want to change slide layouts. 

Select a Slide: Click on the slide in the left sidebar that you want to apply a layout 

to. If you want to apply the same layout to multiple slides, hold down the Ctrl 

(Cmd on Mac) key while clicking on each slide. 

Go to the Layout Options: 

● Click on the "Slide" menu in the top navigation bar. 

● Select "Change layout" from the dropdown 

menu. Choose a Layout: 

● A panel will appear on the right side of the screen with various layout options. 

● Scroll through the layouts or use the search bar to find a specific layout. 

● Click on the layout you want to 

apply. Apply Layout: 

● Once you've selected a layout, it will be applied to the selected slide(s). 

● The content of the slide(s) will be rearranged according to the chosen 

layout. Customize Layout (Optional): 

● After applying a layout, you can customize it further to suit your needs. 

● Click on individual placeholders (text boxes, image placeholders, etc.) to 

add or edit content. 

● Resize, move, or delete placeholders as necessary to adjust the layout. 

 
By following these steps, you can easily apply themes and layouts to your Google 

Slides presentations, ensuring a consistent and professional design throughout your 

slides. 
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5.3.6 Collaborating on presentations in real-time 

 
Collaborating on presentations in real-time is a key feature of Google Slides, allowing 

multiple users to work on the same presentation simultaneously. Here's how to 

collaborate on presentations in Google Slides: 

 
Open Your Presentation: Go to Google Slides and open the presentation you want 

to collaborate on. 

Share the Presentation: 

● Click on the "Share" button in the top-right corner of the screen. 

● In the "Share with others" dialog box, enter the email addresses of the 

people you want to collaborate with. 

● Optionally, add a message to accompany the invitation. 

● Choose the access level for collaborators (e.g., can edit, can 

comment, or can view only). 

Send the Invitation: 

● Click on the "Send" button to send the collaboration invitation to the 

selected individuals. 

● They will receive an email notification with a link to access the 

presentation. Collaborate in Real-Time: 

● Once collaborators open the presentation, they can see changes made 

by others in real-time. 

● Each collaborator is assigned a color, and their cursor is accompanied 

by a colored highlight to indicate their presence and edits. 

● Collaborators can edit text, add or delete slides, insert images, and 

make other modifications to the presentation simultaneously. 

Communicate with Collaborators: 

● Use the built-in chat feature to communicate with collaborators in real-time. 

● Click on the chat icon in the top-right corner of the screen to open 

the chat window. 

● Type messages to communicate with other collaborators working on 

the presentation. 
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Review Changes: 

● As collaborators make changes to the presentation, you can review them 

in real-time. 

● Google Slides automatically saves changes as they occur, ensuring that 

all collaborators have access to the most up-to-date version of the 

presentation. 

Track Changes: 

● Use the revision history feature to track changes made to the presentation 

over time. 

● Click on the "File" menu, then select "Version history" > "See version history." 

● A panel will appear on the right side of the screen showing a timeline of 

edits made to the presentation. You can view previous versions and revert 

to a specific version if needed. 

Save Changes: 

● Google Slides automatically saves changes to the presentation as you work. 

● There's no need to manually save the presentation, as changes are saved 

automatically in real-time. 

 
By following these steps, you can collaborate with others in real-time on Google Slides 

presentations, enabling efficient teamwork and ensuring that everyone has access to 

the latest version of the presentation. 

 
5.3.7 Presenting Slides and Using Speaker Notes 

Presenting slides and using speaker notes in Google Slides allows you to deliver your 

presentation effectively while having additional guidance or information available. Here's 

how to do it: 

 
Open Your Presentation: Go to Google Slides and open the presentation you 

want to present. 

Enter Presentation Mode: 

● Click on the "Present" button in the top-right corner of the screen. It 

looks like a play button ▶. 

● Alternatively, you can press the shortcut key "Ctrl + F5" (Windows) or "Cmd + 
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Shift + Enter" (Mac) to enter presentation mode. 

Navigate Through Slides: 

● Use the arrow keys on your keyboard or click on the navigation arrows 

at the bottom of the screen to move between slides. 

● You can also use the slide thumbnail view on the left side to jump to a 

specific slide. 

Display Speaker Notes: 

● If you've added speaker notes to your slides, they will appear on your 

screen while presenting. 

● To view speaker notes, click on the "Notes" button in the bottom-right 

corner of the screen. It looks like a speech bubble 💬. 

● Speaker notes provide additional context, reminders, or talking points 

for each slide. 

Present with Presenter View: 

● If you have multiple monitors or screens available, you can use 

Presenter View for a better presentation experience. 

● Click on the "Present" button and select "Presenter view" from the 

dropdown menu. 

● In Presenter View, one screen displays the slides for the audience, while 

the other screen shows the presenter view with speaker notes, current 

slide, and upcoming slides. 

Use Presenter Tools: 

● While presenting, you have access to presenter tools at the bottom of the screen. 

● These tools include options to: 

● Pause or end the presentation. 

● Turn on/off captions. 

● Display a laser pointer or spotlight during the presentation. 

● Adjust the screen settings (e.g., switch monitors, change screen 

resolution). 

● Use the Q&A feature to engage with the audience and answer 

questions. Interact with Your Audience: 
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● Engage with your audience by delivering your presentation confidently 

and using visual aids effectively. 

● Refer to your speaker notes as needed for guidance, but avoid reading 

directly from them to maintain eye contact and connection with your 

audience. 

● Use the Q&A feature to address audience questions or feedback during 

or after the presentation. 

End Presentation: 

● To exit presentation mode, press the "Esc" key on your keyboard or click 

on the "Exit" button in the top-right corner of the screen. 

● Your presentation will return to editing mode, where you can make 

further changes or close the presentation as needed. 

 
By following these steps, you can effectively present your slides in Google Slides while 

utilizing speaker notes to stay on track and deliver a polished and engaging 

presentation. 

 
5.3.8 Exporting and Sharing presentations 

Exporting and sharing presentations in Google Slides allows you to distribute your 

slides to others or save them in different formats for offline use or further editing. Here's 

how to do it: 

 
Open Your Presentation: Go to Google Slides and open the presentation you 

want to export or share. 

Export as PDF: 

● Click on the "File" menu at the top-left corner of the screen. 

● Select "Download" from the dropdown menu. 

● Choose "PDF Document (.pdf)" from the submenu. 

● Your presentation will be downloaded as a PDF file to your 

computer. Export as PowerPoint: 

● Follow the same steps as above, but select "Microsoft PowerPoint 

(.pptx)" from the submenu. 

● This option allows you to download your presentation in PowerPoint 

format, which can be opened and edited in Microsoft PowerPoint. 

Export as Other Formats: 
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● Google Slides also supports exporting presentations in other formats 

such as JPEG, PNG, and SVG. 

● To export as an image, select "Image" from the "Download" submenu and 

choose the desired image format (JPEG or PNG). 

● To export as an SVG (Scalable Vector Graphics) file, select "Vector 

graphics (.svg)" from the "Download" submenu. 

Share Your Presentation: 

● Click on the "Share" button in the top-right corner of the screen. 

● In the sharing settings window, enter the email addresses of the 

individuals you want to share the presentation with. 

● Choose the access level for each person (e.g., "Can edit," "Can 

comment," "Can view"). 

● Optionally, add a message to accompany the sharing invitation. 

● Click on the "Send" button to share the presentation via 

email. Get Shareable Link: 

● Instead of sharing via email, you can generate a shareable link to your 

presentation. 

● Click on the "Get shareable link" option in the sharing settings window. 

● Choose the access level for anyone with the link (e.g., "Viewer," 

"Commenter," "Editor"). 

● Copy the shareable link and share it via email, messaging apps, or 

social media. Embed Presentation: 

● If you want to embed your presentation on a website or blog, click on 

the "< > Embed" option in the sharing settings window. 

● Copy the embed code provided and paste it into the HTML code of your 

website or blog. 

● Adjust the size and other settings as needed to fit your website's 

layout. Share with Specific People: 

● If you only want to share the presentation with specific individuals, click on 

the "Specific people" option in the sharing settings window. 

● Enter the email addresses of the people you want to share the presentation 
with 
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and choose their access levels. 

● Click on the "Send" button to share the presentation with the selected individuals. 

 
By following these steps, you can export your presentation in different formats and 

share it with others via email, shareable link, or embedding, allowing you to collaborate 

and distribute your slides effectively using Google Slides. 

 

Let Us Sum Up 

 
Exploring the features of Google Slides offers a comprehensive understanding of its 

capabilities for creating, editing, and presenting slideshows. Users can easily create 

slides with text, images, shapes, and multimedia elements, leveraging pre-designed 

templates. Editing tools enable formatting and customization, while real-time 

collaboration facilitates teamwork. Import and export options ensure compatibility and 

sharing flexibility, while themes and layouts enhance visual appeal. Presenting slides 

with speaker notes and interactive tools ensures effective communication. Finally, 

exporting and sharing presentations in various formats enable seamless distribution and 

collaboration. Google Slides empowers users to create dynamic presentations 

efficiently, fostering engagement and creativity. 

 
Check your progress 

 
1. What is one of the key features of Google Slides for creating presentations? 

 
A) Real-time collaboration 

B) Editing images 

C) Playing music in the background 

D) Sending emails 

 
2. How can users format text in Google Slides? 

 
A) By changing the slide layout 

B) Using the toolbar options 

C) Importing from PowerPoint 

D) Adding animations 

 
3. Which feature of Google Slides allows multiple users to work on the same 

presentation 
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simultaneously? 

 
A) Import and Export 

B) Presenter View 

C) Collaboration 

D) Exporting as PDF 

 
4. What is the purpose of speaker notes in Google Slides? 

 
A) To entertain the audience 

B) To provide additional context or reminders for presenters 

C) To display animations 

D) To change slide layouts 

 
5. Which mode in Google Slides allows presenters to navigate through slides in full-screen 

view? 

 
A) Editing Mode 

B) Collaboration Mode 

C) Presenter View 

D) Export Mode 

5.4 GOOGLE CLOUD PRINT 
 

5.4.1 Introduction to Google cloud print 
 

Google Cloud Print was a service developed by Google that allowed users to print from 

any device, such as a smartphone, tablet, or computer, to any printer connected to the 

service. It was launched in 2010 and discontinued on December 31, 2020. 

 
Google Cloud Print worked by allowing users to send print jobs from their devices to 

printers that were connected to the internet. Here's how it functioned: 

 
Registration: Users needed to register their printers with Google Cloud Print. 

This registration process typically involved connecting the printer to a Google 

account. Cloud-Enabled Printers: Printers that were directly compatible with 

Google Cloud Print were referred to as "Cloud-Ready" printers. These printers 

could connect directly to the internet without the need for a computer 

intermediary. 

Non-Cloud Printers: Users could also use Google Cloud Print with traditional 

printers that were not Cloud-Ready. This typically involved setting up a 

connection through a computer that was connected to both the printer and the 
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internet. The computer acted as a bridge, relaying print jobs from the Google 

Cloud to the printer. 

Sending Print Jobs: Once the printer was registered and set up with Google 

Cloud Print, users could send print jobs from their devices, such as computers, 

smartphones, or tablets, to the printer through the Google Cloud Print service. 

Access from Anywhere: One of the main advantages of Google Cloud Print was 

its ability to allow printing from anywhere, as long as the device sending the print 

job had an internet connection. Users could print documents from their mobile 

devices while on the go, for example. 

Integration with Google Services: Google Cloud Print was integrated with various 

Google services, such as Google Chrome and Google Drive, making it seamless 

for users to print documents directly from these platforms. 

 
Overall, Google Cloud Print provided a convenient and versatile way for users to print 

documents remotely to compatible printers over the internet. 

5.4.2 Discontinuance of Google cloud print 

Google announced the discontinuance of Google Cloud Print, which officially ceased its 

service on December 31, 2020. Several reasons contributed to this decision: 

 
Security Concerns: Over time, Google Cloud Print faced increasing scrutiny over 

security vulnerabilities. The service required users to upload documents to 

Google's servers before printing, raising concerns about the privacy and security 

of sensitive information. Google likely decided to discontinue the service to 

address these security risks and focus on more secure printing solutions. 

Data Privacy: Privacy concerns were another significant factor in the decision to 

discontinue Google Cloud Print. Storing print job data on Google's servers raised 

questions about data privacy and compliance with various regulations, such as 

GDPR (General Data Protection Regulation). Discontinuing the service allowed 

Google to mitigate potential privacy issues associated with handling user data. 

Integration with Native Printing Services: As cloud-based printing technology 

evolved, many operating systems and devices began offering native printing 

services without the need for third-party solutions like Google Cloud Print. This 

shift made Google Cloud Print less essential for users, as they could rely on built-

in printing features provided by their devices and operating systems. 
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Alignment with Google's Strategy: Google Cloud Print might have been seen as 

divergent from Google's broader cloud computing strategy. Google likely decided 

to streamline its offerings and focus resources on core cloud services that align 

more closely with its business objectives and customer needs. 

Low Adoption and Usage: Despite being available for nearly a decade, Google 

Cloud Print did not achieve widespread adoption among users and organizations. 

The service may have struggled to gain traction due to various factors, such as 

compatibility issues with certain printers and limited awareness among users. 

Low adoption rates could have contributed to Google's decision to discontinue 

the service. 

 
In summary, the discontinuance of Google Cloud Print was driven by a combination of 

security concerns, data privacy considerations, changes in technology trends, alignment 

with Google's strategic priorities, and potentially low adoption and usage rates. 

Let Us Sum Up 

 
Google Cloud Print was a service allowing users to print from any device to any printer 

connected to the internet. It offered registration, integration with Google services, and 

access from anywhere. Discontinued on December 31, 2020, due to security concerns, 

data privacy issues, native printing services integration, alignment with Google's 

strategy, and low adoption rates. Despite its convenience, it faced scrutiny over privacy 

and security, leading Google to focus on more secure printing solutions aligned with its 

core objectives. 

 
Check your progress 

 
1. What is Google Cloud Print 

A) A cloud storage service by Google 

B) A service that allows users to print from any device connected to the internet 

C) An email management tool 

D) A video conferencing platform 

2. How does Google Cloud Print function for users with traditional printers that 

are not Cloud-Ready? 

A) Users can directly connect their devices to the printer via USB for printing. 
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B) Users need to physically visit the printer location to initiate print jobs. 

C) Users set up a connection through a computer that acts as a bridge between 

the printer and the Google Cloud Print service. 

D) Google Cloud Print does not support traditional printers. 

3. What is the main advantage of Google Cloud Print in terms of accessibility? 

A) It requires printers to be connected to Google's servers directly. 

B) It allows printing only from devices within the same local network as the printer. 

C) It enables printing from anywhere as long as the device sending the print 

job has an internet connection. 

D) It restricts printing to specific locations designated by Google. 

4. Which of the following Google services is Google Cloud Print integrated with? 

A) Google Photos 

B) Google Translate 

C) Google Maps 

D) Google Drive 

5. What was the reason behind Google's decision to discontinue Google Cloud Print? 

A) Lack of printer compatibility with the service 

B) Security vulnerabilities and concerns over data privacy 

C) Insufficient demand for cloud-based printing solutions 

D) Incompatibility with Google's overall cloud computing strategy 

Unit Summary  
This unit explores three essential cloud-based tools from Google. Google Forms allows users to create 

surveys, quizzes, and collect data efficiently with built-in analysis features. Google Slides offers a 

platform for creating presentations collaboratively, supporting real-time editing and seamless sharing. 

Google Cloud Print (now discontinued) was a service that enabled users to print documents remotely 

using cloud-connected devices. Each tool is designed for ease of access, collaboration, and integration 

with other Google Workspace apps, promoting productivity and efficiency in a cloud-based environment. 

Glossary  
1. Google Forms: Online survey and data collection tool. 

2. Google Slides: Cloud-based collaborative presentation software. 

3. Google Cloud Print: Remote cloud-enabled printing service (discontinued). 

4. Real-time Collaboration: Simultaneous editing by multiple users. 

5. Cloud Storage: Online storage for documents and files. 

Here are 10 multiple-choice questions (MCQs) with answers related to Google Forms, 

Google Slides, and Google Cloud Print: 
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Self Assessment Questions 

 

1. Which Google app allows you to create and distribute online surveys? 

   a) Google Slides 

   b) Google Docs 

   c) Google Forms 

   d) Google Sheets 

   Answer: c) Google Forms 

2. What is the primary function of Google Slides? 

   a) Create and manage spreadsheets 

   b) Create and share presentations 

   c) Design web pages 

   d) Edit photos 

   Answer: b) Create and share presentations 

3. Which feature in Google Forms allows you to automatically collect responses into a 

spreadsheet? 

   a) Response Validation 

   b) Data Linking 

   c) Form Response 

   d) Google Sheets Integration 

   Answer: d) Google Sheets Integration 

4. Which of the following was the primary purpose of Google Cloud Print? 

   a) Editing documents online 

   b) Sharing presentation slides 

   c) Printing from any device remotely 

   d) Creating online surveys 

   Answer: c) Printing from any device remotely 

5. In Google Slides, what feature allows you to add animations and transitions between 

slides? 

   a) Slide Master 

   b) Slide Layout 

   c) Animations Tab 
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   d) Comments Section 

 

   Answer: c) Animations Tab 

6. Which Google Forms question type allows you to select multiple answers? 

   a) Short Answer 

   b) Paragraph 

   c) Checkboxes 

   d) Dropdown 

   Answer: c) Checkboxes 

7. How can you share a Google Slides presentation with others for collaboration? 

   a) Send as an email attachment 

   b) Publish to a website 

   c) Use the Share button and invite people 

   d) Print and distribute physical copies 

   Answer: c) Use the Share button and invite people 

8. What happened to Google Cloud Print as of December 31, 2020? 

   a) It was updated with new features 

   b) It was integrated into Google Drive 

   c) It was discontinued 

   d) It was merged with Google Docs 

   Answer: c) It was discontinued 

9. Which option allows you to collect file uploads from respondents in Google Forms? 

   a) File Upload Field 

   b) Text Response Field 

   c) Multiple Choice Field 

   d) Linear Scale Field 

   Answer: a) File Upload Field 

10. In Google Slides, what feature lets you present your slides live to an audience online? 

   a) Present Mode 

   b) Publish to Web 

   c) Share Screen 

   d) Slideshow Mode 

   Answer: b) Publish to Web 
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Activities  

Activity: Creating and Presenting a Survey-Based Presentation 
 
Objective: 
Participants will create a survey using Google Forms, collect responses, analyze the 
data, and then present their findings using Google Slides. Finally, they will use Google 
Cloud Print (if still available) or an alternative method to print their presentation. 
 
Activity Steps: 
 
1. Create a Survey with Google Forms: 
   - Task: Participants will design a survey on a topic of their choice (e.g., employee 
satisfaction, customer feedback, or a class poll). 
   - Outcome: Participants will be able to create a survey, including various question types 
(e.g., multiple choice, short answer) and set up data collection. 
 
2. Distribute the Survey: 
   - Task: Share the Google Forms survey link via email or social media to collect 
responses. 
   - Outcome: Participants will understand how to share a Google Form and collect 
responses from different sources. 
 
3. Analyze Responses: 
   - Task: Once responses are collected, participants will use Google Forms’ built-in 
analytics and Google Sheets integration to analyze the data. 
   - Outcome: Participants will gain skills in data interpretation and basic statistical 
analysis using Google Forms and Google Sheets. 
 
4. Create a Presentation with Google Slides: 
   - Task: Based on the survey results, participants will create a Google Slides 
presentation that includes key findings, charts, and graphs. 
   - Outcome: Participants will learn to effectively present data by creating visual slides 
that summarize and highlight important insights. 
 
5. Present Findings: 
   - Task: Use Google Slides' "Present" feature to deliver the presentation to an audience. 
Participants will also explore options for sharing their slides live online. 
   - Outcome: Participants will practice presenting data and engaging an audience 
through digital tools. 
 
6. Print the Presentation (Alternative to Google Cloud Print): 
   - Task: Since Google Cloud Print has been discontinued, participants will use 
alternative methods (e.g., download as PDF and print) to produce physical copies of their 
presentation. 
   - Outcome: Participants will demonstrate the ability to export and print a presentation 
using alternative methods. 
 
Outcomes: 
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1. Survey Creation and Distribution: 
   - Participants will effectively use Google Forms to design, distribute, and collect survey 
data. 
    
2. Data Analysis Skills: 
   - Participants will gain proficiency in analyzing survey data using Google Sheets and 
visualizing results. 
    
3. Presentation Design: 
   - Participants will develop skills in creating professional presentations using Google 
Slides, including data visualization and slide design. 
    
4. Print Preparation: 
   - Participants will learn how to export and print presentations, adapting to changes in 
available tools like Google Cloud Print. 

 
Suggested Readings 

 Travis, R. (2013). Tech Eliquette: OMG, 2 Edition, RLT Publishing. 

 


